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3.4.2 ப�கிழியின  ேழககள் 
அன்றாட ேறாழ்வில் நறாம் பயனபடுததும் 

பநகிழிப் பபறாருள்்களும் பலபடி்களறால் ஆனது. 
அறனதது பநகிழி்களிலும் ஒவர ்மறாதிரியறான 
அலகு்களறால் அற்மயப்பபறறிருப்பதில்றல.  ஒரு 
சிலேற்க பநகிழ்்களில் ஒறற்ப்படி்கள் வநரியல் 
அற்மப்பில் இறணநதும், வேறுசிலேற்க 
பநகிழி்களில் ஒறற்ப்படி்கள் குறுககுப் 
பிறணப்பில் இறணநதும் ்கறாணப்படுகின்ன. 
ஒறற்ப்படி்களின அற்மப்பிறனப் பபறாறுதது 
பலபடி்கள், இரு பபரும்பிரிவு்களறா்கப் 
பிரிக்கப்படுகின்ன. இளகுபறே ்மறறும் 
இறுகுபறே. அறே எனனபேனறு தறவபறாது 
்கறாணவபறாம்:

இளகும் ப�கிழிகள்:
பறாலிஎததலீன (பறாலிததீன எனறும் 

அறைக்கப்படுகி்து) எனபது இளகு பநகிழியின 
ஓர எடுததுக்கறாட்டறாகும். நறாம் பபரு்மளவு 
பயனபடுததும் பநகிழிப் றப்கள் பறாலிததீனறால் 
பெய்யப்பட்டறேயறாகும். ஒரு பறாலிததீன 
றபயிறன எரிககும் பபறாழுது, அது உருகி, 
விரும்பததறா்கறாத ்மணதறத வீசி, ்கரும்புற்கறய 
பேளியிட்டு, பிர்கறாெ்மறான சுடரறா்க எரிகி்து.  
PET (பறாலி எததிலீன படரப்தறாவலட்) பறாட்டிலும் 
பபரு்மளவு பயனபடுததப்படும் பநகிழிககு 
்மறப்றாரு எடுததுக்கறாட்டறாகும்.  இநத பறாட்டிறல 
நறாம் ப்கறாதிநீரறால் நிரப்பினறால், பறாட்டிலின 
ேடிேம் சிறதகி்து.  இம்்மறாதிரி, பேப்பப்படுததும் 
பபறாழுது எளிதில் ப்மனற்மயறாகி, ேறளயும் 
தனற்ம ப்கறாணட பநகிழி்கள் இளகும் தனற்ம 
ப்கறானட பநகிழி்கள் என்றைக்கப்படும். 
இவேற்க பநகிழி்கறள உருககி ்மறுசுைறசி 
பெய்து வேப்றாரு பநகிழிப் பபறாருளறாக்கலறாம்.  

இறுகும் ப�கிழிகள்
்மறா்றா்க, சில பநகிழி்கறள ஒருசில 

முற்யில் தயறாரிக்கப்பட்டு, பபறாருள்்களறாககி 
அேறற் பேப்பப்படுததினறால 
ப்மனற்மயறாேதில்றல, பினேறளேதில்றல. 

எனவே, இவேற்க பநகிழி்கறள மீணடும் 
உருககி வேப்றாரு பபறாருளறா்க ்மறாற் 
முடியறாது.  இததற்கய பநகிழி்களுககு 
இறுகும் பநகிழி்கள் எனறு பபயர. வபகறலட் 
்மறறும் ப்மலற்மன இறுகும் பநகிழி்களுககு 
எடுததுக்கறாட்டு்களறாகும். பேப்பம் ்மறறும் 
மினெறாரதறதக ்கடததறாத பபறாருளறா்க வபகறலட் 
விளஙகுகி்து. எனவே, வபகறலட்டிறனப் 
பயனபடுததி மினஸவிட்சு்கள் ்மறறும் 
பலேற்க பறாததிரங்களின ற்கப்பிடி்கள் 
தயறாரிக்கப்படுகின்ன. ப்மலற்மன தீயிறன 
எரிப்பதறாலும், தீயிறனத தறாஙகும் தி்ன 
பபறறிருப்பதறாலும் தறர ஓடு்கள் ்மறறும் 
தீயறணககும் துணி்கள் வபறான்ேறறின 
தயறாரிப்பில் பயனபடுகின்ன.

இ�வைக ெந�� பலப�க�
ெவ�ப�தா
 இள�
 
(இள�
 ெந��க�)

ெவ�ப�தா
 இ��

(இ��
 ெந��க�)

• ச���க��� இைடேய ����
   �ைண�� இ
ைல.
• ச���க��� இைடேய பல­ன 
   ஈ��� ச�� உ�ள�.
• ெவ�ப�ப���
ெபா�� இள��ற�.

• பலப� ச���க�� இைண�� ����
  இைண�பாக�
, வ�ைமயான 
  சக�ைண�பாக�
 அைம���ளதா
, 
  ெவ�ப�ப���
 ெபா�� உைடவ�
ைல.
• ெவ�ப�ப���
ெபா�� க�ன�த�ைம 
   ெப���றன.

எ.்கறா: PET நீர பறாட்டில்்கள் : பேப்பததறால் இளகும் 

எ.்கறா : மின்கல குமிழ்்கள்: பேப்பததறால் இறுகும்
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நெகிழி ரெசின் குறியீடுகள்
இதுவரை இளகும் நெகிழிகளுக்கும் 

இறுகும் நெகிழிகளுக்கும் இடையேயுள்ள 
வேறுபாடுகளைக் கற்றோம், அன்றாட 
வாழ்வில் நாம் பயன்படுத்தும் நெகிழிகளைப் 
பற்றி மேலும் அறிவ�ோமா? நெகிழிகள் 
நமக்குப் பலவகைகளிலும் பயன்பட்டாலும், 
சிலவகை நெகிழிகள் தீங்குவிளைவிக்கும் 
வேதிப்பொருள்களையும் தன்னகத்தே 
க�ொண்டிருக்கின்றன.

ரெசின் குறியீடுகளின், அடிப்படையிலும் 
நாம் நெகிழிகளை வகைப்படுத்தலாம். 
பலவகை நெகிழிகளைப் பற்றி அறிவ�ோம். 
ரெசின் குறியீடுகளின் அடிப்படையிலும் 
நாம் நெகிழிகளை வகைப்படுத்தலாம். 
பலவகையான நெகிழிகளை வகைப்படுத்த 
உலகளாவிய அளவில் க�ொடுக்கப்பட்டுள்ள 
குறியீடுகளே ரெசின் குறியீடுகளாகும். இவ்வாறு 
ரெசின் குறியீட்டின் அடிப்படையில் நெகிழியைப் 
பிரித்தல், அவற்றைத் தனித்தனியாக மறுசுழற்சி 
செய்ய உதவியாக இருக்கும். ஒவ்வொரு நெகிழி 
ப�ொருளுக்கும் பிரத்யேகமாக என்ன குறியீடு 
க�ொடுக்கப்பட்டுள்ளது என்பதை நாம் எவ்வாறு 
அறிவது? நெகிழிப் ப�ொருளில் எந்த இடத்தில் 
இந்தக் குறியீடு க�ொடுக்கப்பட்டிருக்கும்? 

நெகிழிப் ப�ொருளின் அடிப்பகுதியில�ோ, 
அல்லது மூடியில�ோ, ப�ொருளைத் தயாரித்து 
விற்பனை செய்பவரின் பெயர்வில்லை 
ஸ்டிக்கரில�ோ ஒன்றைய�ொன்று துரத்தும் 
அம்புக்குறியாலான முக்கோண உருவத்தைப் 
பார்க்கவும். அந்த முக்கோணத்தின் (மத்தியில்) 
நடுவில் ஓர் எண் க�ொடுக்கப்பட்டிருக்கும். சில 
பிளாஸ்டிக் ப�ொருள்களில் அந்த எண்ணிற்குரிய 
நெகிழி வகையின் பெயருடைய 
சுருக்கெழுத்தும் க�ொடுக்கப்பட்டிருக்கும். 
இந்தக் குறியீட்டையே நாம் ரெசின் குறியீடு 
என்கிற�ோம்.

அம்புக்குறி முக்கோணத்தின் நடுவில் 1 
என்ற எண் காணப்பட்டு அம்முக்கோணத்தின் 
கீழ் PET என்ற எழுத்துகள�ோ, PETE 
என்ற எழுத்துகள�ோ காணப்பட்டால், அந்த 
நெகிழி ப�ொருளானது பாலி எத்திலீன் 
டெரிப்தாலேட்டால் உருவாக்கப்பட்டது என 
அறியலாம். பலவகையான வேதிப்பொருள்கள் 
(சேர்த்திகள்) நெகிழியுடன் சேர்க்கப்படுவதால் 
அப்பொருள் நெகிழ்வுத்தன்மை, வலிமை, 
மென்மை அல்லது ஒளி ஊடுவும் 
தன்மை ப�ோன்ற பல பண்புகளையும் 
குணங்களையும் பெறுகின்றன. நெகிழியுடன் 
சேர்க்கப்படும் சில வேதிப்பொருள்கள் 
விலங்குகள், நமது சுற்றுப்புறம் மற்றும் நமது 
உடல் ஆர�ோக்கியத்திற்கும் ஆபத்தைக் 
க�ொண்டுவருவதாக உள்ளது. எடுத்துக்காட்டாக, 
ரெசின் குறியீடு எண் # 3 என்பதைக் 
குறிக்கும் பாலிவினைல் குள�ோரைடு (poly 
Vinyl chloride – PVC) மிகவும் நச்சுத்தன்மை 
வாய்ந்ததாகவும், நமது ஆர�ோக்கியத்திற்கு 
தீங்குவிளைவிக்ககூடிய காட்மியம், ஈயம் 
ப�ோன்ற கன உல�ோகங்களைத் தன்னகத்தே 
க�ொண்டுள்ளது. ரெசின் குறியீடு எண் 
#6 என்பதைக் குறிக்கும் பாலிஸ்டைரீன் 
(polystyrene – PS) என்ற பிளாஸ்டிக் 
புற்றுந�ோயை ஏற்படுத்தும் ஸ்டைரீன் என்ற 
நஞ்சான வேதிப்பொருளை தன்னகத்தே 
க�ொண்டுள்ளது.

பல்வேறு வகையான நெகிழி பற்றி மேலும் 
அறிய ரெசின் குறியீடு விளக்கப்படத்தைப் 
பாருங்கள். நாம் பயன்படுத்தும் ப�ொதுவான 
நெகிழிப்பொருள்களுள் எவை நமக்கும், 
நமது சுற்றுப்புறத்திற்கும், விலங்குகளுக்கும் 
பாதுகாப்பானவை மற்றும் எவை 
பாதுகாப்பற்றவை என்ற தகவல்களை 
அறியலாம்
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PETE, 

PEHD

V, Vinyl

PELD, 
LLDPE

NO CODE

Thermocol, EPS
XPS and HIPS 

02

HDPE

03

PVC

04

LDPE

05

PP

06

PS

07

OTHER

01

PET

ெர�� ���� ேவ� ெபய�க�          ெபா
வான ெபா��க�                                   பய�பா�

பா
ெய	ட�

�ைட, �ைளயா�� உைடக�,
ெவ�ப���� ேம�ைறக�/ 
	ெவ�ட�க�, க �, sails 
���வத�� ஏ
வான 
பா
ெய	ட� இைழயாலான 
ைபக�

இ�த வைக ெந��க� ஒேர ஒ� �ைற ம��ேம 
பய�ப���� வைக�� வ�வைம�க�ப���ளன.
PET ெந��ைய ­��� பய�ப���னா� 
அ����� ஆ��ம� எ�ற ேவ��ெபா�� 
ெவ�ேய�� – அ� உட��� ந�ைம பய�கா�. 
ஆைடக��காக� ெப�மள� பா�ெய�ட� எ�ற 
ெசய�ைக இைழ பய�ப��த�ப��ற�.

�ெம��, அ��, மா�க�� �� ைவ�க�ப��
சா��க�, crocheted, ெந¨ய�ப�ட �ப�ைபக�,
க��, ­�©� வைல, «ழ� வைலக�, அைம�¬க�, 
இைழகளா� வ�®�ட�ப�ட கா��¯� 
(ெந�� ேக�க����� ெற�ப�ட�), ��� 
�ைள�காத உ�ளாைடக� (அ�உய� ²ல�³� 
எைட´�ள பா� எ��µ� – UHMW)

பா�கா�பான ெந��க�� ஒ�றாக� க�த�ப��ற�. 
இ� ெம�தான�, ºக வ�வான, தா��தைல எ��ெகா��� 
அ�¬த த�ைம ெகா�ட�. ஈர�பத��ைன 
உ�¼ைழய½டாம� தைடெச¨´� ச�� 
வா¨�த�. ெப�மள� ம�¾ழ�� ெச¨ய�த�க�. 

PVC இைழக�, ½ைனயா� இைழகளா� ெச¨ய�ப��
 மைழ��ைடக�, ெவ��¬ற� ��க�, மைழேகா��க� 
(கா�ைறக�)கா� Á��க� ­�©�வைலக�, ெசய�ைக 
இைழக�, �ழ�ைதக��கான ஆைடக� ம��� 
ேபா�ைவக�. ஆைடக�� ேம� ஒ��� ½�ைலக� 
அைட�க�� (dress costumes) அலÅகார ஆைடக� ம��� 
ேபா� ேதா� ெபா��க� தயா��க ½ைன� பய�ப��ற�.

ºக ஆப�தான ெந��� ெபா�ளா��. மா�� 
வா�ைலகைள எ��ெகா��� த�ைம, 
��த��¬, �த�ய �ற�த ப�¬கைள� ெப�ற�
 ½ைனயா�.

கனரக சா��க�, ெசய�ைக 
¬�க�, கா�ப�� ஆ�கள� 

பா�கா�பான ெந��க�� ஒ�றா��. இ� ºக�� 
ெந�Æவான��, ெம�ைமயான�மாக இ��தா�� 
வ�ைம ெபா���ய�.

பா�கா�பான ெந��க�� ஒ�றாக க�த�ப��ற�.
ஒ��ைற ம��ேம பய�ப���ய�ட� எÇய�³�ய 
ெபா��கைள� தயா��க ெந¨ய�படாத PP – ��க�
உ�வா�க�ப���றன.

ஒ� �ைற பய�ப��த�ப�� உÇÈ¾� ெபா��க� –
டயப�க�, ¾�த� ெச¨ய� பய�ப�� ஈர� �ைட��� 
பÈ¾க�, க��க�, தைர க�பளÅக�, வ�க�ட� பய�ப�� 
க�ைல� ��க�, º�கல��� உ�ள த��¬É ¾வ�க�,
Êேயா��க� (geotextiles) (வ�கா� ம��� அ��¬ 
த��¬É¾வ�) கா��¯��க� ேபா�� ெபாÏ� கலைவைய 
«ைல�ப��த PP ¼� இைழக� கல�க�ப��ற�.

எÏ�ேகாைள அள½��அள�ேகா�க�, 
ஒ��ைறம��� பய�ப��த�³�ய ேதÐ� 
ம��� ���பான �வைளக�, ¾��க�, 
சைமயலைற கர��க� ம��� ெபா�ைமக�

ºக�� ஆப�தான ேவ��ெபா��க� ெகா�டதா� 
இÑவைக ெந��க� �ைம ½ைள½�க�³�யைவ.
ெப��பாலான PS ஆ� ெச¨ய�ப�ட ெபா��க� 
ெப��பா�� ஒ��ைற ம��� பய�ப���
எÇய�³�ய உண� ம��� �ரவபானÅக�� 
கல�களாகேவ பய�ப��த�ப��ற�

பா�கா�பேன� (PC), 
அ��ேலா ைந��� �Ô�டா
 ைடÕ� �ைட¯� (ABS), 
அ���� (AC). உ�� 
ெந��க� ைநலா�, 
பா�Ô��ேத� (PU), 
இ�ன ©ற 

PC  : ��வ�க�� பா���க� ம��� உண�� கல�க�.
ABS   : தைல�கவசÅக� ம��� கா� ப�ப�க�. அ���� ைபப�, 
ஆ��க� ேக©�க� ம��� ெப���க�. 
உ�� ெந��க� : ெந�� ைபக� ம��� ைவ சாதனÅக�. 
ைநலா� : உைடக�, ப�டÅக� ம��� ப��ல���� �ÉசÅக�. 
PV  : ெம�ைத�� ஃேபா�க� ம��� Ú�க�� அ��பாகÅக�. 

ெர�� �ÇÕ�க� 1 �த�  6 ��ய உ�ள அள½� இவ�Ç� ெபா��தாத 
அைன�� ெந��� ெபா��க�� இ�� அடÅ��. PC ம��� 
ABS எ�ற இ�வைக ெந��க���� நÉ¾� ெபா��கைள� 
த�னக�ேத ெகா���ளதா� பா�கா�ப�றதாக க�த�ப��ற�. 
#7 �ÇÕ� ெகா�ட ெந��� ெபா�ைள ÐÅக� வாÅக ேந��டா�,
 ேம�� ஆரா¨�� அதைன பய�ப���வ�� ெத�� ெப�க.

ெர�� �ÇÕ� இ�ைல,
¾��ெகÏ��� இ�ைல

எ�த ஒ� ெந�� ²ல�ெபா�ளாக��
இ��கலா�.

ெந��� ெபா��க� உ�வா�க தயா��பாள� 
எ�தெவா� ½�ைய´� ©�ப�ற½�ைல. இ� 
ஆப�தான வைகையÉ ேச��நதாக�� இ��கலா�. 
எ�த� தகவ�� இைண�©� இ�ல நம�� எ�த 
உ��ரவாத�� இ�ைல. ெர�� �ÇÕ� இ�லாத 
ெந��� ெபா��க�� பய�பா��ைன� த½��க��.

ெந�� ெர�� �ÇÕ� ½ள�க�பட� 
ெப��பா�� ெந��� ெபா��க�� ெபய� ½�ைல�ேலா அ�ல� ெபா��� அ��ப���ேலா ெர�� �ÇÕ� இ����.

ஒ�ைறெயா�� ப��வ� ேபா� அைம�த ��ேகாண வ�½லான அ�¬�Ç�� ந�½� ஒ� எ�ேணா அ�ல� அ�த ெந�� 
²ல�ெபா��� ¾��ெகÏ�ேதா காண�ப��.

இைவ த½ர ேவ� ஏேதà� எ�கேளா, எÏ���கேளா காண�ப�டா� அைவ ெர�� �ÇÕ�க� அ�ல.
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3.4.4 நெகிழிகளின் தாக்கம்

நெகிழிகள் விலை மலிவாகவும், 
இலேசானதாகவும், வலிமையானதாகவும், 
நீடித்து உழைப்பதாகவும் இருப்பதால், 
நமது நவீன வாழ்க்கையில் பல்வேறு 
முன்னேற்றங்களும், நன்மைகளும் நமக்குக் 
கிடைத்துள்ளன. ஆனால், நெகிழிகளின் அதிக 
அளவிலான  பயன்பாடு, அதிலும் ஒருமுறை 
மட்டுமே பயன்படுத்தி எறியக்கூடிய நெகிழிகள் 
நமது சுற்றுப்புறத்திற்கும் விலங்குகளுக்கும் 
நமது ஆர�ோக்கியத்திற்கும் தீவிர 
தாக்கங்களையே ஏற்படுத்தி வருகின்றன.

பல்வேறு வகையான நெகிழிக் 
கழிவுகளைக் க�ொண்ட குப்பைத் த�ொட்டிகளை 
நாம் பார்த்து வருகிற�ோம். நெகிழி த�ொடர்பான 
பெரிய சிக்கல்களுள் ஒன்று யாதெனில், 
அவை சிதைவடைவதும் இல்லை, மண்ணில் 
மட்குவதும் இல்லை. நெகிழிக் குப்பைகள் 
பலகாலம் மறையாமல் இருப்பதால், பெரிய 
அளவிலான கழிவுகளுக்கு வழிவகுத்து,  எல்லா 
இடங்களிலும் நிறைந்து, குவிந்து சுற்றுச் 
சுழலை மாசுபடுத்துகின்றன.

ஒருமுறை மட்டுமே பயன்படுத்தி 
எறியக்கூடிய பாலித்தீன் பைகள் மற்றும் உணவு 
ப�ொட்டலங்களைப் அதிகளவு பயன்படுத்தி 
எறிவதால், நமது சுற்றுப்புறமும் குப்பைக் 
கூடமாகி வடிகால்களிலும் அடைத்துக் க�ொண்டு 
சுற்றுப்புறத்தினை மாசுபடுத்துகின்றன. 
வடிகால்களில் அடைப்பு ஏற்படுவதால், நீர் 
தேங்கி நிற்கின்றது. இந்நீர்க்குட்டைகள் 
க�ொசுக்களின் இனப்பெருக்கத்திற்குக் 
காரணமாகி மலேரியா, டெங்கு,  சிக்குன்குனியா 
ப�ோன்ற வியாதிகளைப் பரப்புவத�ோடு, நீர் 
வடிந்து ஓடாமல், வெள்ளமாகப் பரவுவதற்கும் 
காரணமாகினறன.

வெவ்வேறு வகையான  நெகிழிகளை இனம் காண்க
வெவ்வேறு வகையான நெகிழிப் ப�ொருள்களைச் சேகரித்து அவற்றில் காணப்படும் ரெசின் 

குறியீடு அல்லது அப்பொருளின்மீது காணப்படும் சுருக்கெழுத்தினை கவனமாகப் பார்க்க. 
க�ொடுக்கப்பட்டுள்ள ரெசின் குறியீடு விளக்கப்படத்தின் உதவிய�ோடு, உங்களிடம் உள்ள நெகிழிப் 
ப�ொருள் நாம் பயன்படுத்த, பாதுகாப்பானதா, பாதுகாப்பற்றதா, சந்தேகத்திற்கு இடமானதா, என 
இனம் காண்க. அப்பொருள்களின் மேல் என்ன ரெசின் குறியீடுகளை நீங்கள் காண்கிறீர்கள்? அந்த 
ரெசின் குறியீடு பாதுகாப்பான ப�ொருளைக் குறிப்பிடுகிறதா? அல்லது பாதுகாப்பற்ற தன்மையை 
உணர்த்துகிறதா? அல்லது சந்தேகத்திற்கு இடமாக உள்ளதா அல்லது ரெசின் குறியீடே 
இல்லையெனும் ப�ொழுது அப்பொருள் பாதுகாப்பற்றது  என கண்டறிந்து அட்டவணையில் பதிவிடுக

ப�ொருள் ரெசின் குறியீட்டு 
எண்

சுருக்கெழுத்து பாதுகாப்பின் வகை ப�ொருளின் 
பயன்பாடு

செயல்பாடு : 8
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சில விலங்குகள் ஏன் நெகிழியினை 
உண்கின்றன என நீங்கள் சிந்தித்ததுண்டா? 
மீதமுள்ள உணவுப்பொருளை எறியும்பொழுது 
பெரும்பாலும் அவற்றை நெகிழி பையிலிட்டே 
எறிகிற�ோம். உணவுப்பொருள்களின் 
வாசனையை நுகரும் விலங்குகள், அவற்றை 
உண்ணும்பொழுது தவறுதலாக நெகிழி 
பைகளையும் சேர்த்தே உட்கொள்கின்றன. 
எடுத்துக்காட்டாக, நகரங்களில் வசிக்கும் 
விலங்குகள், அதிலும் பெரும்பான்மையாக 
மாடுகள், பாலித்தின் நெகிழி பைகளிலுள்ள 
மீதமான உணவுப்பொருள்களை உண்ண 
முயலும் ப�ொழுது தவறுதலாக நெகிழிப் 
பைகளையும் உண்கின்றன. இதனால் ஏற்படும் 
விளைவுகளை உங்களால் யூகிக்க முடிகிறதா? 
…………………………………………………

நெகிழிப் பைகள், பாட்டில்கள், 
உறிஞ்சுக்குழாய்கள் ப�ோன்ற நெகிழிக் 
கழிவுகள் கடல்களையும் சென்றடைகின்றன. 
அவ்வாறு கடலில் குவியும் நெகிழிகள், கடல்நீர், 
சூரியஒளி மற்றும் அலையசைவுகளுக்கு 
உட்பட்டு, சிறிய துண்டுகளான மைக்ரோ 
நெகிழிகளாக (நுண்ணிய பிளாஸ்டிக் துகள்கள்) 
உடைகின்றன. வீட்டு உபய�ோகப் ப�ொருள் 
சிலவற்றிலும் இத்தகைய மைக்ரோபிளாஸ்டிக் 
காணப்படுகின்றன. பற்பசை, முகம்கழுவும் 
கரைசல், உடலைத் தூய்மைபடுத்தும் 
தேய்ப்பான்கள் ஆகியவற்றில் காணப்படும் 

மைக்ரோ (நுண்ணிய) மணிகள், மைக்ரோ 
நெகிழிகளின் சில எடுத்துக்காட்டுகளாகும். இந்த 
மைக்ரோ மணிகள் கழுவும் ப�ொழுது, நீரில் 
அடித்துச் செல்லப்பட்டு நிலம், ஆறுகள், ஏரிகள் 
மற்றும் கடல்களில் சேர்ந்து அவ்விடங்களை 
மாசுபடுத்துகின்றன.

பாசிகளால் சூழப்பட்ட சிறிய 
நெகிழி துகள்களையும், சிறிய நெகிழித் 
துணுக்குகளையும் அதிகளவு பறவைகள் அதிக 
அளவில் உண்ண நேரிடுகிறது. இவ்வாறாக 
நெகிழிப் ப�ொருள்களை உண்ட விலங்குகளின் 
வயிற்றில் நெகிழிப் ப�ொருள்கள் அவற்றின் 
வயிறு உறுப்புகளில் இடத்தை அடைத்துக் 
க�ொள்வதால், அவ்விலங்குகள் உணவுப் 
ப�ொருள்களை உண்ணமுடியாமல் பட்டினியால் 
வாடுகின்றன. வயிற்றில் உள்ள நெகிழிப் 
ப�ொருள்கள் செரிமானம் அடைவதில்லை. 2015 
– இல் நடந்த ஆராய்ச்சியில், 90% கடல்வாழ் 
பறவைகளின் வயிற்றில் நெகிழிகள் இருப்பது 
கண்டறிப்பட்டது.

தமிழ்நாடு அரசு, ஒருமுறை 
மட்டும் பயன்படுத்தப்பட்டு எறியப்படும் 
நெகிழிப்பொருள்களைத் தடை செய்துள்ளது 
பற்றி நாம் முன்பே படித்தோம் அல்லவா? 
நெகிழிகள் சுற்றுப்புறத்தில் ஏற்படுத்தும் 
தீய விளைவுகளைத் தடுக்கும் முக்கிய 
முயற்சிகளுள் ஒன்றாக அரசின் இந்தத் 
தடையினைப் புரிந்து க�ொள்ளலாம்.
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காற்றில்

மைக்ரோ இழைகள்

நீரில்

 உணவில்

3.4.5 பாலிலாக்டிக் அமிலம் (PLA) நெகிழிகள் 
நெகிழிக் குப்பைகள் நமது சுற்றுப்புறத்தை 

எந்த அளவிற்கு மாசுபடுத்துகின்றன என்பதை 
நாம் காண்கிற�ோம் அல்லவா? நெகிழியின் 
குணங்களை ஒத்த ஒரு ப�ொருள், மட்கும் 
தன்மை க�ொண்டு  நிலத்தில் உறிஞ்சப்பட்டு, 
நிலத்திற்குச் சத்துக்கள் வழங்கும் தன்மை 
க�ொண்டதாக  இருந்தால், அப்புதிய ப�ொருள் 
நம்மை இனிமையாக்கும் அல்லவா? 

ஆம், செயற்கை  நெகிழிகளுக்கு மாற்றாக 
அறிவியலாளர்கள் கண்டறிந்ததே PLA – 
(Poly Lactic Acid) எனப்படும் பாலிலாக்டிக் 
அமிலமாகும். இது சில வகை நெகிழிகளுக்கு 
மாற்றாக அமைகிறது. பாலிலாக்டிக் அமிலம் 
அல்லது பாலிலாக்டைடு, உரமாகும் தன்மை 
க�ொண்ட உயிர்ப்புத்திறன் க�ொண்ட-
வெப்பத்தால் இளகும் நெகிழி ஆகும். இந்தப் 
பாலிமர் ப�ொருளைச் ச�ோளம், கரும்பு மற்றும் 
இனிப்புச்சுவை க�ொண்ட கிழங்குகளின் 
கூழ்களில் இருந்து பெறமுடியும். PLA 
என்பது மட்கும் தன்மை க�ொண்ட ப�ொருள். 

செயற்கை இழைகளால் 
ஆன உடைகளில் நெகிழிப் 
ப�ொருள்கள் இருப்பதை 

நாம் அறிவ�ோம். ஒவ்வொரு முறையும் 
அத்தகைய ஆடைகளை நாம் த�ோய்க்கும் 
ப�ொழுது, சிறிய இழைகளான –நுண் 
இழைகள் ஆடைகளிலிருந்து வெளியேறி, 
நிலம், நீர�ோடைகள், ஆறுகள் மற்றும் 
கடல்களில் கலக்கின்றன.

கடலின் மேற்பரப்பில் மிதக்கும் 
(persistent organic pollutants) 
த�ொடர்ச்சியான கரிம மாசுபடுத்திகள் 
மேற்சொன்ன நுண்ணிய இழைகளில் 
ஒட்டிக்கொண்டு ஆபத்தான மாசுபாட்டை 
உண்டாக்குகின்றன. கடல்வாழ் 
உயிரினங்களான இறால், மீன் 
ப�ோன்றவை நுண்ணிய நெகிழிகளை, 
தமது இயற்கையான உணவு ஆதாரம் 
என்று எண்ணி உண்கின்றன. அத்தகைய 
நெகிழிகளை உண்பதால் பலவித நச்சுகள் 
கடல்வாழ் உயிரினங்களின் உடலுக்குள் 
சேர்கின்றன. அந்தக் கடல்வாழ் 
உயிரினங்களை மனிதர்களாகிய நாம் 
உண்ணும்பொழுது உயிரினங்களின் 
உடலில் தங்கிய நச்சுகள், நமது 
உடல்களை அடைகின்றன. இவ்வாறாக, 
உணவுச் சங்கிலித் த�ொடரில் நாம் 
உண்ணும் உணவு, பருகும் நீர் மற்றும் 
சுவாசிக்கும் காற்றிலும் நுண் இழைகள் 
காணப்படுகின்றன

இப்பொருளைப் பயன்படுத்தி உணவுப் 
ப�ொட்டலக்கலன்கள், குப்பைப் பைகள் மற்றும் 
ஒரு முறை மட்டுமே பயன்படுத்தக்கூடிய 
சமையல் மற்றும் உணவு மேசை கருவிகள் 
ப�ோன்றவற்றைத் தயாரிக்கலாம்.
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PLA – தேநீர்ப் பைகள்PLA – உணவுக் 
கலன்கள்

3.4.6 �நெகிழிகளை அப்புறப்படுத்தும் பல்வேறு 
முறைகள்

நெகிழிகள் எங்கும் நிறைந்துள்ளன. 
அதிகரித்து வரும் நெகிழிகளின் பயன்பாடு 
மற்றும் நெகிழிக் கழிவுகளின் பெருக்கத்திற்கு 
ஓர் தீர்வு தேவைப்படுகிறது. நெகிழிக் 
கழிவுகள் எவ்வாறு அப்புறப்படுத்தப்படுகின்றன 
என்பதையும் நெகிழிக் கழிவுகளை 
அப்புறப்படுத்தும் சிறந்த முறைகளையும் நாம் 
தற்பொழுது பார்க்கலாம்.

காய்கறிகளின் புறத்தோல்கள், பழங்கள் 
மற்றும் மீதமான உணவுப் ப�ொருள்கள் 
ப�ோன்றவற்றை மண்ணில் இட்டால், 
அவை மண்ணில் உள்ள பாக்டீரியாவால் 
சிதைக்கப்பட்டு, ஊட்டச்சத்துகள் நிறைந்த 
இயற்கை உரமாகின்றன. இயற்கை முறையில் 
பாக்டீரியாக்களின் செயல்பாட்டால் எந்தப் 
ப�ொருளும் சிதைக்கப்படுகிறத�ோ, அதற்கு மட்கும் 
தன்மை க�ொண்ட ப�ொருள் எனப் பெயர்.

நெகிழிகள், இயற்கை முறையில் 
பாக்டீரியாக்களின் செயல்பாட்டால் 
சிதைக்கப்படுவதில்லை. எனவே, அவை மட்கும் 
தன்மை க�ொண்டதல்ல என்று அறியலாம். 
எனவே குப்பைகளை எறியும் முன், அவற்றை 
மட்கும் தன்மை க�ொண்ட குப்பைகள் மற்றும் 
மட்கும் தன்மையற்ற குப்பைகள் என்று பிரித்த 
பிறகு, தனித்தனியே அப்புறப்படுத்துவதே 
சிறந்தது. ஒரு முறை மட்டுமே பயன்படுத்தி 
எறியப்படும் நெகிழிப்பொருள்களே 

உலகெங்கிலும் உற்பத்தி செய்யப்பட்டும், 
பயன்படுத்தப்பட்டும், தூக்கியெறியப்பட்டும் 
வருவதால், மிக அதிக அளவில் நெகிழிக் 
கழிவுகள் குவிந்துள்ளன. இவ்வாறாக, சேர்ந்த 
நெகிழி கழிவுகள் மறுசுழற்சி செய்யப்பட்டோ 
அல்லது எறிக்கப்பட்டட�ோ அல்லது குழிகளில் 
இட்டு மூடப்பட்டோ, திறந்த வெளியில் க�ொட்டி 
குப்பை மேடாக்கிய�ோ நமது சுற்றுச் சூழலில் 
நிறைகின்றன. இதுவரை உற்பத்தி செய்யப்பட்ட 
(சேகரிக்கப்பட்ட) நெகிழி கழிவுகளிலிருந்து 79% 
குழிகளில் இட்டு மூடப்படுகிறது அல்லது திறந்த 
வெளியில் க�ொட்டப்பட்டு குப்பைமேடாகிறது, 
12% எரிக்கப்படுகிறது, 9% மட்டுமே மறுசுழற்சி 
செய்யப்படுகிறது என்று மதிப்பிடப்பட்டுள்ளது.

நெகிழிக் கழிவுகளால் என்ன நடக்கிறது 
என்பது பற்றி மேலும் அறியலாம். நெகிழிக் 
குப்பைகளை அகற்ற முயற்சிக்கும் வழிகளுள் 
ஒன்று 5R க�ொள்கை Refuse(தவிர்), Reduce 
(குறை), Reuse (மீண்டும் பயன்படுத்து), Recycle 
(மறுசுழற்சி செய்) மற்றும் Recover (மீட்டெடு) 
குப்பைப் ப�ொருள்களின் தரநிலையை 
விளக்கும் பிரமிட் பற்றி நாம் சென்ற ஆண்டுகளில் 
படித்தவகையில், நெகிழிக் கழிவுகளை அகற்றும் 
சிறந்த முறைகளில் அதிகபட்ச சாதகமான முறை 
இவ்வாறாக அமையும். மறு (தவிர்), குறை, 
மீண்டும் பயன்படுத்து, மறுசுழற்சி செய், மீட்டெடு 
(மட்க மற்றும் எரித்துச் சாம்பலாக்கு), இறுதியாக 
திறந்த வெளியில் க�ொட்டிக் குப்பை மேடாக்கு. 

மறுத்தல் / தவிர்த்தல் (Refuse) 
நெகிழியாலான ப�ொருள்களைத் 

தவிர்ப்பதே மிகச் சிறந்த முறையாகும். 
ஒரு முறை மட்டுமே பயன்படுத்தித் தூக்கி 
எறியப்படும் நெகிழிப் ப�ொருள்களைப் 
பெரும்பாலும் தவிர்க்கலாம். எடுத்துக்காட்டாக, 
நாம் கடைகளுக்குச் செல்லும் ப�ொழுது 
பருத்தியிலான பை அல்லது சணல் பைகளைக் 
க�ொண்டு சென்றால், கடைக்காரர் தரும் நெகிழிப் 
பைகளை வேண்டா என்று மறுக்கலாம்.
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குறைத்தல் (Reduce) 
நாம் பயன்படுத்தும் நெகிழிப் ப�ொருள்களின் 

எண்ணிக்கையைக் குறைப்பதும் முக்கியமான 
முறையாகும். நெகிழிப் ப�ொருள் ஒன்றை 
வாங்கும் முன், அப்பொருளுக்குச் சமமாக அல்லது 
மாற்றாக வேறு ஏதேனும் மூலப்பொருளால் 
செய்யப்பட்ட பதிலிப்பொருள் உள்ளதா என 
சரிபார்த்தபின் அப்பொருளை வாங்கலாம். 
நாமே நெகிழிப் ப�ொருள்களைப் குறைவாக 
பயன்படுத்தினால், குறைந்த அளவிலேயே 
நெகிழிக் கழிவுகளையும் உருவாக்குவ�ோம். 
நாம் பயன்படுத்தும் நெகிழிப் ப�ொருள்களின் 
எண்ணிக்கையைக் குறைத்து, அதன் மூலம் 
நாம் தூக்கி எறியும் நெகிழிக் கழிவுகளைக் 
குறைத்தாலும், நெகிழிப் ப�ொருள்களின் 
பயன்பாட்டை முற்றிலுமாக நிறுத்துவது என்பது 
தற்பொழுது இயலாததாக உள்ளது. 

மீண்டும் பயன்படுத்துதல் (Reuse)

நெகிழியினால் செய்யப்பட்ட ப�ொருள்களை 
முடிந்தளவு மீண்டும் மீண்டும் பயன்படுத்தலாம். 
எடுத்துக்காட்டாக, நம்மிடம் நல்ல நிலையில் 
ஒரு நெகிழிப் பை இருந்தால், அதனைத் 
தூக்கியெறிலாம் மறுமுறை கடைக்குப் 
ப�ொருள்கள் வாங்கச் செல்லும்பொழுது, மீண்டும் 
பயன்படுத்தலாம். நம்மிடம் நல்ல நிலையில் 
உள்ள ஒரு நெகிழிப் ப�ொருள் இருந்து, நமக்கு 
அதைப் பயன்படுத்த விருப்பமில்லை எனில், 
அதனைத் தூக்கி எறியாமல், அப்பொருளை 
பயன்படும் வேற�ொருவருக்குக் க�ொடுக்கலாம். 

மறுசுழற்சி செய்தல் (Recycle) 
நெகிழிக் கழிவுகளை 

மறுசுழற்சி செய்வது 
நல்ல முறையாகும். 
பயனற்ற ப�ொருள்களில் 
இருந்து பயனுள்ள புதிய 
ப�ொருள்களை உற்பத்தி 
செய்யும் ப�ொருட்டு, நெகிழிக் கழிவுகளை ரெசின் 
குறியீடுகளின் அடிப்படையில் பிரித்தெடுத்து, 
அவற்றை மறுசுழற்சிக்கு உட்படுத்துதல் 
சிறந்த முறையாகும். இவ்வாறு செய்வதால் 
அக்கழிவுகள் திறந்தவெளி குப்பை மேடுகளில் 
குவிவது அல்லது மூடும் வகை குப்பைக் 
குழிகளில் புதைப்பது ஆகிய வழிகளில் 
சுற்றுச்சூழலை மாசுபடுத்தாயிருக்கும். 
பலவகையான வெப்பத்தால் இளகும் 
நெகிழிகளை மறுசுழற்சி செய்யலாம். அவை 
வெப்பத்தால் இளகி, உருகியபின் அவற்றை 
மறுசுழற்சியால் வேற�ொரு ப�ொருளாக மாற்ற 
முடியும், ஆனால் வெப்பத்தால் இறுகும் 
நெகிழிகளை அவ்வாறு மறுசுழற்சி செய்ய 
இயலாது. 

மீட்டெடுத்தல், மட்குதல் மற்றும் எரித்துச் 
சாம்பலாக்குதல் – (Recover)

வெப்பப்படுத்திய�ோ, உயிரியல் 
முறைகளுக்கு உட்படுத்திய�ோ திண்மக் 
கழிவுகளை பயனுள்ள வளங்களான 
மின்சாரமாக அல்லது மட்கிய உரங்களாக 
மாற்ற முடியும். பெரிய ஓர் உலையில் இட்டோ,  
திறந்த வெளியில�ோ நெகிழிப்பொருள்களை 
எரிப்பது சுற்றுப்புறத்திற்குக் கெடுதலை 
உண்டாக்கும். பெரும்பாலும், நெகிழிப் 
ப�ொருள்களை சாம்பலாக்கிகளில் (incinerator)  
இட்டு உயர் வெப்பநிலைகளில் எரித்து, 
வெளியாகும் வாயுக்களைக் கவனமாகச் 
சேகரித்தும், மீதமான நச்சுத்தன்மை வாய்ந்த 
சாம்பலை கவனமாகப் பிரித்தும், மின்சார சக்தி 
பெறப்படுகிறது. இது பெரும்பாலும் நெகிழிக் 
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கழிவுகளைக் கையாள்வதற்காகக் சாதகமான 
வழியாகக் கருதப்படுகிறது. இருப்பினும், 
நெகிழிப் ப�ொருள்களை எரிப்பதால் நச்சுத் 
தன்மை க�ொண்ட வாயுக்கள் வெளிவருவதும், 
நச்சுத் தன்மை க�ொண்ட வேதிப்பொருள்களும், 
கன உல�ோகங்கள் சாம்பலில் வெளிவருவதும் 
தவிர்க்க இயலாதவைகளாகும். மீண்டும் 
புதுப்பிக்க இயலாத வளங்களைப் 
பாழ்படுத்துவதாலும், கையாள முடியாத 
அளவில் நச்சுத் தன்மை க�ொண்ட வாயுக்களும் 
சாம்பலும் உருவாவதாலும், நெகிழிகளை 
எரித்தல் என்பது சிறந்த முறையன்று.

உமது கரிம கழிவுகளை உரமாக்கவும்

திறந்த வெளியிலும் சாம்பலாக்கிகளிலும் 
எரித்தல்

குழிகளில் இட்டுப் புதைத்தல்
சுற்றுச்சூழலியிருந்து அப்புறப்படுத்தும் 

விதமாகப் பெரும்பாலும் நிலங்களில் 
பெரிய குழிகளை அமைத்து அவற்றுள் 
நெகிழிக்கழிவுகள் அதனுள் புதைக்கப்படுகிறது. 
உலகெங்கிலும், நெகிழிக் கழிவுகளை 
அப்புறப்படுத்தும் பரவலான முறையாக, 
குழிகளில் இட்டு புதைத்தல் விளங்குகிறது. 
உலக அளவில் 7-13% நெகிழிக் கழிவுகள் 
குழிகளில் இட்டே புதைக்கப்படுகின்றன. 
இவ்வாறு செய்வதால் காற்று, நிலம், 
நிலத்தடிநீர் ஆகியவற்றை நெகிழிக் குப்பைகள் 
மாசுபடுத்துகின்றன. காலப்போக்கில், குழிகளில் 
இட்ட நெகிழிகள் சிதைந்து, அதில் உள்ள 
நச்சுத்தன்மை க�ொண்ட வேதிப்பொருள்கள் 
கசிந்து வெளியேறி, சுற்றுப்புறத்தை 
மாசுபடுத்தும்.

களிமண் 
படலம்

மண்ணின் 
அடுக்குகள்

குப்பையிலிருந்து 
வெளியேறும் 
திரவம்

குப்பையின் அடுக்குகள்

குழிகளில் 
இட்டு 
புதைத்த 
குப்பை

3.4.7 மட்கும் தன்மை க�ொண்ட நெகிழிகள் 

1980 களில் முதன்முறையாக மட்கும் 
தன்மை க�ொண்ட நெகிழிகள் அல்லது உயிரி 
நெகிழிகள் என்ற கருத்து த�ோன்றியது. அவை 
சிதைவுறும் தன்மையின் அடிப்படையில், இரு 
வகைப்படும். அவையாவன : வீரியம் குறைந்த 
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நெகிழி (degradable plastic) மற்றும் மட்கும் 
தன்மை க�ொண்ட நெகிழி. 

வீரியம் குறைந்த நெகிழிகள், வழக்கமாக 
நெகிழிகளைப் ப�ோலவே பெட்ரோலிய 
எண்ணெய் அல்லது பெட்ரோலிய வாயுவினால் 
தயாரிக்கப்படுகின்றன. வீரியம் குறைந்த 
நெகிழிகள் சூரியஒளி, ஆக்ஸிஜன் மற்றும் 
நீருடன் இருக்கும்பொழுது, இவ்வகை 
நெகிழிகளில் உள்ள ஒரு வேதிப்பொருள் 
(அல்லது சேர்த்தியானது), இவ்வகை 
நெகிழிகளை வழக்கமான நெகிழிப் ப�ோல் 
அல்லாமல், விரைவாக உடையச் செய்கிறது 
அல்லது சிதைக்கிறது. இவ்வாறாக, 
வீரியம் குறைந்த நெகிழிகள், வழக்கமான 
நெகிழிகளிலிருந்து மாறுபடுகின்றன. வீரியம் 
குறைந்த நெகிழிகளுக்கு என்ன நடக்கும் என 
உங்களால் யூகிக்க முடிகிறதா? 

வீரியம் குறைந்த நெகிழிகள் சிறிய 
துண்டுகளாக உடைந்து, மைக்ரோநெகிழிகள் 
என்றாகி அவை நமது சுற்றுப்புறத்தில் வெகு 
காலம் சிதைவடையாமல் கிடக்கின்றன. வீரியம் 
குறைந்த நெகிழிகள் சுற்றுச்சூழலில் முற்றிலும் 
சிதைந்து கலப்பதில்லை என்பதைத் தெளிவாக 
நாம் புரிந்துக�ொள்ள வேண்டும். இவ்வகையான 
நெகிழிகளால் உருவான மைக்ரோ 
நெகிழிகள், கடல்வாழ் உயிரினங்களில் 
ஏற்படுத்திய விளைவினையும், அவை கடல் 
வாழ்விலங்குகளை உண்ணும் வகையில், 
நமது உணவுப் பண்டங்களின் மூலம் எவ்வாறு 
நம்மை வந்து அடைகின்றன என்பதையும் நாம் 
இந்தப் பாடத்திலேயே கற்றது உங்களுக்கு 
நினைவிருக்கலாம். 

புதுப்பிக்கும் தன்மை வாய்ந்த மூலங்களான 
ச�ோளம், கரும்பு, அவகேட�ோ விதைகள் அல்லது 
இறால்களின் ஓடுகள் ப�ோன்றவற்றிலிருந்து 
மூலப்பொருள்களைச் சேகரித்து 
உருவாக்கப்பட்ட நெகிழிகள், மட்கும் தன்மை 
வாய்ந்த நெகிழிகள் ஆகும். மட்கும் தன்மை 

PLA நெகிழியான – உயிரி 
நெகிழியின் தயாரிப்பு முறை 

தேவையான ப�ொருள்கள் 
i. ச�ோள மாவு – 1 மேஜை கரண்டி 
ii. காய்கறி கிளிசரின் – 1 ஸ்பூன் (மருந்து 
கடைகளில் கிடைக்கும்) 
iii. வினிகர் (5% அமிலத்தன்மை) – 1 ஸ்பூன் 
iv. நீர் – 4 மேஜைக்கரண்டி 
v. கிளறக் கரண்டி 
vi. சமைக்கும் பாத்திரம் 
vii. அடுப்பு  
viii. அலுமினியத் தகடு 

செய்முறை 

சமையல் பாத்திரத்தில் நீருடன் 
மாவினைக் கலக்கவும். அதனுடன் வினிகர் 
மற்றும் கிளிசரினைச் சேர்க்கவும். அடுப்பைப் 
பற்றவைத்து அனைத்துப் ப�ொருள்களையும் 
மிதமான வெப்பத்தில் கலக்கவும். த�ொடர்ந்து 
கலந்தபடி இருப்பதை உறுதிசெய்யவும். 
கலவையானது வெண்ணிறத்திலிருந்து 
நிறமற்ற ஜெல் ப�ோல் மாறவேண்டும். 
க�ொதிக்கத் தயாராகி, குமிழ் த�ோன்றும் 
ப�ொழுது, கலவையை அடுப்பிலிருநது 
இறக்கிவிடலாம்.

அலுமினியத் தகட்டில் திரவ 
ஜெல்லினைப் பரவவிடவும். ஒரு மணி 
நேரம் குளிர்வடைந்தவுடன், ப�ொருளை 
உமக்கு விருப்பமான குவளை ப�ோன்றோ, 
கிண்ணம் ப�ோன்றோ வடிவமைத்துக் 
க�ொள்ளலாம். இவ்வாறாகத் தயாரிக்கப்பட்ட 
ப�ொருள்களைத் த�ொடர்ந்து 24 மணி 
நேரத்திற்கு குளிர்ந்து இறுகிய பின், 
பயன்படுத்திப் பாருங்கள்.
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க�ொண்ட நெகிழிகள் நுண்ணுயிரிகளால் 
முழுவதும் சிதைக்கப்பட்டுத் தாவரத்திற்கு 
பயனளிக்கும் கார்பன் – டை – ஆக்ஸைடு, 
மீத்தேன், நீர் மற்றும் இன்னபிற இயற்கையான 
சேர்மங்களாகப் பூமியில் சேர்ந்து மண்ணிற்கு 
உணவாகின்றன.

3.4.8 நெகிழி உண்ணும் பாக்டீரியா 

2016இல் ஜப்பான் அறிவியலாளர்கள், 
பாலி எத்திலீன் டெரிப்தாலேட் பாட்டில்களை 
மறுசுழற்சி செய்யும் ஆலையில் ஐடெனல்லா 
சகீயன்சிஸ் 201 – F6 (Ideonellasakaiensis 201 
– F6) என்ற பாக்டீயா ஒரு முறை மடடுமே 
பயன்படுத்தத்தக்க polyethylene terephthalate 
– PET பாட்டில்களின் நெகிழியினைச் 
செரிப்பதைச் ச�ோதித்து அறிந்தனர். இந்த 
பாக்டீரியாவானது ‘PETase’ என்ற ந�ொதியைச் 
சுரந்து PET பிளாஸ்டிக்கினை சிறிய 
மூலக்கூறுகளாகச் சிதைக்கின்றது. இந்தச் சிறிய 
மூலக்கூறுகள் பாக்டீரியாக்களால் உணவாக 
உறிஞ்சப்படுகின்றன. ந�ொதியின் செயல்பாடு 
வரைபடமாகக் கீழே காட்டப்பட்டுள்ளது.

ஐ.ச
கீயன்சிஸ்

வெளியேறிய பெரிப்தாலிக் 
அமிலத்தையும், எத்திலீன் 
கிளைக்காலையும் உண்கிறது.

ஐ சகீயன்சிஸ்  
PET 

படலத்துடன் 
ஒட்டுகிறது

பாக்டீரியா  PETயை உடைத்து 
பாலி எத்திலீன் பெரிப்தாலிக் 
அமிலமாகவும் எத்திலீன் 
கிளைக்காலாகவும் ஆக்குகிறது

நெகிழியை உண்ணும் பாக்டீரியாவின் 
கண்டுபிடிப்பானது நெகிழியால் உண்டாகும் 
மாசுபாட்டிற்குச் சாத்தியமான தீர்வாகத் 
த�ோன்றினாலும், அது இன்னமும் மிகவும் 
சிக்கலானதே! ஏனெனில், நெகிழியினால் 
உண்டான மாசுபாட்டின் அளவு, மிக அதிக 
அளவிலானது. நாம் அந்த அளவுக்கு அதிக 
அளவிலாளான நெகிழிப்பொருள்களைப் 
மேன்மேலும் பயன்படுத்தி குப்பையாகக் 
குவிக்கிற�ோம். நெகிழியை சிதைக்கும் 
பாக்டீரியாவின் செயல்படும் வேகம் மிகவும் 
குறைவாக இருப்பதால், நாம் சந்திக்கும் நெகிழி 
மாசுபாட்டை எதிர்கொள்ள இந்த பாக்டீரியாவின் 
செயல்வேகம் ப�ோதுமானதாக இருக்காது.

இந்த பாக்டீரியாவின் மற்றொரு 
குறைபாடுயாதெனில், இது ரெசின் குறியீடு #1 
என்ற எண்ணிற்குரிய நெகிழியினை மட்டுமே 
சிதைக்கும். அக்குறியீட்டு எண் க�ொண்ட 
நெகிழியானது தற்பொழுது மறுசுழற்சி  
செய்யத்தக்க நெகிழியாகவே உலகெங்கிலும் 
தயாரிக்கப்படுகிறது. நமது சுற்றுச்சூழலில் மிக 
அதிக அளவில் குவிந்திருக்கும் மறுசுழற்சி செய்ய 
முடியாததாகவும் மற்றும் தரமற்றதாகவுமான 
நெகிழிகளைக் கையாளத் தகுந்த சாத்தியமான 
தீர்வாக இந்த பாக்டீரியா அமையாது. எனவே, 
இவ்வளவு பெரிய நெகிழி மாசுபாட்டின் தீர்வாக 
இது அமையாது!

3.5 �கண்ணாடி-வகைகள் மற்றும் 
பயன்கள்
கண்ணாடி ஜன்னல், 

முகம் பார்க்கும் கண்ணாடி 
அல்லது கண்ணாடியால் 
ஆன பல்பு என நாம் பார்க்கும் 
இடமெங்கும் மனிதனால் உருவாக்கப்பட்ட 
ப�ொருள்களுள் மிகவும் பழைமையானதும் 
தனித்துவம் வாய்ந்த ப�ொருளாகவும் கண்ணாடி 
விளங்குகிறது. கண்ணாடி ஒரு புதிரான 
ப�ொருள்.  ஏனெனில், நம்மை பாதுகாக்கும் 
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அளவு கடினத்தன்மை க�ொண்டதாகவும், அதே 
சமயம், நம்மால் நம்பமுடியாத அளவு எளிதில் 
ந�ொறுங்கும் தன்மை க�ொண்டதாகவும் 
கண்ணாடி உள்ளது. ஒளிபுகாத்தன்மை 
க�ொண்ட மணலில் இருந்து தயாரிக்கப்பட்டாலும், 
கண்ணாடி ஒளிபுகும் தன்மை க�ொண்டதாக 
உள்ளது. மிகவும் வியக்கத்தக்க வகையில், 
கண்ணாடி ஒரு திண்மப்பொருளாகவும், 
வித்தியாசமான வகையில்  திரவமாகவும் 
தன்னை உருமாற்றிக்கொள்கிறது.

சிலிக்கான்-டைஆக்ஸைடு உருக 17000C 
வெப்பநிலை அளவு உருக்கி, அதனுடன் 
ச�ோடியம் கார்பனேட் சேர்க்க வேண்டும்.  
பின்னர், அதனை வேகமாகச் குளிர்விக்கவும். 
சிலிக்கான்-டைஆக்ஸைடை உருக்கியதும், 
சிலிக்கான் மற்றும் ஆக்ஸிஜன் அணுக்கள் 
தமது படிக அமைப்பிலிருந்து சிதையும். 
அவற்றை மெதுவாகக் குளிர்விக்கும்பொழுது,  
அணுக்கள் வரிசையாக மீண்டும் தனது படிக 
அமைப்புக்குத் திரும்பும். ஆனால், திரவத்தினை 
உடனடியாகக் குளிர்விக்கும்பொழுது, 
சிலிக்காவின் அணுக்கள், தமது இடங்களில் 
வரிசைப்படுத்தி பழையபடி படிக அமைப்பைப் 
பெற இயலாது. எனவே, பழைய அமைப்பில் 
இல்லாமல் வேற�ோர் அமைப்பில் அணுக்கள் 
அமையப்பெறும். இது ப�ோன்ற ப�ொருள்களை 
நாம் உருவமற்றவை என்று அழைக்கிற�ோம். 
இந்த நிலையில், கண்ணாடி நீள்வரிசை 
அமைப்பில் அமைந்தும், கனிமத்தின் பண்பில் 
இருந்து, கண்ணாடியின் அமைப்பினை ஒத்த 
உருவத்திலும் இருக்கும், அந்நிலையில் அது 
பலபடிகள் எனக் கருதப்படுகிறது.

வர்த்தக அளவில் கண்ணாடித் 
தயாரிக்கப்படும்பொழுது, மணலினை 
வீணாகிப்போன கண்ணாடியுடன் 
(மறுசுழற்சிக்கென சேகரிக்கப்பட்டவையில் 
இருந்து)  ச�ோடா சாம்பல், (ச�ோடியம் கார்பனேட்) 
மற்றும் சுண்ணாம்புக்கல் (கால்சியம் 

கார்பனேட்) ஆகியவற்றைக் கலந்து உலையில் 
இட்டு வெப்பப்படுத்த வேண்டும். மணலின் 
வெப்பநிலையினைக் குறைக்க ச�ோடா 
சாம்பல் உதவுகிறது.  இவ்வாறாகக்   தயாரான 
கண்ணாடி, நீரில் கரையும். நீரில் கரைவதைத் 
தடுக்க சுண்ணாம்புக்கல் சேர்க்கப்படுகிறது. 
இவ்வாறு பெறப்பட்ட கண்ணாடி ச�ோடா-
லைம்- சிலிக்கா கண்ணாடி என்றழைக்கப்படும். 
இதுவே, நாம் பெரும்பாலும் பயன்படுத்தும் 
சாதாரணக் கண்ணாடியாகும்.

கண்ணாடித் தயாரிப்பு முடிந்த நிலையில் 
அதன் த�ோற்றம் அல்லது பண்புகளில் 
மாற்றம் ஏற்படுத்தும் ப�ொருட்டு அதனுடன் 
சில வேதிப்பொருள்கள் சேர்க்கப்படுகின்றன.
எடுத்துக்காட்டாக, இரும்பு மற்றும் குர�ோமியம் 
சார்ந்த வேதிப்பொருள்களைச் சேர்ப்பதால் 
பச்சை-நிறக் கண்ணாடி உருவாகிறது.

பைரக்ஸ் என்ற முத்திரையுடன் பெருமளவு 
விற்கப்படும் கண்ணாடி வகை, சூளையில் 
சிதையாத ப�ோரா சிலிக்கேட் கண்ணாடி 
வகையாகும், இது உருகிய நிலையிலுள்ள 
கண்ணாடியுடன் ப�ோரான் ஆக்ஸைடினைச் 
சேர்ப்பதன் மூலம் பெறப்படும்.

உருகுநிலை கண்ணாடியுடன் ஈய 
ஆக்ஸைடினைச் சேர்க்கும்பொழுது நல்ல 
–படிகநிலையில், எளிதில் வெட்டக்கூடிய 
கண்ணாடி கிடைக்கிறது.

பல்வேறு அடுக்குகளில் கண்ணாடி 
மற்றும் நெகிழியினை அடுக்கடுக்காக ஒன்று 
மாற்றி மற்றொன்று என அடுக்குவதால் குண்டு 
துளைக்காத கண்ணாடி பெறப்படுகிறது.

உருகிய நிலையிலுள்ள  கண்ணாடியினை 
மிக விரைவாகக் குளிரவைக்கும்பொழுது 
அக்கண்ணாடி மிகக் கடினமான 
கண்ணாடியான காரில் உள்ள காற்றுக் 
கவசங்களாகப் பயன்படும் கடினக் கண்ணாடி 
தயாரிக்கப்படுகிறது.
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உருகுநிலையிலுள்ள கண்ணாடியுடன் 
வெள்ளி அய�ோடைடினைச் சேர்க்கும்பொழுது 
பெறப்படும் கண்ணாடிகள் சூரியஒளி மற்றும் 
பிற ஒளிகள் அதன் மேல்படும்பொழுது 
கருமைநிறக் கண்ணாடியாக மாறுகிறது.  
இவ்வாறு மாறுவதால் இந்தக் கண்ணாடிகளை 
கண்களுக்குப் பயன்படும் லென்சுகளின் 
தயாரிப்பிலும், கண்கவசங்களாகப் 
பயன்படும் கண்ணாடிகள் தயாரிப்பிலும் 
பயன்படுத்துகின்றனர்.

நினைவிற் க�ொள்க
�� இழைகள் என்பவை, நீண்ட மற்றும் சரம் 

ப�ோன்ற கட்டமைப்புகளை 
உருவாக்குவதற்கெனப் பின்னிப்பிணைந்த 
மூலக்கூறுகளின் நீண்ட வடிவமாகும், 
அவை நெய்யப்பட்டோ, பின்னப்பட்டோ, 
படர்ந்தோ பிணைந்தோ காணப்படும். 

�� இழைகள், இயற்கை மற்றும் செயற்கை 
என இருவகைப்படும். 

�� மரக்கூழின் வேதியியல் செயல்முறைகளால் 
உருவாக்கப்பட்ட இழை ரேயானாகும். 

�� பெட்ரோலிய எண்ணெய் மற்றும் 
வாயுவிலிருந்து பெறப்படும் செயற்கை 
இழையே நைலான் ஆகும். பாலிகாட் 
என்பது பாலியெஸ்டரும், பருத்தியும் சேர்ந்த 
கலவை, பாலிவுல் என்பது பாலியெஸ்டரும் 
கம்பளியும் சேர்ந்த கலவை. 

�� தீயிலேற்றும் ப�ொழுது செயற்கை இழைகள் 
உருகுகின்றன, இயற்கை இழைகள் 
எரிகின்றன. 

�� ஒற்றைப்படிகள் என்ற சிறிய 
மூலக்கூறுகளின் பல எண்ணிக்கையிலான 
உருப்படிகள், மீண்டும் பல்வேறு 
வகையான பிணைப்புகளால் இணைந்து, 
பலபடிகள் என்ற நீண்ட சங்கிலிச் 
சேர்மங்களை உண்டாக்குகின்றன. 

�� வெப்பப்படுத்தும் ப�ொழுது எளிதில் 
உருசிதைவு அடைந்தும், வளைந்தும் 
ப�ோகக்கூடிய நெகிழிகள் வெப்பத்தால் 
இளகும் நெகிழிகள் என்றழைக்கப்படும். 

�� நெகிழிகள் பலவகையிலாவன. அவற்றுள் 
சிலவகை நெகிழிகள் பாதுகாப்பானதாகவும், 
சிலவகை பாதுகாப்பற்றதாகவும் 
இருக்கின்றன. எனவே, நெகிழிப் 
ப�ொருள்களில் குறிப்பிடப்பட்டுள்ள ரெசின் 
குறியீட்டைக் க�ொண்டோ, 
சுருக்கெழுத்தினைக் க�ொண்டோ, அது 
எவ்வகை நெகிழி என அறிய முடியும். 

�� பாலி லாக்டிக் அமிலம் அல்லது 
பாலிலாக்டைடு என்பது மட்கும் 
தன்மையுள்ள மற்றும் உயிர்ப்புத்திறன் 
க�ொண்ட இளகும் நெகிழி ஆகும்.  

�� நெகிழிகள் பலவகையிலாவன. அவற்றுள் 
சிலவகை நெகிழிகள் பாதுகாப்பானதாகவும், 
சிலவகை பாதுகாப்பற்றதாகவும் 
இருக்கின்றன. எனவே, நெகிழிப் 
ப�ொருள்களில் குறிப்பிடப்பட்டுள்ள ரெசின் 
குறியீட்டைக் க�ொண்டோ, 
சுருக்கெழுத்தினைக் க�ொண்டோ, அது 
எவ்வகை நெகிழி என அறிய முடியும்.  

�� பிளாஸ்டிக்குகளை 5R – க�ொள்கையின் 
அடிப்படையில் பாதுகாப்பாக அப்புறப்படுத்தி 
கையாளலாம் தவிர்த்தல், மறுத்தல், 
குறைத்தல், மீண்டும் பயன்படுத்துதல், 
மறுசுழற்சி செய்தல் அல்லது மீட்டெடுத்தல், 
இல்லையெனில் குழிகளில் இட்டுப் 
புதைத்தல் என்றவாறு நெகிழிக் கழிவுகள் 
மேலாண்மை செய்யப்படுகிறது. 

�� ரெசின் குறியீட்டு எண் #1 ஐ க�ொண்ட PET 
என்ற வகையான பிளாஸ்டிக்கை உண்டு 
செரிக்கும் வகையான 
Ideonellasakaiensis201 – F6 என்ற 
பாக்டீரியாவைக் கண்டறிந்து, ஒருமுறை 
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மட்டுமே பயன்படுத்தும் பாட்டில்களின் 
வகையான பாலி எத்திலுன் டெரிப்தாலேட் 
என்ற நெகிழியின் மாசுபாட்டிற்கு ஓரளவில் 
தீர்வு கண்டுள்ளனர்.

மதிப்பீடு

I. சரியான விடையைத் தேர்ந்தெடுக்கவும் 
1.	ம னிதனால் உருவாக்கப்பட்ட முதல் இழை 

_________ ஆகும். 
அ) நைலான் 	 ஆ) பாலியஸ்டர் 
இ) ரேயான் 	 ஈ) பஞ்சு

2.	வ லுவான இழை _________ ஆகும். 
அ) ரேயான் 	 ஆ) நைலான் 
இ) அக்ரிலிக் 	 ஈ) பாலியஸ்டர்

3.	 ஓர் இயற்கை இழையினைச் சுடரில் 
காட்டினால் அவ்விழை _________

அ) உருகும் 	 ஆ) எரிதல் 
இ) ஒன்றும் ஏற்படுவதில்லை 
ஈ) வெடித்தல் 

4.	கம்ப ளியைப் ப�ோன்ற பண்புகளைக் 
க�ொண்ட செயற்கை இழை _________ 
ஆகும்.
அ) நைலான் 	 ஆ) பாலியெஸ்டர் 
இ) அக்ரிலிக் 	  ஈ) PVC

5.	நெ கிழியின் சிறந்த பயன்பாடென்பது 
_________ என்ற பயன்பாட்டில் அறியலாம். 
அ)இரத்தப்பைகள் 
ஆ)நெகிழிக் கருவிகள்
இ)நெகிழி உறிஞ்சுக் குழாய்கள் 
ஈ)நெகிழி கேரி பைகள் 

6.	 _________ என்பது மட்கும் தன்மையற்ற 
ஒரு ப�ொருள் 
அ) காகிதம் 		  ஆ) நெகிழி புட்டி
இ) பருத்தி துணி 		  ஈ) கம்பளி

7.	 PET என்பது _________ இன் 
சுருக்கெழுத்தாகும்.
அ)பாலியெஸ்டர் 
ஆ) பாலியெஸ்டர் மற்றும் டெரிலின் 
இ)பாலிஎத்திலின்டெரிப்தாலேட்
ஈ) பாலித்தின்டெரிலின்

II. க�ோடிட்ட இடங்களை நிரப்புக
1.	 _________ என்பது பாலியெஸ்டர் துணிக்கு 

ஓர் எடுத்துக்காட்டு ஆகும்.
2.	 பல்வகை நெகிழிகளை இனம்காண 

_________ பயன்படுகின்றன.
3.	 சிறிய அலகுகளான பல ஒற்றைப்படிகளின் 

த�ொடர்ச்சியான சங்கிலித் த�ொடர் 
அமைப்பின் பெயர் _________ ஆகும்.

4.	 முழுமையான இயற்கை இழையின் 
எடுத்துக்காட்டு _________ ஆகும்.

5.  �கக்கூன்களைக் க�ொதிக்க வைத்துப் பெறும் 
இயற்கை இழை _________ என்று பெயர்.

III. சரியா தவறா
1.	 அதிக அளவிலான நெகிழிகள் சுற்றுச்சூழலை 

பாதிக்கின்றன.

2.	ம றுத்தல் (தவிர்த்தல்) என்பது நெகிழியைக் 
கையாளும் சிறந்த முறையாகும்.

3.	ச ெயற்கை இழைகளான ஆடைகளை 
அணிந்து சமையறையில் வேலை செய்வது 
சிறந்ததே.

4.	 வீரியம் குறைந்த நெகிழிகள் சிதைந்து 
மைக்ரோநெகிழிகள் என்ற சிறிய 
துகள்களாகும். 

VII STD Science Term-3 TM  unit 3.indd   78 22-11-2019   12:22:39



79

5.	 பருத்தி என்பது ஓர் இயற்கையான பாலிமர் 
ஆகும்.

IV ப�ொருத்துக.

A B
நைலான் வெப்பத்தால் இளகும் நெகிழி
PVC வெப்பத்தால் இறுகும் நெகிழி
பேக்லைட் இழை
டெஃப்லான் மரக்கூழ்
ரேயான் ஒட்டாத சமையல்கலன்கள் 

V. சரியான வரிசையில் எழுக
1.	 நீர், மாவு, வினிகர் மற்றும் கிளிசரினைக் 

க�ொண்ட ஒரு சமைக்கும் கலனைக் 
கலக்கவும். 

2.	 இப்பொருளை நாம் பயன்படுத்தும் முன் 24 
மணி நேரம் குளிரவைக்கவும். 

3.	 ஒரு குவனை ப�ோன்றோ ஒரு கிண்ணம் 
ப�ோன்றோ வடிவமாக்கவும். 

4.	 அந்தத் திரவம் தெளிவடையும் வரை 
மிதமான சூட்டில் த�ொடர்ந்து கலக்கவும். 

5.	 அந்தத் திரவமானது க�ொதிக்கத் த�ொடங்கும் 
ப�ொழுது அதனை அடுப்பில் இருந்து 
எடுத்துவிடலாம். 

6.	 அந்த ஜெல்லினை அலுமனியத் தட்டின் 
மேல் பரப்பி விடவும். 

VI ஒப்புமை தருக. 
1.	 பருத்தி : இயற்கை : பாலியெஸ்டர் : 

____________

2.	 PLA கரண்டி : மட்கும் தன்மை :: நெகிழி 
ஸ்பூன் : ____________

3.	நை லான் : வெப்பத்தால் உருகும் : பட்டு : 
____________

VII வாக்கியம் மற்றும் காரணம் 
1.	 வாக்கியம் : மண்ணில் புதைக்கப்பட்ட 

காய்கறித் த�ோல்கள் இரு வாரங்களில் 
மறைந்து ப�ோகின்றன. 

காரணம் : காய்கறித் த�ோல்கள் மட்கும் 
தன்மை க�ொண்டவை.

2.	 வாக்கியம் : நைலான் ஆடைகள் 
சிதைந்து மைக்ரோ இழைகளாக மாற 
அதிக காலமாகும். ஆனால் பருத்தி 
ஆடைகள் சிதைவடைய ஆறு மாதகாலம் 
ப�ோதுமானது. 

காரணம் : நைலான் பெட்ரோலிய 
வேதிப்பொருள்களால் தயாரிக்கப்படுவதால் 
மட்கும் தன்மை பெற்றிருப்பதில்லை. 
பருத்தித் துணி மட்கும் தன்மை க�ொண்டது. 

3.	 வாக்கியம் : நெகிழி ப�ொருள்களைத் 
தவிர்ப்பது நல்லது. 

காரணம் : நெகிழிகள் சுற்றுச் சூழலை 
மாசுபடுத்துகின்றன. 

VIII குறுக்கெழுத்து 
இடமிருந்து வலம் 
1.	ச ெயற்கை கம்பளியாகப் பயன்படும் இழை. 
2.	 நீர் பாட்டில்கள் உருவாக்கத் தேவைப்படும் 

நெகிழி
கீழிருந்து மேல் 

3.	 குறை – செயற்கை இழையான இதற்கு 
செயற்கைப்பட்டு என்ற பெயரும் உண்டு. 

4.	 சிறிய ஒற்றைப்படிகளின் த�ொடர்ச்சியான 
சேர்க்கை உருவாக்கும் நீண்ட சங்கிலிப் 
ப�ொருள்
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மேலிருந்து கீழ் 
5.	 கூட்டிலிருந்து பெறப்படும் ஒரு வகையான 

இயற்கை இழை. 

6.	 பாலியெஸ்டர் என வகைப்படுத்தப்படும் ஓர் 
செயற்கை இழை 

7.	க யிறு தயாரிப்பில் பயன்படும் பலபடி

5

1 C L I

2  P 6 E E

3 O R

4 A 7  N

O

IX. மிகக் குறுகிய விடை தருக
1.	 பருத்தியை உருவாக்கும் பலபடிகளின் 

இரசாயனப் பெயர் என்ன? 

2.	நெ கிழி ப�ொருள்கள் வெவ்வேறு 
பண்புகளையும் குணங்களையும் எங்ஙனம் 
பெறுகின்றன? 

3.	நெ கிழிகளையும், செயற்கை இழைகளையும் 
எரிப்பது நல்லதல்ல, ஏன்? 

4.	நெ கிழியினால் செய்த வாளியானது 
துருப்பிடிப்பதில்லை. ஆனால் இரும்பு வாளி 
துருப்பிடித்து விடுகிறது. ஏன்? 

5.	நெ கிழிப் ப�ொருள்களைத் தவிர்ப்பது 
எவ்வாறு சிறந்த முறையாகும்? 

6.	வெப்ப த்தால் இறுகும் நெகிழிப் 
ப�ொருள்களுக்கு இரு எடுத்துக்காட்டுகள் 
தருக. 

7. �  5 R - க�ொள்கை என்பது என்ன?

X சிறுவினா 
1.	 ‘மட்கும் தன்மை வாய்ந்தவை’ என்ற 

ச�ொல்லின் ப�ொருள் என்ன?

2.	க�ோடைக்  காலங்களில் விளையாடும் 
ப�ொழுது அணிய ஏதுவான ஆடைவகை 
யாது? ஏன்?
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3.	 விலங்குகள் மற்றும் சுற்றுச்சூழலில் 
நெகிழியின் தாக்கம் என்ன? 

XI நெடுவினா 
1.	 செயற்கை இழைகளின் பயன்களையும், 

வரம்புகளையும் பட்டியலிடுக. 

2.	நெ கிழிப் ப�ொருள்களை அகற்றும் 
பாதுகாப்பான முறைகள் சிலவற்றினை 
பரிந்துரைக்கவும்.

XII உயர் சிந்தனைத் திறன் வினாக்கள் 
1.	 ஒருமுறை மட்டுமே பயன்படுத்தித் 

தூக்கியெறிப்படும் நெகிழிகளைத் தமிழ்நாடு 
அரசு தடை செய்துள்ளது. அரசின் இந்தச் 
செயல்பாடு எவ்வகையில் முக்கியத்துவம் 
பெறுகிறது. 

2.	நெ கிழிப் பைகள் சிதைவடைய ஏறத்தாழ 
500 ஆண்டுகள் ஆகும் என நாம் அறிவ�ோம். 
ஒரு தலைமுறை மாற 30 ஆண்டுகள் ஆகும் 
எனில், அந்த நெகிழிப்பை மட்குவதற்கு 
எத்தனை தலைமுறைகள் தேவைப்படும். 

XIII பதில் எழுதுக
1. நாம் பயன்படுத்தும் ப�ொருள்கள் எது?
2. இன்று காலை உங்கள் கைகளில் பட்ட முதல் 

நெகிழிப் ப�ொருள் என்ன
3. உங்கள் வகுப்பறையை பார்வையிட்டு 

அதில் காணப்படும் நெகிழியால் ஆன 
ப�ொருள்களைப் பட்டியலிடுக

4. உங்கள் மதிய உணவை எடுத்துச் 
செல்வதற்கும், தண்ணீரை எடுத்துச் 
செல்வதற்கும் நீங்கள் பயன்படுத்தும் 
ப�ொருள்களின் வகைகள் யாவை? 

5. 	 உங்களிடம் உள்ள துணிகளின் 
வகைகளைப் பட்டியலிடுக.

IIV. i) க�ோடிட்ட இடங்களை நிரப்புக

இ�� காைல�� 
��க� ெதா�ட �தலாவ� 

ெந
	� ெபா�� எ�?

உ�கள� 
வ��பைறைய உ�� 

ேநா�
 அ���ள 
ெந
	யா� ஆன 

ெபா��கைள 
வ�ைச�பப���க

நா� பய�ப���� 
ெபா��க�

உ�கள� ம�ய 
உணைவ�� 

���ைர�� ��க� 
எ�த� கல�� 

எ���� 
ெச�
��க�?

உ�க� ஆைடக�� 
பய�ப��த�ப���ள 

���� 
வைககைள 

வ�ைச�பப���க

ii) �க�ொடுக்கப்பட்டுள்ள படத்தினை உற்றுந�ோக்கி 
என்ன நடக்கிறது என்பதை விளக்குங்கள்

iii) �க�ொடுக்கப்பட்டுள்ள தகவல்களைப் படித்து, 
அவற்றை வரைபடத்தில் குறிக்கவும். 
நாடுகளையும் – அவை பயன்படுத்தும் 
நெகிழிப் ப�ொருள்களின் அளவையும் ஒப்பிடுக. 

உலகம் முழுவதும் பயன்படுத்தும் 
ம�ொத்த நெகிழியின் 28 % சீனா பயன்படுத்தி 
பிளாஸ்டிக்கின் அதிக பயனாளி ஆகிறது. 
இந்தோனேசியா 10% பிலிப்பைன்ஸ் மற்றும் 
வியட்நாம் தலா 6% , தாய்லாந்து 3.2 % , எகிப்து 
3%, நைஜீரியா 2.7% மற்றும் தென் ஆப்பிரிக்கா 
2% பயன்படுத்துகின்றன.
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 � மருத்துவம், நுண்ணுயிர்கச்கால்லி, வலி நிவாரணி, நச்சுத்்தபடசபாருள, 
ஒவவாபம பாதிப்பு நீக்க மருந்து (Antihistamine), அமில நீககி, மறறும் ORS 
ஆகியவறபறப் பறறி அறிந்துச்காளளு்தல்

 � எரி்தலின ்தனபம மறறும் அவறறின வப்க்கபளப் பறறி அறிந்துச்காளளு்தல்.

 � சுடர் மறறும் அ்தன அபமப்பபப் புரிந்து ச்காளளு்தல் 

்கறறல் வநாக்கங்கள

அலகு
4 அன்ைாட ்வாழ்வில் 

வ்வதியியல்

அறிமுகம்
1971 ஆம்ஆண்டு வங்காளவ்தெத்தில் 

நடந்்த விடு்தபலப் வபாரினவபாது அ்கதி்களா்க 
சவளிவயறிய மக்கள ்காலரா வநாயினால் 
பாதிக்கப்பட்டனர். அவர்்களுககு வாயவழி 

நீவரறறுக ்கபரெல் Oral Rehydration Solution 
(ORS) உட்ச்காளளச் செய்ததினால் அவர்்களின 
இறப்புவிகி்தம் 50% லிருந்து 3% ெ்தவீ்தமாகக 
குபறந்்தது எனக ்கண்டறியப்பட்டது.
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	 இந்திய மருத்துவரான திலீப் 
மஹாலபாபைஸ் என்பவர், 1971 – 72 ஆம் 
ஆண்டு மக்களுக்குக் காலரா  பரவியிருந்த 
காலங்களில் ORS இன் முக்கியத்துவத்தை 
எடுத்துரைத்தார். உடல் வறட்சியால் 
பாதிக்கப்பட்ட மக்களுக்குச்  செயற்கை திரவ 
உப்பு பற்றாக்குறையைச் சமாளிக்க வேண்டிய 
சூழ்நிலை அவருக்கு ஏற்பட்டது. மணிப்பூரில் 
ஏற்பட்ட காலரா த�ொற்றின் ப�ோது இவர். செய்த 
களச்சோதனையில் ORS சிகிச்சை  முக்கிய 
பங்கு வகித்தது. இதுவரையில் ORS 
உலகெங்கிலும் மில்லியன் கணக்கான 
குழந்தைகளின் உயிர்களைக் 
காப்பாற்றியுள்ளது.

குழந்தைகளே, மேலே உள்ள தகவலைப் 
படித்தீர்களா? இதிலிருந்து நீங்கள் என்ன 
நினைக்கிறீர்கள்? இப்போது ORS மற்றும் 
அதன் செயல்பாடு பற்றித் தெரிந்து க�ொள்ள 
ஆர்வமாக இருப்பீர்கள் அல்லவா?

மேலும் சில ப�ொதுவான மருந்துகள் மற்றும் 
அவை எப்படி செயல்படுகின்றன என்பதைப் 
பற்றியும் தெரிந்து க�ொள்வோமா?

நல்ல ஆர�ோக்கியமாக உள்ள மனிதனின் 
குடலில், சாதாரணமாக 20 லிட்டர் 
தண்ணீரானது குடல்சுவர் வழியாகச் சென்று 
த�ொடர் பரிமாற்றம் நிகழ்கின்றது. கிட்டத்தட்ட 
ஒவ்வொரு 24 மணி நேரத்திலும் நீரானது 
மீண்டும் உறிஞ்சப்படுகிறது. இந்த 
வழிமுறையின் மூலம் செறிக்கப்பட்ட 
உணவிலிருந்து கரையக்கூடிய உயிரினக் 
கழிவுகள் (metabolites) இரத்த ஓட்டத்தில் 
கலக்கின்றன.

வயிற்றுப்போக்கு காரணமாக, ஒரு நபர் 
உடல்நிலை சரியில்லாமல் இருக்கும்போது, நீர் 
வெளியேற்றப்பட்டு உடலானது திரவ 
சமநிலையை இழக்கின்றது. இது நீர்ப்போக்கு 
என்று அழைக்கப்படுகிறது. ஒரு மனிதன் 
இறப்பது வயிற்றுப்போக்கினால் அன்று மாறாக, 
அதிக நீர்ப்போக்கினால்தான் இறப்பு 
ஏற்படுகிறது. உடலின் திரவத்தில் 10% க்கும் 
அதிகமாக நீர் இழப்பு ஏற்பட்டால், மனிதனுக்கு 
இறப்பு ஏற்பட வாய்ப்பு உள்ளது.

UNICEF / WHO விதிமுறைகளின் படி O.R.S பின்வருமாறு தயார் செய்ய வேண்டும்

வ. 
எண் 

புதிய ஓ.ஆர்.எஸ் கிராம் /
லிட்டர்

சதவிதம் % புதிய ஓ.ஆர்.எஸ் mno/
லிட்டர்

1 ச�ோடியம் குள�ோரைடு 2.6 12.683 ச�ோடியம் 75
2 குளுக்கோஸ் 13.5 65.854 குள�ோரைடு 65
3 ப�ொட்டாசியம் 

குள�ோரைடு
1.5 7.317 குளுக்கோஸ் 75

4 ட்ரைச�ோடியம் சிட்ரேட், 
ஷட்ரோட்

2.9 14.146 ப�ொட்டாசியம் 20

5 சிட்ரேட் 10
6 மொத்தம் 20.5 100.00 ம�ொத்த 

சவ்வூடுபரவல்
245
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4.1. வாய்வழி நீரேற்று கரைசல் (ORS)
வாய்வழி நீரேற்று 

கரைசல் (Oral Rehydration 
Solution) என்பது உப்பு, 
சர்க்கரை மற்றும் நீர் 
ஆகியவற்றின் கலவையாகும். 
இது உடலில் அதிக வியர்வை, வாந்தி அல்லது 
வயிற்றுப்போக்கு மூலம் ஏற்பட்ட நீர் 
பற்றாக்குறையை, நீர் மற்றும் 
எலக்ட்ரோலைட்டுகள் மூலம் மீட்டெடுத்து நீர்ச் 
சமநிலையைப் பராமரிக்கின்றது

வயிற்றுப் ப�ோக்கின்போது, உடலின் 
நீர்ச்சமநிலை வெகுவாகப் பாதிக்கப்படுகின்றது. 
அதாவது, நம் உடலானது நீரை உறிஞ்சுவதைக் 
காட்டிலும் அதிக நீரைச் சுரந்து 
வெளியேற்றுகின்றது இதனல் 
வழக்கமானதைவிட ஒரு நாளைக்குப் பல 
லிட்டா்  நீா் இழப்பு ஏற்படுகின்றது. நீர�ோடு 
சேர்ந்து ச�ோடியம் மற்றும் ப�ொட்டாசியம் ப�ோன்ற 
தாதுஉப்புகளையும் நமது உடல் இழக்கின்றது. 

நமது உடல் சரியாக இயங்குவதற்குச் 
ச�ோடியம் (Na) ப�ோன்ற தாது உப்புகள் 
தேவைப்படுகின்றன. உதாரணமாக, நமது 
குடலில் சரியான அளவு ச�ோடியம் 
இருந்தால்தான் நீரானது சவ்வூடு பரவல் 
நிகழ்வின் மூலம் நீரை உறிஞ்ச முடியும். குடல் 
சுவரில் ப�ோதிய அளவு உப்பு இல்லையெனில், 
குடல் உறிஞ்சிகளால் நமக்குத் தேவையான 
நீரை உறிஞ்ச முடியாது.

செயற்கையான உப்பு நீர்க்கரைசலை 
(Saline Solution) நமது உடலில் செலுத்தும்போது 
தண்ணீர் மற்றும் ச�ோடியம் ஆகியவை 
நேரடியாக இரத்த ஒட்டத்திற்கு  
மாற்றப்படுகின்றன. இருப்பினும், உப்பு 
நீர்க்கரைசலை வாய்வழியாக எடுத்துக் 
க�ொள்ளும்போது,  நமது உடலானது நீரைய�ோ, 
ச�ோடியம் உப்பைய�ோ உறிஞ்ச முடியாது. 
ஆனால், குளுக்கோசுடன் உப்பைச் சேர்த்து 

எடுத்துக்கொள்ளும்போது நீர், உப்பு, 
குளுக்கோஸ் ஆகிய மூன்றையும் நமது உடல் 
எடுத்துக் க�ொள்ளும் என்பதை டாக்டர் திலீப் 
மஹாலபாபைஸ் கண்டுபிடித்தார்.

ச�ோடியம் அயனியானது, செறிவின் 
அடிப்படையில் நமது உடல் செல்லிற்குள் 
செல்கின்றது. இதனால், வயிற்றுப் 
ப�ோக்கின்போது நமது குடல் குளுக்கோஸ் 
மற்றும் உப்பு மூலக்கூறுகளை உறிஞ்ச  முடியும். 
வயிற்றுப்போக்கிற்கு எந்தக் காரணமாக 
இருந்தாலும், 90% முதல் 95% ந�ோயாளிகளுக்கு 
இது ஒரு சிறந்த சிகிச்சை ஆகும். இழந்த நீரை 
நமது உடல் மீண்டும் அடைந்து சமநிலை 
பெறுவதின் மூலம், பெரும்பாலான 
ந�ோயாளிகள் காப்பாற்றப்படுகிறார்கள்.

ச�ோடியம் மற்றும் குளுக்கோஸ் ஆகியவை 
நம் சிறுகுடலுடன் இணைந்து இடம் 
பெயர்கின்றன. இது குளுக்கோஸ் 
தட்டுப்பாட்டைப் ப�ோக்கி, நீர் 
உறிஞ்சும்தன்மையை துரிதப்படுத்துகிறது. 
இந்தச் செயல்பாடானது, இந்த நூற்றாண்டின் 
மிக முக்கியமான மருத்துவ முன்னேற்றமாகக் 
கருதப்படுகிறது.

ORS

உணவு

திரவங்கள்

சுகாதாரம்

கை 
சலவை

துத்தநாகம்

தடுப்பூசி

வைட்டமின் 
A

வயிற்றுப்போக்கிலிருந்து 
குழந்தையின் பாதுகாப்பு
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4.2. அமிலநீக்கி (ANTACID):
அமிலத்தன்மை என்பது, இரைப்பையில் 

அதிகமாகச் சுரக்கும் அமிலத்தின்  காரணமாக 
ஏற்படும் அறிகுறிகளாகும். நமது வயிறு 
இயற்கையாகவே இரைப்பை நீர் அல்லது 
ஹைட்ரோகுள�ோரிக் அமிலத்தைச் (HCl) சுரந்து, 
உணவைச் சிறிய துகள்களாக்கி, செரிமானம் 
செய்ய உதவுகின்றது. ஆனால், அமில 
உணவுகள், கார உணவுகள், குடிப்பழக்கம், 
நீரிழிவு மற்றும் மனஅழுத்தம் ப�ோன்றவற்றின் 
காரணமாக அமிலம் அளவுக்கு அதிகமாகச் 
சுரக்கின்றது. அமிலத்தன்மை காரணமாக, 
அதிகப்படியான அமிலம் வயிற்றுப்பகுதியில் 
இருந்து நம் உணவுக்குழாய் வரை செல்லும்.

நமது வயிற்றுப் புறணிச் செல்கள் ஒன்று 
முதல் மூன்று வரையிலான pH க�ொண்ட 
அமிலத்தைத் தாங்குமாறு 
வடிவமைக்கப்பட்டுள்ளன.

நமக்கு அமிலத்தன்மை அல்லது 
நெஞ்செரிச்சல் உண்டாகும்போது 
எடுத்துக்கொள்ளும் மருந்திற்கு ஆன்டாசிட் 
என்று பெயா். இவை ஒரு வலுவற்ற 
காரங்களாகும். ஓர் அமிலத்துடன் சரியான 
அளவு காரத்தைச் சேர்க்கும்போது, அது 
நடுநிலைமையடைகின்றது என்பதை நாம் 
வேதியிலில் படித்துள்ளோம். அதேப�ோல 
ஆண்டாசிட் மருந்துகளை உட்கொள்ளும்போது 
வேதிவினை நிகழ்ந்து குறைந்த அரிக்கும் 
தன்மைவாய்ந்ததாக மாறுகின்றது.

பெரும்பாலான அமில நீக்கிகள்,   ச�ோடியம் 
பை கார்பனேட் (NaHCO3), கால்சியம் 
கார்பனேட் (CaCO3), மெக்னீசியம் 
ஹைட்ராக்ஸைடு (Mg(OH)2), மெக்னீசியம் 
கார்பனேட் (MgCO3) மற்றும் அலுமினியம் 
ஹைட்ராக்ஸைடு Al(OH)3ஆகியவை ஆகும்.

உதாரணமாக, மெக்னீசியம் 
ஹைட்ராக்சைடு ஹைட்ரோகுள�ோரிக் 

அமிலத்தை நடுநிலையாக்கும்பொழுது ஏற்பட்ட 
வினையானது;
Mg (OH)2 (s) + 2 HCl  -----> MgCl2 + 2 H2O (l)

உண���ழா�

வ�� ����த� உண���ழா�� 

� ப�
 ����த�  

அ�ல �ர��க� 
உண���ழா��

�����றன 

4.3. ஆண்டிபயாடிக் (Antibiotics)
சில நூற்றாண்டுகளுக்கு 

முன்பு, சிறிய அளவிலான 
காயங்கள் கூட, 
மனிதா்களுக்கு இறப்பை 
உண்டாக்கும் நிலை ஆனால், 
நு ண் ணு யி ர்க்கொ     ல் லி 
கண்டுபிடிப்பானது அந்நிலையை 
மாற்றிவிட்டது. தற்பொழுது மரணத்தை 
ஏற்படுத்தும் பல த�ொற்று ந�ோய்களைக் 
குணப்படுத்தும் மிகப்பெரும் மருந்தாக 
ஆண்டிபயாடிக்குகள் எனப்படும் ந�ோய் எதிர்ப்புச் 
சக்தி மருந்துகள் இருந்து வருகின்றன.

ஆண்டிபயாடிக் மருந்தானது 
எதிர்பாராவிதமாகக் கண்டுபிடிக்கப்பட்டது. 
அதாவது, 1928ஆம் ஆண்டில் டாக்டர். 
அலெக்சாண்டர் ஃப்ளெமிங் என்ற பிரிட்டிஷ் 
நுண்ணுயிரியலாளர் நிம�ோனியா, 
த�ொண்டைவலி ப�ோன்ற பல ந�ோய்களுக்குக் 
காரணமான ஸ்டேஃபிள�ோக�ோகஸ் 
பாக்டீரியாவை அதற்குண்டான 
பாக்டீரியாவளர்தளத்தில் (Bacterial culture) 
பாக்டீரியா வளர்ப்பதற்கான ஆராய்ச்சிகளை 
மேற்கொண்டார். அவ்வாறு 
மேற்கொள்ளும்போது, அவா் பயன்படுத்திய 
மேசையைச் சுத்தம்செய்யாமல் அப்படியே 

VII STD Science Term-3 TM  unit 4.indd   85 22-11-2019   12:24:46



86

விட்டுவிட்டு விடுமுபறயில் செனறுவிட்டார்.
பல நாள்களுககுப் பிறகு அவா் 

திரும்பிவந்து பார்த்்தவபாது, பாகடீரியா 
வளர்்தளத்தில் பூஞபெ்கள சிறு சராட்டி வடிவில் 
வளர்ந்துளளப்தக ்கண்டறிந்்தார். பாகடீரியா 
வளர்்தளப்பகுதியில் நுண்வணாககியில் 
பார்ககும்வபாது எந்்தப் பாகடீரியாவும் 
வளர்ச்சியபடயவில்பல எனபப்த 
உறறுவநாககினார். குறிப்பிட்ட ஒரு பூஞபெககுப் 
பாகடீரியாபவக ச்கால்லககூடிய ெகதி 
உளளது எனபப்தக ்கண்டறிந்்தார். இவர் 
்தம்முபடய பரிவொ்தபனயில், 
ஸ்ட்ரீப்வடாவ்காக்கஸ், சமனிஙவ்காவ்கா்கஸ் 
மறறும் டிஃசபதீரியா வபசிலஸ் வபானற 
பரவலான தீஙகு விபளவிககும் 
பாகடீரியாக்கபள, ஈடுபடுத்தினார்.  இறுதியில் 
சபனசிலின வநாட்வடட்டம் எனற பூஞபெயானது 
பாகடீரியக்கபள அழிககினறது எனபப்தக 
்கண்டறிந்்தார்.

உலகின மு்தல் ஆண்டிபயாடிக மருந்து 
சபனசிலியம்சநாவடட்டம் எனற 
பூஞபெயிலிருந்து ்கண்டறியப்பட்டது. 
ஃபிசளமிங ச்தாறறுவநாய்களுககு 
சிகிச்பெயளிப்ப்தறகு முனவப, 
ஆயிரக்கணக்கான ஆண்டு்களுககு முனனர் 
ச்தாறறு வநாய்கபளக குணப்படுத்துவ்தறகு 
மு்தனமு்தலா்க பூஞபெ பயனபடுத்்தப்பட்டுளளது. 
எனப்தற்கான ொனறு்கள உளளன. 
எடுத்துக்காட்டா்க,  பண்படய எகிப்தியர்்கள, 
பாதிக்கப்பட்ட ்காயங்களுககு சராட்டி பூஞபெப் 

பயனபடுத்தினார்்கள. பண்படய 
கிவரக்கர்்களிபடவயயும், செர்பியாவிலும், 
இந்தியாவிலும் இது வபானற சிகிச்பெ 
முபற்கள ்கண்டறியப்பட்டுளளன. அபவ 
சிறி்தளவவ பயனுளள்தா்க இருந்்த வபாதிலும், 
நவீன ்காலங்களில் நுண்ணுயிர் எதிர்ப்புச் 
ெகதி ச்காண்ட ஆண்டிபவயாடிக மருந்து்களின 
மூலம் பல சிகிச்பெ்கள சவறறி்கரமா்க 
வமறச்காளளப்பட்டு வருகினறன.

ஃப்சளமிங, சபனசிலின மருந்து 
்கண்டுபிடித்்த பிறகு, இரண்டாம் உல்கப் வபாரில் 
வபாது ்காயமபடந்்த வீரர்்களுககுப் சபனசிலின 
பயனபடுத்்தப்பட்டது, இ்தன முடிவு்கள மி்கவும் 
வியப்பா்க இருந்்தன. மு்தலாம் உல்கப் வபாரில், 
பாகடீரியாவினால் எறபடுத்்தககூடிய 
நிவமானியா எனற ச்தாறறு வநாயால் இறப்பு 
18% லிருந்து  இரண்டாம் உல்கப் வபாரின 
வபாது, 1% ெ்தவிகி்தத்திறகும் குபறவா்கவவ  
இருந்்தது எனறு வரலாறு்கள கூறுகினறன.

சில ்தாவரங்களும், நுண்ணுயிரி்களும் 
நச்சுத்்தனபமயுளள சபாருள்கபள உறபத்தி 
செயகினறன. இந்்தப் சபாருள்கள,  மறற 
உயிரினங்கபள அழிக்க உ்தவுகினறன. 
இபவ நுண்ணுயிர் எதிர்ப்பி்கள என 
அபழக்கப்படுகினறன. இனறு பல மருந்துத் 
ச்தாழிறொபல்கள ஆண்டிபயாட்டிக 
மருந்து்கபள செயறப்க முபறயில் உறபத்தி 
செயகினறனா்  உ்தாரணம்: குவளாராபினி்கால் 
மறறும் சடட்ராபெகளின வபானறபவ  புதிய 
வப்க ஆண்டிபயாடிககு்கள ஆகும். 

 v ஆண்டிபவயாடிக ்தவிர, செயறப்க 
முபறயில் பல ஆண்டிபயாடிககு்கபள நம்மால் 
உருவாக்க முடியும். இந்்த வப்க 
்கண்டுபிடிப்பு்களின மூலம், இபவ மி்கக 
குபறவான விபலயில் இனறு மக்களுககு 
வழங்கப்படுகினறன. பாகடீரியாவால் 
ஏறபடககூடிய ச்தாறறு வநாய்களும், இறப்பு 
விகி்தங்களும் ்தறவபாது குபறந்துளளன.

நுண்ணுயிர் எதிர்ப்பி்கபள அதி்கமா்கப் 
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பயனபடுத்துவப்த நாம் ்தவிர்த்்தல் வவண்டும். 
ஏசனனில் ஒரு நபர் ச்தாடர்ந்து சநடுங 
்காலத்திறகு ஆண்டிபயாடிக  எடுத்துகச்காளளும் 
வபாது, நுண்ணுயிர் எதிர்ப்பி்களின செயல்பாடு 
குபறகிறது.  எனவவ, இ்தறகு மாறறா்க அவர் 
அதி்க வீரியம் ச்காண்ட மருந்து்கபள 
உட்ச்காளள வநரிடும். இவவாறு 
ஆண்டிபயாடிக்கானது, இனறு சபரிய 
அளவிலான வநாய்களுககுப் சிகிச்பெ்களுககு 
இனறு பயனபட்டு வருகினறது.

ெளி மறறும் புளூ 
வபானற வநாய்கபள 
ஏறபடுத்தும் பவரஸ்்களுககு 

ஆண்டிபயாடிக மருந்து்கள வவபல 
செயவதில்பல.

4.4. ்வலிநி்வேணிகள் (Analgesics)
்காயம், தீப்புண்்கள, கூர்பமயான 

சபாருள்கள அழுத்துவ்தாலும் மறறும் பிற 
்காரணங்களாலும் நம் உடலில் வலி 
ஏறபடுகினறன.  ்காயப்பட்ட  இடத்ப்தச் சுறறிலும் 
எழும் எரிச்ெல் உணர்வவா, அதி்கமான 
்தபலவலிவயா அல்லது மூட்டு சுழறசியால் 
ஏறபடும் வலியுணர்வவா ்காரணமாயிருக்கலாம்.  
்கழுத்து வலி, முதுகு வலி, மூட்டு வலி, ்தபலவலி, 
நரம்பு வெ்தமுறுவ்தால் ஏறபடும் வலி, 
்காயம்படுவ்தால் உண்டாகும் வலி மறறும் 
வியாதி்களால் ஏறபடும் வலி ஆகியபவ சில 
சபாதுவான வலி்களாகும்.

வலி எனற இந்்த விரும்பத்்த்கா்த 
மனசவழுச்சியானது மூபளயில் 
உருவாகிறவ்தயனறி இவசவழுச்சி ்காயப்பட்ட 
இடத்திலில்பல. வலி ்கடுபமயா்க இருப்பின, 
எடுத்துக்காட்டா்க, தீப்புண்ணாயிருப்பின அந்்த 
உந்து்தல் மூபளபயச் செனறபடந்்தவுடன 
மறுசமாழி ்தரத்துண்டுகிறது. அவவாறு 
மூபளயிடமிருந்து சபறப்படும் ெமிகபஞயில், 

தீயிலிருந்து நம் ப்கயின ்தபெ்கள 
பினனிழுக்கப்படுகினறன.

வலியுணர்ப்படும் புளளிலிருந்து வரும் 
்த்கவல்்களுககு எதிர்விபனயாறறும் வி்தமா்க 
மூபளயும் ்த்கவல்்தரத் ச்தாடஙகும் முபறவய 
நிவாரணத்தின ச்தாடக்கம் ஆகும். வலிபய 
அடககும், குபறககும் வவதிப்சபாருபள 
சவளிவயறறுவது மறறும் கூடு்தலான 
சவளபள இரத்்த அணுக்கபளயும், 
இரத்்தத்்தட்டு்கபளயும் ்காயம்பட்ட இடத்திறகு 
அனுப்புவது ஆகிய செயல்்கள மூலம் 
நிவாரணமுபற ச்தாடரும்.

வலிநிவாரணி்கள அல்லது வலிநீககி்கள 
எனபன நமது உடலியிருந்து சவளியாகும் 
வலி-குபறககும் வவதிப்சபாருள்களாகும். 
அபவ சவளிவயறி  வலி எனற உணர்பவக 
்கட்டுப்படுத்துகிறது. பமய நரம்பு மண்டலத்தில் 
வநரடியா்க செயல்பாவடா அல்லது வலி 
உணரப்படும் புறநரம்பு இடங்களில் 
அதி்கமாறறம் இல்லா்த, நிபலயில் குறிப்பா்க 
இவவப்க வலிநீககி்கள செயல்படுகிறது.

1. வலி மூலம்

3.  மூபள வலி 
ச ெ ய தி ்க ப ள 
விளககுகிறது

2.  வலி செயதி்கள 
புற நரம்பு்கள 
வ ழி ய ா ்க வு ம் , 
மு து ச ்க லு ம் பு 
வ ழி ய ா ்க வு ம் 
ந்கரும்

4.  மூபள வலிபய 
அடககும் 
வவதிப்சபாருட்்கபள 
அனுப்புகிறது மறறும் 
பிற பதில்்கபளத் 
தூண்டுகிறது
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காய்ச்சலில் அவதியுறும்பொழுது நாம் 
பாராசிட்டாமால் உட்கொள்கிற�ோம். 
பாராசிட்டமால் நமது உடலில் ஏற்பிகளுடன் 
த�ொடர்பு க�ொண்டு, மூளைக்கு அனுப்பப்படும் 
வலியின் தீவிரத்தைக் குறைத்தும், வலி மற்றும் 
உடல்வெப்பநிலையை அதிகரிக்கும் 
புர�ோஸ்டாகிளான்டின்களின்  அளவைக் 
கட்டுப்படுத்தியும் செயல்படுகின்றன.

மயக்க மூட்டிகள்:
1860 இல் ஆல்பர்ட் 

நீம்மானின் என்பவர் க�ோக�ோ 
இலைகளிலிருந்து க�ோகைன் என்ற 
முதல் மயக்கமூட்டும் மருந்தினைப் 
பிரித்தெடுத்தார்.

பாரம்பரிய வீக்க நீக்கிகள்
அவை பின்வருமாறு 

வகைப்படுத்தப்படுகிறது
1. ப�ோதைத் தன்மையற்ற (சேர்த்திகள் அற்ற) 

வலி நீக்கிகள், எடுத்துக்காட்டாக, ஆஸ்பிரின்
2. ப�ோதைத்தன்மை வாய்ந்த வலிநீக்கிகள்  

எடுத்துக்காட்டாக, க�ோடீன்

புதினா கேட்னிப் 
4.5. உடல் வெப்பம் தனிப்பி (Antipyretic)

சாதாரனமாக மனித உடலின் 
வெப்பநிலையானது 98.4 முதல் 98.6 டிகிரி 
பாரன்ஹீட்வரை இருக்கும். வெப்பமானது இந்த 
நிலைக்கு மேலே சென்றால் அது காய்ச்சல் 
என்று அழைக்கப்படுகிறது. காய்ச்சல் வருவதற்கு 
ப�ொதுவான காரணம் ந�ோய்த்தொற்றாகும். 
ந�ோயை உண்டாக்கக்கூடிய பாக்டீரியா 

மற்றும் வைரஸ்கள் ஒரு குறிப்பிட்ட 
வெப்பநிலைக்கு மேல் வளர முடியாது. எனவே 
படையெடுக்கும் ந�ோய் கிருமிகளிலிருந்து 
நம்மை பாதுகாக்க ந�ோய் எதிர்ப்பு சக்தியானது 
நம் உடலின் வெப்பநிலையை 
அதிகரிக்கச்செய்திறது.

நமக்கு ந�ோய்தொற்று ஏற்பட்டவுடன் ந�ோய் 
எதிர்ப்பு அமைப்பானது பைர�ோஜன் என்ற 
வேதிப்பொருளை வெளியிடுகிறது. இரத்த 
ஓட்டத்தின் மூலமாக இந்த பைர�ோஜன்கள் 
மூளையின் அடிப்பகுதியில் இருக்கும் 
ஹைப்போதாலமஸை சென்றடைகின்றன. 
ஹைப்போதாலமஸின் பனி நம் உடலின் 
வெப்பநிலையை கட்டுப்படுத்துவதாகும். 
பைர�ோஜன்கள் ஹைப்போதாலமஸை 
சென்றடைந்தவுடன் புர�ோஸ்டாகிளான்டின் 
என்ற வேதிப்பொருளை வெளியிடுகின்றது, 
இது நம் உடலின் வெப்பநிலை அதிகரிக்க 
காரணமாகின்றது.

ப�ொதுவாக குறைந்தளவு காய்ச்சல் நமக்கு 
நல்லது, ஏனெனில் இவை ந�ோய்கிருமிகளின் 
வளர்ச்சியை தடுக்கிறது. இருப்பினும் உடல் 
வெப்பநிலை 105 டிகிரி பாரன்ஹீட்டைவிட 
அதிகரிக்கும்போது புரதம் மற்றும் மூளையை 
தாக்கி நடுக்கம் மற்றும் வலிப்பு ஏற்பட 
வாய்ப்புள்ளது. நீண்டநாள் காய்ச்சலானது சில 
நேரங்களில் மரணத்தைகூட உண்டாக்கும்.

ஆன்டிபைரடிக்ஸ் என்பது காய்ச்சலை 
குறைக்கும் ஒரு வேதிப் ப�ொருளாகும் (anti - 
against and pyretic -Feverish). இவை 
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புர�ோஸ்டாகிளான்டின் உற்பத்தியை ஒடுக்கி 
காய்ச்சலை குறைக்கின்றன. பாரசிட்டமால் 
மிகவும் ப�ொதுவான, நன்கு அறியப்பட்ட 
ஆன்டிபைரடிக் ஆகும். இது தவிர ஆஸ்பிரின், 
இபுருஃபன், டைக்ளோபினாக் ஆகியவை உடல் 
வெப்பம் தனிப்பி மற்றும் அழற்சி நீக்கியாகும்.

4.6. ஆண்டிசெப்டிக் (Antiseptic)
த�ொற்றுந�ோய் ஏற்படுத்தும் கிருமிகளை 

அழிக்கவும், நுண்ணுயிர்களை எதிர்க்கும் 
வகையிலும் உடலின் மேல்புறம் 
பயன்படுத்தப்படும் மருந்து ஆண்டிசெப்டிக் 
என்று அழைக்கப்படுகின்றது. ஆண்டிசெப்டிக், 
பாக்டீரியாக்களின் கூட்டமைப்புகள், 
பூஞ்சைகள், வைரஸ்கள் அல்லது பிற 
நுண்ணுயிரிகளின் கலவைகளைத் தீவிரமாக 
எதிர்க்கும் ஆற்றலைப்பெற்றுள்ளது. குளியல் 
ச�ோப், ஐய�ோட�ோபார்ம், பினாலிக்நீர்மங்கள், 
எத்தனால், ப�ோரிக்அமிலம் ஆகியன 
ஆண்டிசெப்டிக்கு உதாரணங்களாகும். 

1. கிருமி நாசினி 
குள�ோர�ோசைலென�ோல் மற்றும் 
டெர்பென்கள் 

ஆகியவை சேர்ந்த 
கலவையாகும்
2. அய�ோடின் (Tincture) 
அய�ோடின் + 2 to 
3% ஆல்ஹகால் – 
நீர்கலந்த ச�ோப்பு 
கரைச    ல் , 
ஐய�ோடஃபார்ம் , 
பினாலிக் கரைசல்கள், எத்தனால் மற்றும் 
ப�ோரிக் அமிலம் ஆகியவை சில 
எடுத்துக்காட்டுகளாகும்

4.7. �ஒவ்வாமை பாதிப்பு நீக்கமருந்து 
(Antihistamine)
சில நேரங்களில் நமது ந�ோய் எதிர்ப்பு 

மண்டலம் தீங்கான ப�ொருள் என்று அவற்றை 
உடலில் ஏற்றுக்கொள்வது கிடையாது. இந்த 
வகையான ந�ோய் எதிர்ப்பு அமைப்பு ஒவ்வாமை 
பாதிப்பு (ஹிஸ்டாமைன்) என்றழைக்கப்படும். 
நமது நாசியில் நுழையும் தாவரங்களின் 
மகரந்தத் தூள், எரியும் தாவர இலை மற்றும் சில 
கரிம ப�ொருள்களின் வாசனை  ப�ோன்ற 
ப�ொருள்கள் ஒவ்வாமை பாதிப்புகளை 
ஏற்படுத்துவதற்குச் சில எடுத்துக்காட்டுகளாகும்.

இவை உடலுக்குப் பாதிப்பில்லாவை தாம், 
ஆனால், இரசாயனத்தை உற்பத்தி செய்யும் 
ப�ொருள்களாக விளங்குகின்றன. ஒவ்வாமை 
பாதிப்பு ஒருவரின் கண்கள், மூக்கு, த�ொண்டை, 
நுரையீரல், த�ோல் அல்லது இரைப்பை, இரத்தம் 
மற்றும் குடல் ப�ோன்ற இடங்களில் ஒவ்வாமை 
அறிகுறிகளை ஏற்படுத்துகிறது. நமக்குள் நாசி 
ஒழுகுதல், தும்மல், த�ோல் தடித்தல் அல்லது 
த�ோல் எழுச்சி, அரிப்பு, சிவப்பு ச�ொறி (படை 
ந�ோய்) ஆகியவற்றை உருவாக்குகிறது. 
ஒவ்வாமை என்பது, உடலின் 
எதிர்வினையாகும். இது, பாதகமான 
விளைவுகளான வாய் வறட்சி மற்றும் 
தூக்கத்தை ஏற்படுத்துகிறது. 
டிஃபென்ஹைட்ரமைன், குள�ோர்பெனிரமைன், 
சிமெடிடின். ஆண்டிஹிஸ்டமினிக்ஸின் 
ப�ோன்றவை சில எடுத்துக்காட்டுகளாகும்.

இயற்கை ஆண்டிசெப்டிக்
1. பூண்டு,    2. மஞ்சள்,   3. ச�ோற்றுகற்றாலை 
4. வெங்காயம்,        5. முள்ளங்கி
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மருத்துகள்
உடல் ந�ோய்களுக்குச் சிகிச்சையளித்து 

அதனைக் குணப்படுத்துவதற்கும் நமது 
சுகாதாரத்தை மேம்படுத்துவதற்கும் மருந்துகள் 
பயன்படுகின்றன. பெரும்பாலான மக்கள் 
தங்கள் வாழ்நாளில் சில மருந்துகளையாவது 
உட்கொள்கின்றனர்.
ந�ோய்நாடி ந�ோய்முதல்நாடி அது தணிக்கும்
வாய்நாடி வாய்ப்பச்செயல் – வள்ளுவன் வாக்கு

மருத்துவம் என்பது ந�ோயைக் கண்டறிதல், 
சிகிச்சை செய்தல் மற்றும் தடுப்பதற்கான 
அறிவியல் ரீதியான அனுகுமுறையாகும். 
மருந்தை உட்கொள்ள பல வழிகள் உள்ளன.
அவையாவன 1. வாய்வழி பயன்பாடு, 2. 
வெளிப்புற பயன்பாடு, 3. ஊசி மருந்துகள் (உள் 
தசை / உள் சிரை). நாம் எடுத்துக் க�ொள்ளும் 
மருந்துகள் நம் ந�ோய்க்கு சிகிச்சையளித்து 
நல்ல உடல்நலத்தைக் க�ொடுக்கினறன

எனக்குப் 
பரிந்துரைக்கப்படாத 
எந்த மருந்தையும் 

உட்கொள்ளக் கூடாது 
என எனக்குத் தெரியும்

நான் நன்கு 
வளர்ந்த பின்னரே 

மருந்தினை 
உட்கொள்வேன்

எப்போதும் 
மருந்துகளைப் 
பாதுகாப்பாக 

பயன்படுத்தவேண்டும்

எரிதல்
இரும்பு உருகுதல், 

நிலக்கரி எரிதல் மற்றும் 
மெழுகுவத்தியின் சுடர் 
ஆகியவற்றில் ப�ொதுவானவை எவை என்று 
சிந்திக்க முடியுமா? இவை அனைத்தும் எரிதல் 
எனப்படும். எரிதல் என்பது, ஓர் எரிப�ொருள் 
ஆக்சிஜனேற்ற காரணியின் முன்னிலையில் 
நிகழும் வேதி வினையாகும். இவற்றில் 
வெப்பம், ஆற்றல்  மற்றும் ஒளியும் 
வெளியிடப்படும்.

ஆண்டிசெப்டிக் கிருமிநாசினிகள்
1. �அனைத்து ஆண்டிசெப்டிக்களும் 

கிருமிநாசினிகள் ஆகும்.
1. �அனைத்து கிருமிநாசினிகளும் 

ஆண்டிசெப்டிக் அல்ல.

2. �இது நேரடியாக உயிருள்ள செல்களின் மீது 
பயன்படுத்தப்படுகிறது.

2. இது உயிரற்ற ப�ொருள் மீது தெளிக்கலாம்.

3. எ.கா. த�ோல் / சளி 3. எ.கா. மேற்பரப்பு, ஆய்வக மேசை, தரைகள்.

குறிப்பிட்ட அளவைவிட அதிகமாக 
எடுத்துக்கொள்ளும் மருந்தினால் 
தீங்கு விளையும் என எனக்குத் 

தெரியும். மருந்துப் புட்டியின் மேல், நாம் 
எடுத்துக் க�ொள்ளவேண்டிய மருந்தின் 

காலவதி குறிப்பிடப்பட்டிருக்கும்

மருந்துகளை உரிய இடத்தில் 
பாதுகாப்பாக வைக்க வேண்டும்.  

சிறுவயது குழந்தைகளின் கைகளுக்கு 
எட்டாத இடத்தில் வைக்கவேண்டும் என 

எனக்குத் தெரியும்

 மருந்துகள், 
இனிப்புசுவை அல்ல 

என்பதை நன்கு 
உணர்ந்துள்ளேன்.
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‘எரிதல்’ என்பது எரியும் 
வேதிவினைதானா? எரிதல் மனிதர்களால் 
வேண்டுமென்றே பயன்படுத்தப்பட்ட முதல் 
இரசாயன வினைகளில் ஒன்றாகும். 
ஆக்ஸிஜனுடன் வினை புரியும் எந்த நிகழ்வும் 
ஆக்ஸிஜனேற்ற வினை என்று 
அழைக்கப்படுகிறது. ஆக்ஸிஜனுடன் 
ஹைட்ரோகார்பனை எரிப்பதில், ப�ொதுவாகக் 
கார்பன் டை ஆக்சைடு மற்றும் நீர் உற்பத்தி 
செய்யப்படுகின்றன.

CH4+2O2 → CO2+2H2O + வெப்ப ஆற்றல்

(ஹைட்ரோகார்பன்) (ஆக்ஸிஜன்) (கார்பன் டை ஆக்சைடு) (நீர்)

அனைத்து எரிதல் வினையின்போது, 
வெப்பம் வெளியிடப்படுவதால் இது வெப்ப 
உமிழ்வினை எனப்படுகிறது.

எரிவெப்பநிலை:
ஒரு ப�ொருள் எரிவதற்குத் தேவையான 

குறைந்தபட்ச வெப்பநிலை, அதன் எரி 
வெப்பநிலை என்று அழைக்கப்படுகிறது.  எ.கா. 
மத்தாப்பு எரிதல், ஒரு ப�ொருள் அதன் எரி 
வெப்பநிலையைவிடக் குறைவாக இருந்தால் தீ 
பிடிக்காது, எரியாது, வெவ்வேறு ப�ொருள்கள் 
வெவ்வேறு எரிவெப்பநிலைகளைக் 
க�ொண்டுள்ளன. என்பதை முந்தைய 
பருவத்தில்,  இயற்பியல் பாடத்தில் 
கற்றுக்கொண்டோம்.

மிகக் குறைந்த எரிவெப்பநிலையைக் 
க�ொண்ட ப�ொருள்கள் எளிதில் 
தீபிடிக்கக்கூடியவை. ஆதலால், இவை 
எரியக்கூடிய ப�ொருள்கள் என்று 
அழைக்கப்படுகின்றன. 

எடுத்துக்காட்டாக பெட்ரோல், ஆல்கஹால், 
எல்.பி.ஜி (திரவ பெட்ரோலிய வாயு), சி.என்.ஜி 
(அழுத்தப்பட்ட இயற்கை எரிவாயு).
சுடர்:

நெருப்பு ஒரு வாயுவா? ஒரு திரவமா,  ஒரு  
திடப்பொருளா?

சுடர் என்பது, ஒரு வேதிவினை மற்றும் 
வாயுக்களின் கலவையாகும்.  சுடரானது ஒளி 
மற்றும் வெப்பத்தைத் தருகிறது. இது 
பருப்பொருள் அன்று, . ஆனால், நெருப்பு ஒரு 
பருப்பொருள்.  ஆவி நிலையிலுள்ள எரிப�ொருள், 
ஆக்ஸிஜன், கார்பன் டை ஆக்சைடு, கார்பன் 
ம�ோனாக்சைடு,  நீராவி மற்றும் பல எளிதில் 
ஆவியாகிற ப�ொருள்கள் ஆகியவை சுடரின் 
வேதிவினையாக்க் கருதப்படுகின்றன. 
சுடர் மற்றும் அதன் அமைப்பு:

ஒளியின் திருவிழா எது? அந்த விழாவின் 
சிறப்பு என்ன? ஆம். வீடுகளை அலங்கரிக்க 
அதிக விளக்குகளை ஏற்றி வைப்போம் 
இல்லையா? இப்போது விளக்குகள் எவ்வாறு 
ஒளிர்கின்றன? ஆம், சுடருடன்.

நிகழ்வு
தீப்பிடித்தலின் வேதிவினை

ஆக்ஸிஜன் + வெப்பம் + எரிப�ொருள் = தீ
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வண்ண வண்ண சுடர் ச�ோதனை செய்வோம் 
வாருங்கள்
•	 வண்ண வண்ணச் சுடர் ச�ோதனை 

செய்வோம் வாருங்கள்:
•	 வெண்மை சுடர் – எப்சம் உப்பு
•	 ஊதா சுடர்  - லித்தியம் உப்பு
•	 இண்டிக�ோச சுடர் – �ப�ொட்டாசியம் 

குள�ோரைடு
•	 நீல சுடர்– பிளீச்சிங்பவுடர்
•	 பச்சை சுடர் – ப�ோராக்ஸ்பவுடர்
•	 மஞ்சள் சுடர் – கால்சியம்குள�ோரைடு
•	 ஆரஞ்சு சுடர் – சமையல்உப்பு
•	 சிவப்பு சுடர் – ஸ்டிரான்ஸ்யம்குள�ோரடு

ஆசிரியரின் உதவியுடன் மேற்கண்ட 
உப்பை ஆல்கஹால் கலவையுடன் எதாவது 
ஒரு சுடருடன் வண்ணமாக்கி மகிழலாம்.

அ�க 
ெவ�ப� 

�தமான 
ெவ�ப� 

�ைற�த 
ெவ�ப� 

ெவ
�ப�� ��ைமயாக 
எ�த�  (�ல�)

ந��ப�� பா� 
எ�த� (ம�ச�)

உ� ப�� ஏ�யாத �ைல 
ெம��வ � (க­��)

ெம��வ � 

சுடர் என்பது, எரியக்கூடிய ப�ொருளின் 
எரிதல் மண்டலமாகும். எரியும்போது 
ஆவியாகும் ப�ொருள்கள் சுடரை 
உருவாக்குகின்றன. எடுத்துக்காட்டு: மெழுகு, 
மண்ணெண்ணெய் ப�ோன்றவை ஆகும். 

ஆனால், சில ப�ொருள்கள் சுடரை உருவாக்காது, 
ஏனெனில், அவை ஆவியாகாத ப�ொருள்களைக் 
க�ொண்டுள்ளன. எ.கா.நிலக்கரி
மெழுகு சுடரின் அமைப்பு :

ஒரு மெழுகுவர்த்திச் சுடர் மூன்று முக்கிய 
மண்டலங்களைக் க�ொண்டுள்ளது, 
அவையாவன,
I. சுடரின் வெளிப்புறப் பகுதி:

எரிப�ொருள் முழுமையான எரிதல் 
நடைபெறும் பகுதியாகும், இது நீலநிறத்தை 
க�ொண்ட வெப்பமான பகுதியாகும். இது சுடரின் 
ஒளிராத பகுதியாகும்.
II. சுடரின் நடுப்பகுதி:–

எரிப�ொருள் குறைவாக எரிதல் நடைபெறும் 
பகுதியாகும், இது மஞ்சள் நிறத்தை க�ொண்ட 
வெப்பமான பகுதியாகும்.இது சுடரின் ஒளிரும் 
பகுதி.
III. சுடரின் உட்புற பகுதி:-

எரிப�ொருள் எரியாத வாயுக்களைக் 
க�ொண்ட பகுதியாகும். இது கருமை நிறம் 
க�ொண்ட மிக குறைந்த வெப்பப்பகுதியாகும்.

சுடர் உள்ளே 
விரல்

மெழுகுவர்த்தி சுடர் ஏன் நேராக 
இருக்கிறது?

மெழுகுவர்த்தியின் மேலே 
உள்ள காற்று எரிவதால் 
மெழுகுவர்த்தி சுடர் 

உருவாகிறது. வெப்பசலனக் 
க�ொள்கையின்படி சுடரின் மேல் 
எரியக்கூடிய காற்றின் அடா்த்தியானது 
சுற்றுப்புறத்தில் உள்ள காற்றின் 
அடா்த்தியைவிட குறைவாக இருப்பதால் 
சுடரானது எப்போழுதும் மேல்நோக்கி 
இருக்கின்றது.
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nehia Fzg;gLj;Jk; 
mwptpay; fiy

xt;thik 
ghjpg;ig ePf;Fk;
vjph;g;g[ kUe;J

clypy; Ez;qaph;
tsh;r;rpia jLf;Fk;
Ez;qaph; vjph;g;gp

tapw;wpd;
mkpyj;jd;ikia
rkepiygLj;Jk;

mkpyePf;fp 

epyf;fhp cUthjy;

Rlh;

mfr;rptg;g[ kw;Wk; g[w Cjh 
fjph;fs; ckpH;fpd;w 

tha[f;fshYk;
jplg;bghUs;fshYk; 
bfhz;l fyitahFk;.

vhpjy;

bghUl;fs;
Mf;!p$Dld; 

vhpe;J xspiaa[k; 
btg;gj;ija[k;

jUjy;

jd;dpr;irahf
vhpjy;

btd;gh!;gu!;

bkJthf
vhpjy;

ntfkhf
vhpjy; 

Kw;W bgwhky; vhpjy; 

neha; fpUkpfis
mHpf;Fk; 

g[z;zhw;wpahd
fpUkpehrpdp

OR
S

ORS

jPtpu tapw;Wg; 
nghf;fpw;F
czt[ rhh;e;j
tha;tHp ePnuw;w
fiury;

kdpj K:isapy; 
typ my;yJ 

czh;r;rp czuhik
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கல�ோரி மதிப்பு:

ஒரு கில�ோ எரிப�ொருளானது முழுமையாக 
எரிதல் நடைபெற்று வெளியிடப்படும், வெப்ப 
ஆற்றலின் அளவு ஒரு கல�ோரிஃபிக் மதிப்பு 
என்று அழைக்கப்படுகிறது. கல�ோரிஃபிக் மதிப்பு 
= உற்பத்தி செய்யப்படும் வெப்பம் / எரிக்கப் 
பயன்படுத்தப்படும் எரிப�ொருளின் அளவு kJ / kg 
இல்

4.5 கில�ோ எரிப�ொருள் முழுவதுமாக 
எரிந்து, உற்பத்தி செய்யப்படும் வெப்பத்தின் 
அளவு 1, 80,000 கி.ஜே. என அளவிடப்படுகிறது 
என்றால் அதன் கல�ோரிஃபிக் மதிப்பு என்ன?

கல�ோரிஃபிக் மதிப்பு = 1, 80,000 / 4.5 = 40,000 
� KJ / Kg

CO- சுவாச பிரச்சனைக்கு வழிவகுக்கிறது
CO2- உலக வெப்பமயமாதல்
SO2/NO2 – அமிலமழை

சுற்றுச்சூழல் பாதிப்புகள்

தீர்வுகள்

பல்வேறு எரிப�ொருள்களின் கல�ோரிஃபிக் 
மதிப்பு

எரிப�ொருள் கல�ோரிஃபிக் மதிப்பு (kJ / kg)

மாட்டுச்சாணம் 6000-8000

மரக்கட்டை 17000-22000

நிலக்கரி 25000-33000

பெட்ரோல் 45000

மண்எண்ணெய் 45000

டீசல் 450000

மீத்தேன் 500000

சி.என்.ஜி 50000

எல்.பி.ஜி 55000

பய�ோகேஸ் 35000-40000

ஹைட்ரஜன் 150000
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எரிதலின் ்வறககள்:
மூனறு வப்க எரி்தல் செயல்்கள 

நபடசபறுகினறன, அபவ,
வ்வகமாக எரிதல்:

சவளிப்புற சவப்பத்தின உ்தவியுடன 
சபாருளானது வவ்கமா்க எரிந்து சவப்ப 
ஆறறபலயும் ஒளிபயயும் உருவாககுகிறது. 
எ.்கா. எல்.பி.ஜி எரி்தல்.

தன்னிசறெயான எரிபபு: 
சவளிப்புற சவப்பத்தின உ்தவியினறி 

சபாருளானது ்தனனிச்பெயா்க எரிந்து சவப்ப 
ஆறறபலயும் ஒளிபயயும் உருவாககுகிறது. 
எ.்கா. பாஸ்பரஸ் அபற சவப்பநிபலயில் 
்தனனிச்பெயா்க எரி்தல்.

சமது்வாக எரிதல்:
சபாருளானது குபறந்்த வவ்கத்தில் 

எரி்தலுககு சமதுவா்க எரி்தல் எனறு சபயர்.  
சுவாசித்்தல் சமதுவா்க எரி்தலுககு 
உ்தாரணமாகும்.

ெசயல்பாடு : 1

ெர்க்கபர + சபாட்டாசியம் 
சபர்மாங்கவனட்+கிளிெரின 
வமற்கண்ட வவதிப்சபாருள்கபள  வெர்ககும் 
வபாது எனன நி்கழ்கிறது;?

ஒரு நல்ல எரிசபாருளின் பண்புகள்:
 � எளி்தா்கக கிபடக்க வவண்டும்
 � குபறந்்த விபலயா்க இருத்்தல் வவண்டும்
 � எளி்தா்க எடுத்து செல்வ்தா்க இருத்்தல் 

வவண்டும்

 � மி்தமான வவ்கத்தில் எரி்தல் இருத்்தல் 
வவண்டும்

 � அதி்களவு சவப்பாறறபல வழஙகுவ்தா்க 
இருத்்தல் வவண்டும்

 � விரும்பத்்த்கா்த எந்்தசவாரு சபாருபளயும் 
சவளியிடுவ்தா்க இருத்்தல் கூடாது.

 � சுறறுசூழபல மாசுபடுத்்தா்தா்க இருத்்தல் 
வவண்டும்

சநருபறப கட்டுபபடுத்துதல்:

எரிசபாருள்

ஆ
க்ஸி

ஜன் ச்வபபம்

சநருப்பப உறபத்தி செயவ்தறகு கீவழ 
வ்தபவயான வவதிப் சபாருள்கள 
ச்காடுக்கப்பட்டுளளது. இவறறுள ஏவ்தனும் 
ஒனறு அல்லது அ்தறகு வமறபட்டவறபற 
அ்கறறுவ்தன மூலம் சநருப்பபக 
்கட்டுப்படுத்்தலாம்.

I. எரிசபாருள
II. ்காறறு (ஆகஸிஜபன வழங்க)
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தீயனைப்பான் ஐந்து வகையாக வகைப்படுத்தப்டுகிறது அவை
1. நீர்	 2. நுரை	 3. உலர்ந்த வேதித்துகள்கள் 	   4. CO2	 5. நீர்ம இரசாயனங்கள்

நெருப்பின் வகுப்புகள்
ஐந்து வகையான நெருப்பு வகுப்புகள் : வகுப்பு A, வகுப்பு B, வகுப்பு C, வகுப்பு D, மற்றும்  வகுப்பு E.

வகுப்பு A – மரம், காகிதம் மற்றும் துணி ப�ோன்ற எரியக்கூடிய திடப்பொருட்களால் 
ஏற்படுகிறது

வகுப்பு B  – பெட்ரோல், டர்பெண்டைன் அல்லது பெயிண்ட் ப�ோன்ற எரியக்கூடிய 
திரவப்பொருட்களால் ஏற்படுகிறது

வகுப்பு C  – ஹைட்ரஜன், பியூட்டேன் அல்லது மீத்தேன் ப�ோன்ற எரியக்கூடிய 
வாயுப்பொருட்களால் ஏற்படுகிறது

வகுப்பு D  – எண்ணெய்யால் ஏற்படும் தீ.

வகுப்பு E  – மின்சார தீ விபத்துகள்- மின்சார உபகரணங்களால் ஏற்படும் தீ

மின்சார நெருப்பு  – மின் உபகரணங்கள்: மின் ப�ொருள் அகற்றப்பட்டதும், நெருப்பு வகுப்பை 
மாற்றுகிறது

III. வெப்பம் (வெப்பநிலையை உயர்த்த)
IV. எரிதல் வெப்பநிலை

தீ அணைப்பான்:

ஒரு தீயணைப்பு கருவியானது காற்று 
அல்லது எரிப�ொருளின் வெப்பநிலையைக் 
குறைப்பத�ோடு மட்டுமல்லாமல்  அவற்றின்  
விநிய�ோகத்தையும் துண்டித்துவிடுகிறது.

தீயை அணைக்கும் கருவிகள் எவ்வாறு 
செயல்படுகின்றன?

தீயை அணைக்கும் கருவிகள், எரியும் 
எரிப�ொருளை குளிர்விக்கின்றது, ஆக்ஸிஜனை 
வினைபுரியாமல் தடுத்தல் அல்லது அகற்றுதல் 
மற்றும் வேதிவினை நிகழாமல் தடுத்தல் 
ப�ோன்ற விளைவுகளைச் செய்கிறது. அதனால், 
த�ொடர்ந்து எரிய முடியாமல் தீ தடுக்கப்படுகிறது. 
தீ அணைப்பானின் கைப்பிடியை 
அழுத்தப்படும்போது, அது திறந்து, உயர் அழுத்த 
வாயுக்கள் உள்ளறையில் (canister) பிரதான 
சிலிண்டரிலிருந்து  ஒரு சிப்பான் ( siphon) குழாய் 
வழியாக வெளியேறி  தீயை கட்டுப்படுத்துகிறது. 
ஒரு தீ அணைப்பான் மருந்து, தெளிப்பான் 
கருவிப�ோல செயல்படுகிறது.
தீயணைப்பானின் வகைகள்:

வெவ்வேறு வகையான அணைப்பான்கள் 
பல்வேறு வகையான தீயைச் 
கட்டுப்படுத்துகின்றன.  அவற்றில் தீயை 
அணைக்கும் ப�ொருள்களின் ப�ொதுவான 
வகைகள் கீழே க�ொடுக்கப்பட்டுள்ளன.

I.  காற்று அழுத்த நீர் அணைப்பான்கள்,
II. கார்பன்-டை-ஆக்சைடு அணைப்பான்.
III. உலர் ரசாயன தூள் அணைப்பான்கள்
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நினைவில் க�ொள்க: 
�� வாய்வழி நீரேற்றுக் கரைசல் (ORS) என்பது 

உப்பு, சர்க்கரை மற்றும் நீர் ஆகியவற்றின் 
கலவையாகும். இது உடலில் அதிக 
வியர்வை, வாந்தி அல்லது வயிற்றுப்போக்கு 
மூலம் ஏற்பட்ட நீர் பற்றாக்குறையை நீர் 
மற்றும் எலக்ட்ரோலைட்டுகள் மூலம் 
மீட்டெடுத்து நீர்ச் சமநிலையை 
பராமரிக்கின்றது.

�� வயிற்றுப்போக்கு ந�ோயால் பாதிக்கப்பட்ட 
90 - 95% ந�ோயாளிகளுக்கு ORS ஒரு 
சிறந்த சிகிச்சையாகும்.

�� நமது வயிற்றில் அமிலத்தை 
நடுநிலையாக்குவது  ஆன்டாசிட் மருந்து 
ஆகும்.

�� மருந்துகள், ந�ோய்களுக்குச் 
சிகிச்சையளிக்கவும் குணப்படுத்தவும், 
சுகாதாரத்தைப் மேம்படுத்தவும் பயன்படும் 
ப�ொருள்கள் ஆகும்.

�� சில நுண்ணிய உயிரினங்களும் 
தாவரங்களும் அவற்றின் நச்சுப் 
ப�ொருள்களை உருவாக்குகின்றன. இவை 

பிற உயிரினங்களை அவற்றின் 
நச்சுக்களால் அழிப்பதால் அவற்றை 
நுண்ணுயிர் எதிர்ப்பிகள் என்று 
அழைக்கிறார்கள்.

�� ப�ொருள்கள் ஆக்ஸிஜனுடன் வினைபுரிந்து 
வெப்பத்தையும் ஒளியையும் தரும் 
வேதியியல் செயல்முறை எரிதல் என்று 
அழைக்கப்படுகிறது.

�� சுடர் என்பது, ஒரு எரிப�ொருள் எரியக்கூடிய 
பகுதியாகும். மெழுகு, மண்ணெண்ணெய் 
ஆகியன எரிந்து சுடரைத் தருகின்றன.

�� ஒரு ப�ொருள் எரிய தேவைப்படும் 
குறைந்தபட்ச வெப்பநிலை அதன் எரிதல் 
வெப்பநிலை எனப்படும்.

�� 1 கில�ோ எரிப�ொருள் முழுமையாக எரிந்து 
வெளியிடப்படும் வெப்பத்தின் அளவு அதன் 
கல�ோரிஃபிக் மதிப்பு என்று 
அழைக்கப்படுகிறது.

�� ஒரு தீயணைப்பு கருவியானது காற்றின் 
விநிய�ோகத்தை துண்டிக்கிறது, 
எரிப�ொருளின் வெப்பநிலையைக் 
குறைக்கிறது அல்லது இரண்டையும் 
கட்டுப்படுத்துகின்றது.

வ��� A

வைகக�

�ைர

��

எ���
ெபா��க�

(எ.கா. கா�த

& மர
)

எ��� ��ப��

�ரவ�க�

(எ.கா. ெப���
& ெப�ேரா�)

எ��� ��ப��

வா��க�

(எ.கா. ���ேட­
& ��ேத­)

எ��� ��ப��

உேலாக�க�

(எ.கா. ���ய

& ெபா�டா�ய
)

�­
உபகரண�க�
(எ.கா. க��

& ெஜனேர�ட�க�)

 ெகா��� 
ெபா��கைள 

வ��த� 
(எ.கா. தவா )

க����க�

�க�
 அ�க ெவ�ப�ைல
பய­ப��த�ப��ற� 

இர���
 பா�கா�பான�
ம��
 �ைற�த �­ன��த


உல� ��

ஈரமான ரசாயன


CO2

வ��� B வ��� C �­�ய� D �­�ய� வ��� F

�ரவ அ�ல� �­சார 
ப�¢ய �ைய அைண�க 
பய­ப��த ேவ�டா


உ�நா�� 
பய­பா���� 

ெபா��தா�

1000 ேவா�� வைர 
பா�கா�பாக 

பய­ப��தலா


XX X X X
X X X X

X
X

X
X X X
X X X

பல்வேறு  வகையான அணைப்பான்கள் பல்வேறு வகையான தீயை அணைக்கின்றன
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.

மதிப்பீடு

I. சரியான விடையைத் தேர்ந்தெடுக்கவும் 
1. �நிம�ோனியா, மற்றும் மூச்சுக்குழாய் அழற்சி 

சிகிச்சையில் பயனுள்ள ஒரு மருந்து 
_________

அ. ஸ்ட்ரெப்டோமைசின் 

ஆ. குளோரோம்பெனிகால்

இ. பென்சிலின் 		  ஈ. சல்பாகுனிடின்

2. �ஆஸ்பிரின் ஒரு _________

அ. ஆண்டிபயாடிக் 	
ஆ.ஆண்டிபைரடிக்

இ. மயக்க மருந்து  	 ஈ. சைக்கீடெலிக்

3. �_________ என்பது வயிற்று அமிலத்தை 
நடுநிலையாக்குகிறது.

அ. அமிலநீக்கி       	   ஆ. ஆண்டிபைரடிக்

இ. வலிநிவாரணி	   ஈ. ஆண்டிஹிஸ்டமின்

4. �ஒரு ப�ொருள் தீப்பிடிக்க தேவையான மிகக் 
குறைந்த வெப்பநிலை அதன் _________ 
என அழைக்கப்படுகிறது

அ. க�ொதிநிலை	    ஆ. உருகுநிலை

இ. சிக்கலானவெப்பநிலை

ஈ. எரிவெப்பநிலை.

5. �மெழுகுவத்தியின் சுடரில் வெப்பமான பகுதி 
எது _________

அ.நீலம்		  ஆ. மஞ்சள்

இ. கருப்பு 		  ஈ. உள் பகுதி

II. வெற்றிடங்களை நிரப்பவும்
1. �பென்சிலின் முதன்முதலில் கண்டுபிடித்தவா் 

_________

2. �உலக ORS தினம் _________

3. �எரிதல் என்பது ஒருவேதிவினை, 
இதில்பொருள் _________ உடன் 
வினைபுரிகிறது

4. �நீரில் நனைந்த காகிதத்தின் எரிவெப்பநிலை 
_________

5. �எண்ணெய்யால் உற்பத்தி செய்யப்படும் 
நெருப்பை _________ ஆல்கட்டுப்படுத்த  
முடியாது

III. �சரியா அல்லது தவறா? தவறு என்றால் 
சரியான பதிலைக் க�ொடுக்கவும்.

1. �சளி மற்றும் புளூ ப�ோன்ற ந�ோய்களை 
ஏற்படுதும் வைரஸ்களுக்கு 
ஆண்டிபயாடிக்குகள் மருந்துகள் வேலை 
செய்யும்.

2. �வலி நிவாரணி என்பது காய்ச்சலின் ப�ோது 
வெப்பநிலையைக் குறைக்கும் ப�ொருட்கள்.

3. �அனைத்து எரிப�ொருள்களும் சுடரை 
உருவாக்குகின்றன.

4. �எரிதலுக்கு ஆக்ஸிஜன் அவசியம்
5. �மரம் மற்றும் நிலக்கரியை எரிப்பதால் 

காற்றுமாசுபடுகிறது

IV. �பின்வருவனவற்றை ப�ொருத்துங்கள்
ஆண்டிபைரடிக் வலியைக் குறைக்கும்
வலி நிவாரணி உடல்வெப்பநிலையைக் 

குறைக்கும்
ஆன்டாசிட் தன்னிச்சையானஎரிப்பு
பாஸ்பரஸ் ORS தீர்வு
கார்பன் டைஆக்சைடு சுவாச பிரச்சனைக்கு 

வழி வகுக்கிறது.
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V. ஒப்புமை
1. சுடரின் உள்மண்டலம்: _________, சுடரின் 

வெளிமண்டலம்: _________

2.  டிஞ்சர் : _________.

     ஹிஸ்டமைன் : _________.

VI. ஓரிரு ச�ொற்களில் விடையளி.
1. �மனிதனில் கண்டறியப்பட்ட முதல் 

வைரஸ்நோய் _________ (மஞ்சள்காய்ச்சல் 
/ டெங்குகாய்ச்சல்)

2. �ORS – ன் விரிவாக்கம் _________________.

3. �கிருமி நாசினியாகவும் ஆண்டிசெப்டிக் 
ஆகவும் பயன்படக்கூடிய ஒரு மருந்தின் 
பெயரைக் குறிப்பிடுக?

4. �டெட்டாலின் முக்கிய கூறுகள் யாவை?

5. �எரிப�ொருளின் கல�ோரிஃபிக் மதிப்பின் அலகு 
என்ன?

6. �எத்தனை வகையான எரிதல் உள்ளது?

7. �நெருப்பை உற்பத்தி செய்வதற்கான 
அத்தியாவசிய தேவைகள்யாவை?

VII. குறுகிய விடையளி?
1. �மருத்துவர்களைக் கலந்தால�ோசிக்காமல் ஏன் 

மருந்துகள் எடுக்கக்கூடாது?

2. �கிருமிநாசினிகள் ஆண்டிசெப்டிக்லிருந்து 
எவ்வாறு வேறுபடுகின்றன? 
எடுத்துக்காட்டுடன்  விளக்கவும்.

3. �எரிதல் வெப்பநிலை என்றால் என்ன?

4. �4.5 கில�ோ எரிப�ொருள் முழுவதுமாக எரிந்து, 
உற்பத்தி செய்யப்படும் வெப்பத்தின் அளவு 
1,80,000 kg என அளவிடப்படுகிறது என்றால், 
கல�ோரிஃபிக் மதிப்பு என்ன?

VIII. விரிவாக விடையளி.
1. �ஆண்டிபயாடிக் மற்றும் வலிநிவாரணி பற்றிச் 

சுருக்கமாக விளக்குங்கள்?

2. �மெழுகுவத்தி சுடரின் படம் வரைந்து 
பாகங்களைக் குறிக்க.

IX. படம் சார்ந்த கேள்வி.

அருளும், ஆகாஷும் ஒரு 
பரிச�ோதனையைச் செய்து க�ொண்டிருந்தனர், 
அதில் ஒரு பீக்கரில் தண்ணீரை சூடாக்க 
வேண்டும். அருள் பீக்கரை மெழுகுவத்திச் 
சுடரின் மஞ்சள் பகுதியில் திரியின் அருகே 
வைத்திருந்தார். ஆகாஷ் பீக்கரை 
வெளிப்புறத்தில் உள்ள சுடரில் வைத்திருந்தார்.
குறுகிய நேரத்தில் யாருடைய நீர் சூடாகும்?

Websites:

1. �http://memorize.com/medical-terminology 
prefixes

2. sciencedirect.com
3. https://www.scietificamerican.com

VII STD Science Term-3 TM  unit 4.indd   99 22-11-2019   12:25:00



100

சுடர் வொ்தபனபய ச்தரிந்துக 
ச்காளளு்தல்

அனறாட வாழ்வில் வவதியியல்

அன்ைாட ்வாழ்வில் வ்வதியியல் URL:
https://scratch.mit.edu/projects/138778000/

இபணயச் செயல்பாடு

படிநிபல்கள
படி 1 :   URL அல்லது Q.R.Code ஐ பயனபடுத்தி செயல்பாடு பக்கத்ப்த திறக்கவும்.
படி 2 :  பிளாட்டினம் wire ஐ பயனபடுத்தி ஒவவவாரு வவதிப்சபாருபளயும் எடுத்து சுடரில் வபாடவும். 

இப்வபாது ஒவவவாரு வவதிப்சபாருளும் எவவாறு சுடரின நிறத்ப்த மாறறுகிறது 
எனபப்தக ்காணலாம்.

படி 3:  புதிய வவதிப்சபாருபள வ்தர்ந்வ்தடுக்க space bar ஐ அழுத்்தவும்்க.

** படங்கள அபடயாளத்திறகு மட்டுவம.
* வ்தபவசயனில் ‘Adobe Flash’ ஐ அனுமதிக்கவும்.

படி 1 படி 2

படி 4

படி 3
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�� உணவு மற்றும் உடை தயாரிக்க நமக்கு விலங்குகள் எவ்வாறு 
உதவுகின்றன என்பதைத் தெரிந்து க�ொள்ளுதல் 

�� கம்பளி மற்றும் பட்டு எவ்வாறு உருவாகிறது என்பதையும் அறிந்து 
க�ொள்ளுதல்

�� கம்பளி மற்றும் பட்டாலைகளில் ஏற்படும் அபாயங்கள் குறித்தும், அவற்றை 
எவ்வாறு தவிர்ப்பது என்பதையும் புரிந்து க�ொள்ளுதல்

�� அஹிம்சைபட்டு அல்லது அமைதிபட்டு பற்றிய அறிவினைப் பெறுதல்
�� விலங்குகளைப் பாதுகாத்தல் மற்றும் பராமரிப்பின் முக்கியத்துவத்தைப் புரிந்து க�ொள்ளுதல்

கற்றல் ந�ோக்கங்கள்

அன்றாட வாழ்வில் 
விலங்குகள்

5
அலகு
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அறிமுகம் 
முந்தைய வகுப்பில் அன்றாட வாழ்வில் 

தாவரங்கள் எவ்வாறு உதவுகின்றன 
என்பதைப் பற்றிப் படித்தோம். இப்பொழுது 
அன்றாட வாழ்வில் விலங்குகள் நமக்கு எவ்வாறு 
உதவுகின்றன என்பதைப் படிக்கலாமா?.

இயற்கையின் மிகப் பெரிய க�ொடைகளுள் 
ஒன்று விலங்குகளாகும். அவை அன்றாட 
வாழ்வில் மனிதர�ோடு மிகவும் நெருக்கமாக 
இணைந்துள்ளன. நம் நாட்டின் ப�ொருளாதார 
வளர்ச்சிக்கும், வணிக மேம்பாட்டிற்கும் 
விலங்குகள் உதவுகின்றன. நமக்கு உணவு, 

செயல்பாடு : 1

க�ொடுக்கப்பட்டுள்ள சில வகை உணவுப் ப�ொருள்களில், அவற்றின் மூலப்பொருள்கள் மற்றும் 
ஆதாரத்தினை எழுதுக.

வரிசை  
எண் உணவு வகை மூலப்பொருள்கள் ஆதாரம்

1

க�ோழிக்கறி விலங்குகள் 

நறுமணப் ப�ொருள்கள்
எண்ணெய் / நெய் தாவரம்/ விலங்குகள்
கறிவேப்பிலை
க�ொத்துமல்லி இலை தாவரம்

2

மீன்
நறுமணப் ப�ொருள்கள்
எண்ணெய் / நெய் 
எலுமிச்சை

3

பால்
தேநீர் இலை / காஃபி 
க�ொட்டை
நீர்
சர்க்கரை

4

எண்ணெய் / நெய்
சர்க்கரை
பால்
க�ொட்டைகள் 
சுவையூட்டி 

தேன்

5

அரிசி
முட்டை
நறுமணப் ப�ொருள்கள்
எண்ணெய்
க�ொத்துமல்லி இலை
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உடை மற்றும் ப�ோக்குவரத்து ஆகியவற்றிற்கு 
விலங்குகள் பயன்படுகின்றன. விலங்குகளின் 
ப�ொருளாதார முக்கியத்துவம் மற்றும் அவற்றின் 
பாதுகாப்பு, பராமரிப்பு பற்றியும் நாம் இப்பாடத்தில் 
அறிந்து க�ொள்வோம்.

5.1 �விலங்குகளிலிருந்து பெறப்படும் 
உணவுப்பொருள்கள்

பால்
பால் என்பது, வெண்மையான ஒரு 

திரவம். இது விலங்குகளில் பாலூட்டிகளின் 
பால் சுரப்பியிலிருந்து உற்பத்தியாகிறது. பிறந்த 
குட்டி அல்லது குழந்தைகளின் முக்கியமான 
ஆதார ஊட்டச்சத்து மிக்க உணவாகப் பால் 
கருதப்படுகிறது. இதனைத்தான் நாம் அன்றாட 
வாழ்வில் பயன்படுத்துகிற�ோம்.

�� நாம் பயன்படுத்தப்படும் பாலானது பசு, 
எருமை மாடுகள் மற்றும் ஆடுகளிலிருந்து 
கிடைக்கும் முக்கியமான ப�ொருளாகும்.

�� நம் அன்றாட உணவில் பாலானது தேநீர், 
காஃபி, ஐஸ்கிரீம், சாக்லேட், இனிப்பு 
மற்றும் இவை ப�ோன்ற பால் சம்பந்தமான 
ப�ொருள்களைத் தயாரிக்க உதவுகிறது.

�� புரதம் மற்றும் கால்சியம் மிக்க 
ஊட்டச்சத்து உணவாக இருப்பதால் 
பன்னீர், பாலாடைக்கட்டி, பாலேடு 
(க்ரீம்), வெண்ணெய், நெய் மற்றும் 
தயிர் ப�ோன்றவற்றைத் தயாரிக்க பால் 
உதவுகிறது.

தயிர் நெய்

முட்டை
பல்வேறு வகையான பெண் பறவைகள் 

அதாவது க�ோழி, வாத்து, வான்கோழி 
மற்றும் நெருப்புக்கோழிகள் ப�ோன்றவை 
அவற்றின் இளம் உயிரிகள் உருவாவதற்கு 
முட்டையிடுகின்றன. இதனைத்தான் நாம் 
அன்றாட வாழ்வில் பயன்படுத்துகிற�ோம் அவை 
பின்வருமாறு

��முட்டை நம் உடலுக்குச் சக்தியையும், 
நல்ல ஆர�ோக்கியத்தையும் தருகின்றது. 

��இது புரதம் நிறைந்த ஊட்டச்சத்து 
உடையதாகும்.

��ஆறு கிராம் எடையுள்ள முட்டை (Egg) 
உயர்ந்தரகப் புரதத்தைக் க�ொண்டுள்ளது. 
காலையில் புரதம் மிக்க உணவு, அன்றைய 
தினம் முழுவதும் உடல் மற்றும் மூளை 
வளர்ச்சிக்கு உதவுகிறது. எந்த வயதினரும், 
தினமும் முட்டையை உண்பது நல்லது.

வேகவைத்த முட்டை முட்டை ஆம்லெட்

செயல்பாடு : 2

நல்ல முட்டை எது அழுகிய முட்டை எது 
என்பதை உங்களால் பிரித்தறிய முடியுமா?

1.	 ஒரு பாத்திரத்தில் நிறைய நீரை 
எடுத்துக்கொள்ள வேண்டும்

2.	 அதில் முட்டையை வைக்க வேண்டும்

3.	 முட்டை, நீரில் மூழ்கினால் அது நல்ல 
முட்டை, முட்டை நீரில் மிதந்தால் அது 
அழுகிய முட்டையாகும்.
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தேன்
தேன் எங்கிருந்து 

நமக்குக் கிடைக்கிறது? அது 
எவ்வாறு உருவாகிறது? என்பது தெரியுமா? 
நீங்கள் தேன் கூட்டில் பல தேனீக்கள் 
இருப்பதைப் பார்த்திருப்பீர்கள். தேனீக்கள் 
மலர்களிலிருந்து, நெக்டார் என்ற இனிப்புச் 
சாற்றைச் சேகரித்து, அதைத் தேனாக 
மாற்றி, அதைத் தேன் கூட்டில் உள்ள தேன் 
அறைகளில் சேமிக்கின்றன

��  தேன் என்பது தேன் கூட்டிலிருந்து 
நம்மால் பிரித்தெடுக்கப்படும் இனிப்பான 
சாறாகும். 

�� மலைப்பகுதியில் வசிக்கும் 
மக்களால், அடர்ந்த காடுகளில் உள்ள தேன் 
கூடுகளிலிருந்து இயற்கையான மலைத் 
தேன் எடுக்கப்படுகின்றது. 

�� தேன் சிறந்த மருத்துவ குணம் 
மிக்கது, அதிக ஊட்டச்சத்து நிறைந்த 
உணவாகும்

தேன் கூடு

தேன் கூட்டிலிருந்து தேன் வழிகிறது.

செயல்பாடு : 3

ந�ோக்கம் :  தேன் சுத்தமானதா? இல்லையா? 
என்பதைக் கண்டுபிடித்தல். 

தேவையான ப�ொருள்கள் : நீர் மற்றும் 
தேன் 

செய்முறை : ஒரு குவளையில் நீரை 
எடுத்துக் க�ொண்டு அதில் ஒரு துளி 
தேனை ஊற்றவும். பின் அதைக் 
கவனித்துப் பாருங்கள். 

அறிவன : நீரில் இடப்பட்ட ஒரு துளித் தேன் 
கரையாமல் பாத்திரத்தின் அடிப்பகுதி 
வரை சென்றால் அது சுத்தமான தேன். 
பாத்திரத்தின் அடிப்பகுதியை அடையும் 
முன்னரே அது கரைந்தால் அது 
சுத்தமான தேன் இல்லை.

வேலை    க ்கா  ர த் 
தேனீக்களின் வேலை 
எ ன்னவென்றா       ல் 
மலர்களில் உள்ள 

தேனைச் சேகரிக்கும், மேலும் அவை 
இளந்தேனீக்களை வளர்க்கும், தேன் 
கூடு சேதம் அடைந்தால் அதைச் சரி 
செய்யும், தேன் கூட்டைப் பாதுகாக்கும்.

இறைச்சி
விலங்குகளின் உடலின் தசைப்பகுதி 

இறைச்சி எனப்படும். இதனைத் தான் நாம் 
இறைச்சியாக உண்கிற�ோம். பெரும்பாலும் 
இறைச்சி என்பது எலும்புத் தசையையும், 
அதில் உள்ள க�ொழுப்பையும் குறிக்கும். 
மனிதர்களில் சிலர், க�ோழி, ஆடு, முயல், 
பன்றி, வெள்ளாடு, ஒட்டகம், எருமை, மீன், 
நண்டு, இறால் ப�ோன்றவற்றை உணவாக 
உட்கொள்கின்றனர்.

VII STD Science Term-3 TM  unit 5.indd   104 22-11-2019   12:37:04



105

�� விலங்குகளின் இறைச்சி சிலருக்கு 
உணவாகப் பயன்படுகிறது.

�� இறைச்சியில் ஊட்டச்சத்து அதிகம் 
இருப்பதால் அது முக்கிய உணவாகப் 
பயன்படுகிறது. மேலும், க�ோழி 
இறைச்சி பெருமளவில் மனிதர்கள் பலர் 
பயன்படுத்துவதால், அவை வணிக ரீதியாக 
க�ோழிப்பண்ணை அமைத்து க�ோழிகள் 
வளர்க்க உதவுகிறது.

  

	 ஆட்டு இறைச்சி	 க�ோழி இறைச்சி

க�ோழிப் பண்ணை அமைத்தல்
வீட்டில் வளர்க்கப்படும் பறவைகளான 

க�ோழி, வாத்து, வான்கோழி ப�ோன்றவற்றை 
அவற்றின் இறைச்சிக்காகவும், முட்டைக்காகவும் 
வளர்ப்பது பண்ணை அமைத்தல் எனப்படும். 
க�ோழிப் பண்ணை அமைத்தல் என்பது, 
க�ோழிகளின் எண்ணிக்கையை அதிக 
அளவில் பெருக்குவது ஆகும். இவற்றை நாம் 
இரு வகைகளாகப் பிரிக்கலாம்.

i. முட்டையிடுபவை
ii. �பிராய்லர் �(இறைச்சிக்காக 

வளர்க்கப்படுபவை).
க�ோழிப்பண்ணைகள் அமைக்கப் 

ப�ோதுமான, பாதுகாப்பான இடம் 
தேவைப்படுகின்றது. க�ோழிகளை அடைக்கக் 
கூடுகள், தேவையான நீர், காற்றோட்டம், 
புரதம், க�ொழுப்பு, வைட்டமின்கள் நிறைந்த 
உணவுப்பொருள்கள் ப�ோன்றவை 
தேவைப்படுகின்றன. க�ோழித் தீவனம் என்பது 
மக்காச்சோளம், க�ோதுமை, கம்பு மற்றும் அரிசித் 
தவிடு இவற்றை நன்கு மசித்துத் தரவேண்டும். 
இத�ோடு, நிலக்கடலை, க�ொண்டைக்கடலை 
ப�ோன்றவற்றையும் உடைத்துத் தரலாம்.

ந�ோய்கள்
சில ந�ோய்க்கிருமிகள் க�ோழிப் 

பண்ணையில் உள்ள க�ோழிகளைத் தாக்கி 
ந�ோய்களை உண்டாக்குகின்றன. இதைத் 
தவிர்க்க, க�ோழிகள் வாழும் இடத்தைச் 
சுத்தமாக வைத்துக்கொள்ள வேண்டும். 
க�ோழிகளுக்குத் தடுப்பூசி ப�ோட வேண்டும். 
க�ோழிப் பண்ணையில் உள்ள க�ோழிகளுக்குப் 
ப�ொதுவாக உண்டாகும் ந�ோய்கள் பின் 
வருமாறு.

சால்மோனெல் -
ல�ோசிஸ் 
(வயிற்றுப்போக்கு)

-
இந்நோயைப் 
பாக்டீரியா 
உருவாக்கும் 

ரானிக் கெட் ந�ோய் 
(அம்மை ந�ோய்) - இந்நோயை வைரஸ் 

உருவாக்கும் 

ஆஸ்பர்ஜில்லஸ் 
ந�ோய் (பலவீனம், 
நலிந்துப�ோதல்)

-
இந்நோயைப் 
பூஞ்சை 
உருவாக்கும் 

க�ோழிப்பண்ணை

5.2 �உடையாகப் பயன்படும் விலங்கினப் 
ப�ொருள்
விலங்குகளின் உர�ோமங்களுக்கு 

மிகப் பெரிய தேவை உள்ளது. ஆடுகளின் 
உர�ோமத்தைக் க�ொண்டு 
கம்பளி ஆடைகள், 
சால்வைகள், ப�ோர்வைகள், 
தலை முக்காடு மற்றும் 
காலுறைகளைத் தயாரிக்க 
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உதவும் இ்த ்்பால் குதிடரயின் உ்ராமம், 
ஓவியம் தீட்டும் தூரிட்கடய உரு்ாக்க்ப 
்பயன்்படுகிறது. விலங்கின் உ்ராமத்்தாடு, 
அதன் ்தாலும், த்துத்து்ப்பான மற்றும் 
நவீன ஆடை்களும் தயாரிக்க உதவுகிறது.
விலங்கு இ்ழகள்

்பஞசு, சைணல், ்கம்்பளி, ்பட்டு ்்பான்ற 
நார்கள் இயற்ட்க இடழ்கைாகும். ்பஞசு மற்றும் 
சைணல் ்்பான்றட் தா்ர இடழ்களுககு 
எடுத்துக்காட்டு்கைாகும். ்கம்்பளி மற்றும் 
்பட்டு இடழ்கள், விலங்கு இடழ்களுககு 
எடுத்துக்காட்டு்கைாகும். இட் துணி்கள் 
தநய்யவும் உதவுகின்றன. ்கம்்பளி என்்பது, 
ஆடு தமன் உ்ராமக ்கற்டறயிலிருந்து 
எடுக்க்ப்படும் இடழயாகும். இடதத் தவிர, 
முயல், யாக, அல்்பா்கா (உ்ராம ஆடு) 
மற்றும் ஒட்ை்கத்திலிருந்து ்கம்்பளி இடழ்கள் 
எடுக்க்ப்படுகின்றன. ்பட்டு்பபுழுவின் 
கூட்டிலிருந்து எடுக்க்ப்படும் இடழ்ய ்பட்டு 
இடழயாகும்.

கம்ெளி
உடற்பனி மிகுந்த இைங்்களில் ்ாழ்்்ார 

எந்த ் ட்க உடை்கடை அணி்ார்கள் என்்பது 
உங்்களுககுத் ததரியுமா?

ஏன் அ்ர்கள் அவ்ட்க உடை்கடை 
விரும்பி அணிகிறார்கள்?

்கம்்பளி என்ற இடழ, ்்க்பரி்ன என்ற 
குடும்்பத்டதச் சைாரந்த விலங்கு்களின் 
தமன்முடிக ்கற்டறயிலிருந்து த்பற்ப்படுகிறது. 
்கம்்பளி, ஆட்டின் புறத்்தால் ்பகுதியிலிருககும் 

உ்ராமத்டதக ்கத்தரித்தல்ஆடு
்கழுவுதல்

தரம் பிரித்தல் நூற்றல்
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உர�ோமம் ஆகும். இது பெரும்பாலும் ஆடு, 
செம்மறிஆடு, முயல், காட்டெருமையிலிருந்து 
பெறப்படுகிறது. இந்தக் கம்பளியை உருவாக்க 
ஐந்து படிகள் உள்ளன. அவை பின்வருமாறு.

i.	கத்த ரித்தல் (Shearing) 
ii.	 தரம் பிரித்தல் (Grading or sorting)
iii.	க ழுவுதல் (Washing or Scouting)
iv.	சிக்கெடுத்தல் (Carding) 
v.	 நூற்றல் (Spinning)

�� கத்தரித்தல்: ஆடுகளின் உடலிலிருந்து 
உர�ோமங்கள் கத்தரிக்கப்படுகின்றன. 
உடலின் சதைப் பகுதிகளிலிருந்து பிரித்து 
எடுக்கப்படுகின்றன. இது கத்தரித்தல் 
எனப்படும். 

�� தரம் பிரித்தல்: ஒரே ஆட்டின் வெவ்வேறு 
பாகங்களிலிருந்தும் எடுக்கப்படும் 
உர�ோமங்கள் வெவ்வேறானவை. 
இவை பின்னர் தனித்தனியாகப் 
பிரித்தெடுக்கப்படும். இது தரம் பிரித்தல் 
எனப்படும். 

தரம் பிரித்தல், கழுவுதல், சிக்கெடுத்தல், நூற்றல்
�� கழுவுதல் : த�ோலில் இருந்து கத்தரித்த 

த�ோலின் உர�ோமங்கள் உள்ள தூசி, அழுக்கு 
மற்றும் எண்ணெய் பிசின் ப�ோன்றவற்றை 
நீக்க, அதைச் சலவைத்தூள் க�ொண்டு 
நன்கு கழுவ வேண்டும். 

�� சிக்கெடுத்தல் : காய வைத்த கம்பளி 
இழைகளைக் கவனத்துடன் பிரிக்க 
வேண்டும். இதை, ஆலைகளில் உள்ள 
உருளைகளில் செலுத்தி, பின்னர் மெல்லிய 
கம்பி ப�ோன்ற இழையாக மாற்ற வேண்டும். 
இப்படிக் கம்பளியைத் தட்டையான தாளாக 
மாற்றுவது வலை எனப்படும். 

�� நூற்றல் : இந்த வலையைக் குறுகிய 
தனித்த இழையாக மாற்ற, அவற்றை நூற்பு 
இயந்திரங்களில் அனுப்ப வேண்டும். இந்த 
நூல், பின் பந்துப�ோல் உருண்டையாக 
மாறும். இந்த நூல் பந்து, பின் பின்னல்களாக 
மாற்றப்பட்டு, ஆடைகள் நெய்ய உதவும்.

கம்பளியின் சிறப்பம்சங்கள்
�� வெப்பம் மற்றும் தண்ணீருக்கு எதிர்ப்புத் 

தன்மை உடையது மற்றும் இவை 
கிழிவதில்லை.

�� ஈரப்பதத்தை உறிஞ்சிக் க�ொள்ளும் 
தன்மையுடையது.

�� கம்பளி, குளிருக்கு எதிராகச் 
செயல்படுகின்றது. எனவே, கம்பளி சிறந்த 
வெப்பக் கடத்தியாகக் கருதப்படுகிறது.

�� இது எளிதில் சுருங்காது.
கம்பளியின் பயன்கள்

கம்பளி என்பது, பல்வேறு வகையான 
ப�ொருள்கள் செய்ய உதவும் இழையாகும். 
இந்த இழைகளின் விட்டம் ஆடைகள், 
வீட்டிற்குத் தேவையான துணிகள் மற்றும் 
த�ொழிற்சாலைக்குத் தேவையான ப�ொருள்கள் 
செய்ய உதவுகின்றன. மூன்றில் இரண்டு 
பங்கு கம்பளி இழைகள், ஸ்வெட்டர், ஆடைகள், 
க�ோட் மற்றும் விளையாட்டு வீரர்கள் அணியும் 
ஆடைகள் தயாரிக்க உதவுகின்றன. கம்பளி 
இழை மற்றும் இயற்கை அல்லது செயற்கை 
இழைகள�ோடு சேரும்போது அவை மடிப்புக்கு 
எதிர்ப்புத் தன்மை உடைய ப�ோர்வைகள் 
மற்றும் இரைச்சலை உறிஞ்சும் விரிப்புகள் 
தயாரிக்க உதவுகின்றன.

பட்டு
நீங்கள் எப்போதாவது திருமண 

விழாவிற்குச் சென்றிருக்கிறீர்களா? அதில் 
மணமகனும், மணமகளும் எந்த ஆடையை 
உடுத்துவார்கள்? அந்த உடைகள் எவற்றால் 
ஆனவை?
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பட்டு என்பது, பட்டுப் பூச்சியின் கூடுகளில் 
சுரக்கும் இழையாகும். மல்பெரி இலைகளை 
உணவாக உண்ணும் பட்டுப்புழுக்களிலிருந்து 
பட்டு இழைகள் பெறப்படுகின்றன. 
பட்டுப்புழுக்கள் குறுகிய காலமே வாழும்.
அதாவது, இரண்டு மாதங்கள் மட்டுமே வாழும். 
இந்த காலத்தில் அவை வாழ்க்கையில் நான்கு 
வளர்ச்சி நிலைகளைக் கடக்க வேண்டும். 
அவை முட்டை, லார்வா நிலை (கம்பளிப்பூச்சி), 
கூட்டுப்புழு (குக்கூன்) மற்றும் பட்டுப் பூச்சியாகும். 
இந்த வாழ்க்கை நிலைகள் பட்டுப்பூச்சியின் 
வாழ்க்கை சுழற்சியாகும். 

பட்டுப் பூச்சியின் வாழ்க்கை சுழற்சி
ப ட் டு ப் பூ ச் சி கள  ை 

வளர்த்து, அதிலிருந்து பட்டு 
தயாரிக்கப்படுவது,  பட்டுப்பூச்சி 
வளர்ப்பு அல்லது செரிகல்சர் 
எனப்படும். ஒரு முதிர்ந்த 
பெண் பட்டுப் பூச்சி சுமார் 
500 முட்டைகளை இடும். இந்த முட்டைகள் 
ஆறு வாரங்கள் குளிர் வெப்பநிலையில் 
வைக்கப்படும். பின் இவற்றை அடைகாக்கும் 
பெட்டியில் (இன்குபேட்டர்) வைக்க வேண்டும். 
பத்து நாள்கள் கழித்து முட்டைகள் ப�ொரிந்து 
லார்வாக்கள் வெளிவரும். இவை 35 நாட்கள் 
மல்பெரி இலைகளை உண்டு வாழும். பிறகு 
பட்டுப்புழு ஐந்து நாளில் பட்டு இழைகளை 
உற்பத்தி செய்யும். இவை கூட்டுப் புழுக்களாக 
மாறும். பட்டுக்கூடு இழைகள் தனித்த நீண்ட 
இழையாக இருக்கும்.
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கூட்டுப்புழுக்களைக் க�ொதிநீரில் இட்டால், 
அதிலிருந்து பட்டு இழைகளை மிக எளிதாகச் 
சிக்கலின்றி பிரித்துவிடலாம். ஆனால் அவை 
பட்டு இழைகளை உருவாக்கட்டும் என்று 
விட்டு விட்டால் கூட்டுப்புழு உடையும் ப�ோது 
நீண்ட பட்டு இழைகளும் கிழியும். இதனால் 
தான் கூட்டுப்புழுக்களைக் க�ொதி நீரில் 
இட்டு, மிக நீளமான பட்டு நூலை எடுத்து, 
அதைச் சுத்தமாக்கி, சாயமேற்றி ஆடையாக 
நெய்கிறார்கள். 
பட்டின் சிறப்பம்சங்கள்

�� கவர்ச்சியாகவும், மிகவும் மென்மையான, 
அணிவதற்கு வசதியானது, பலதுறைகளில் 
பயன்படுகிறது. 

�� இதை எளிதில் சாயமேற்றலாம்.
�� இயற்கை இழைகளிலேயே பட்டு இழை 

தான் வலிமையான இழையாகும். 
�� இது சூரிய ஒளியை எளிதில் கடத்தும்.

பட்டின் பயன்கள்
பட்டு இயற்கை அழகுடையது, க�ோடை 

காலத்தில் இது இதமானதாகவும், குளிர் 
காலத்தில் வெப்பத்தைத் தரக் கூடியதாகவும் 
உள்ளது. நாகரிகமான, நவீன உடைகளைத் 
அழகாகத் தயாரிக்கவும், சிறப்பு வாய்ந்த அழகிய 
பட்டாடைகளை வடிவமைக்கவும் முக்கியமாக 
சேலைகள் தயாரிக்க இது பயன்படுகிறது. வீட்டு 
உபய�ோகப் ப�ொருள்களான சுவர் அலங்காரப் 
ப�ொருள்கள், திரைச் சீலைகள், கம்பளம் மற்றும் 
இதர விரிப்புகள் தயாரிக்கவும் பயன்படுகின்றன. 
பட்டு இழையானது, மருத்துவத் துறையில், 
அறுவை சிகிச்சையின் ப�ோது தையல் நூலாகப் 
பயன்படுத்தப்படுகிறது.

பட்டு உற்பத்தியில், 
உலகிலேயே இரண்டாவது 
இடத்தைப் பெறுவது 

நம் இந்திய நாடு. தமிழ்நாட்டில் உள்ள 
காஞ்சிபுரம், திருபுவனம் மற்றும் ஆரணி 
ப�ோன்ற இடங்கள் பட்டு உற்பத்திக்குப் புகழ் 
பெற்றவை.
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5.3  ெடடு மறறும் கம்ெளி ஆ்லகளில் 
ஏறெடும் அெறாயங்கள்
ஆடல்களில் ்பணிபுரி்்ாருககுக 

்காயங்்கள் ஏற்்பைலாம். ஆடல்களில் சூழ்நிடல 
்காரணமா்கச் சில ்பாதி்பபு்கள் மற்றும் 
ஆ்ராககியமற்ற நிடல ஏற்்பைலாம்.

ெடடறா்லகளில் ஏறெடும் ெறாதிபபுகள்
த்பாது்ா்க்ப ்பட்ைாடல்களில் 

்பணிபுரி்ப்ர்கள் நின்றுத்காண்்ை ்பட்டுநூடல 
நூற்்பதால் அ்ர்கள் மூட்டு ்லியால் 
அ்தி்ப்படுகிறார்கள். ்மலும் இ்ர்கள் முதுகு 
்லியினாலும், ்பாரட்க ்்காைாறு்கள் மற்றும் 

1. எது முைலில் 
வந்ைது, ெடடுபபுழு 
அல்லது முட்ட

6. குககூனக்ள 
பகறாதிநீரில் 

விடடறால் 
கூடடுபபுழுககள் 

இ்ந்து 
விடுவைறால், 

பெரசின 
இ்லகள் 
ைளரந்து 

விடுகின்ன

5. குககூனனில் 
உள்ள லறாரவறா 
கூடடுபபுழுவறாக 

மறாறும் 4. ெடடுபபூச்சி 
ைன்னச் சுறறி 

குககூ்ன 
உறெததிச் பெய்யும்

7. ைனிதை 
ெடடு இ்ழகள் 

பிரிககபெடுகின்ன

8. இந்ை இ்ழகள் 
நூல் ெந்துகளறாக 

மறாற்பெடுகின்ன
இந்ை நூல் ெந்து 
ஆ்டகள் பெய்ய 

ெயனெடுகி்து

3. ெடடுபபூச்சிகள், 
அவறறின ஆரம்ெ 

எ்ட்ய விட 
50,000 மடங்கு 

எ்டயுள்ள மல்பெரி 
இ்லக்ள உணடு 

வளரகின்ன

2. முட்டகள் 
பெறாரிதது லறாரவறாககள் 

உருவறாகின்ன
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த�ோல் காயங்களாலும் துன்புறுகிறார்கள். 
குறைந்த காற்றோட்டமுள்ள பகுதிகளில் 
இவர்கள் பணிபுரிவதால் சில சமயம், சுவாச 
சம்பந்தமான ந�ோய்களான ஆஸ்துமா மற்றும் 
மார்புச் சளியாலும் அவதிப்படுகிறார்கள்.

கம்பளி ஆலைகளில் ஏற்படும் பாதிப்புகள் 
கம்பளி ஆலைகளில் பணிபுரியும் 

பணியாளர்கள் வெவ்வேறு வேதிப்பொருள்கள் 
மற்றும் சலவைத்தூள்களையும் 
பயன்படுத்துவதால் ஒவ்வாமை மற்றும் 
த�ோல் ந�ோயால் துன்புறுகிறார்கள். இறந்த 
விலங்குகளைக் கையாளுவதால் கம்பளி 
ஆலை பணியாளர்கள் ஆந்தராக்ஸ் பாக்டீரியா 
த�ொற்றால் அவதிப்படுகிறார்கள். இதுப�ோன்ற 
பாதிப்பு ஏற்பட்டால் உயிர் சேதம் எற்படுகிறது 
இது பிரித்தெடுப்போர்கள் ந�ோய் என்றும் 
அழைக்கப்படுகிறது.

பேசில்லஸ் ஆந்த்ராசிஸ் என்ற 
பாக்டீரியாவால் ஏற்படும் ந�ோய் ஆந்தராக்ஸ். 
இந்த பாக்டீரியாவால் பாதிக்கப்பட்ட, 
விலங்குகளின் உர�ோமம் மற்றும் அங்கு 
வாழும் விலங்குகளைக் கையாளுவ�ோர்க்கும் 
ஆந்தராக்ஸ் ந�ோய் எற்பட வாய்ப்புள்ளது. 
இந்நோயின் அறிகுறிகள் – காய்ச்சல், இருமல், 
மூச்சு விடுதலில் சிரமம்.  இவை நிம�ோனியாவை 
ஒத்த அறிகுறிகளாகும். சில சமயம் இவர்களுக்கு 
வாந்தி எடுக்கும் சூழ்நிலையும் மற்றும் 
வயிற்றுப்போக்கும் ஏற்படுகின்றன.
சிகிச்சை

�� பெனிசிலின் மற்றும் சிப்ரோஃப்ளோக்சாசின் 
ப�ோன்ற சிறந்த மருந்துகள் ஆந்த்ராக்ஸ் 
ந�ோயைக் குணமாக்க உதவுகின்றன. 

�� விலங்குகளுக்கு ஆந்தராக்ஸ் தடுப்பூசி ப�ோட 
வேண்டும் மற்றும் ஆந்த்ராக்ஸ் ந�ோயால் 
இறந்த விலங்குகளை ஆழ்குழி த�ோண்டி 
அதில் புதைக்க வேண்டும் அல்லது எரிக்க 
வேண்டும் 

�� முதலாளிகள் தங்களின் 
பணியாளர்களுக்குச், சுத்தமான 
சுற்றுச்சூழலும் நல்ல காற்றோட்டம் 

மற்றும் பாதுகாப்பும் அளிக்க வேண்டியது 
அவர்களின் கடமையாகும்

பட்டுபுழு வளர்த்தல் மற்றும் அமைதிப்பட்டு
பட்டுப்பூச்சிகளை வளர்த்து பட்டு நூலை 

உருவாக்கும் முறை பட்டுபுழு வளர்ப்பு 
(Sericulture) எனப்படும். இது அதிகப் பட்டு 
இழைகளைப் பெறுவதற்காக ஏராளமான 
பட்டுப்பூச்சிகளை வளர்க்கும் முறை ஆகும்.
அகிம்சைபட்டு

ஆண்டாண்டு காலமாகக் க�ொதிக்கும் நீரில் 
கூட்டுப் புழுக்களைப் ப�ோட்டு, அவற்றைக்   அழித்து 
அதிலிருந்து பட்டு இழைகளை எடுத்தனர். 
இந்தியாவில் ஆந்திரப்பிரதேச மாநிலத்தில் அரசு 
அதிகாரியாகப் பணியாற்றிய குசுமா ராஜய்யா 
என்பவர், 1992ஆம் ஆண்டு கூட்டுப்புழுக்களைக் 
அழிக்காமல், அவற்றிலிருந்து பட்டு நூலை 
எடுக்கலாம் என்பதைக் கண்டறிந்தார். 
ஆனால், மென்மையான முறை ஒன்றை 
உருவாக்கினார். கூட்டுப்புழுக்கள், கூட்டை 
உடைத்துக்கொண்டு வெளியேறும் 
ப�ோது அவற்றைக் க�ொல்லாமல், அவை 
உண்டாக்கும் பட்டு இழைகளை எடுக்கலாம் 
என்றார். இந்தப் பட்டு, மனித நேயத்தின் 
அடிப்படையில், பராம்பரிய முறைகளைத் 
தாண்டி உருவாக்கப்பட்டதாகும். எனவே இது, 
அகிம்சைபட்டு அல்லது அமைதிபட்டு என்று 
அழைக்கப்படுகின்றது. இவரைப் பின்பற்றி, 
விலங்குகளின் நலனில் அக்கறையுள்ள 
ஏராளமான மக்களும் இதில் ஆர்வம் காட்டினர். 

5.4 �விலங்குகளின் பாதுகாப்பு மற்றும் 
பராமரிப்பு
விலங்குகளைப் பாதுகாத்தல் என்பது 

நமது குழந்தைகளையும், பெற்றோரையும் 
பாதுகாப்பதற்கு நிகரானது 
அவை மனிதர்கள் ப�ோன்ற 
உயிரிகளாகும். இந்த 
உலகில் வாழும் அனைத்து 
உ யி ரி ன ங ்க ள ை யு ம் 
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பாதுகாப்பது மனிதர்களின் கடமை. 
விலங்குகளைப் பாதுகாக்கும் மிகப் பெரிய 
ப�ொறுப்புணர்வு மனிதர்களாகிய நமக்கு 
இருக்கிறது.

வி ல ங் கு க ளி ன் 
இனப்பெருக்கத்தை ஆய்வு 
செய்தல் மற்றும் அவற்றின் 

பராமரிப்பு பற்றிப் படிக்கும் பிரிவிற்கு 
விலங்கு வளர்ப்பு (Animal Husbandry) 
என்று பெயர்.

நமது சுற்றுச்சூழல், காடு மற்றும் தட்ப 
வெப்பநிலை மற்றும் மாற்ற சார்ந்த அமைச்சகம், 
விலங்குகளைத் துன்புறுத்துதலில் இருந்து 
பாதுகாக்க 1960 ஆம் ஆண்டு, நான்கு புதிய 
சட்டங்களை க�ொண்டுவந்தது அவற்றுள் 
வீட்டில் நாய் வளர்ப்பவர்கள், விலங்குகளை 
சந்தையில் விற்பனை செய்பவர்கள், செல்லப் 
பிராணிகள் மற்றும் மீன்கள் வளர்ப்பவர்கள் 
ப�ோன்றவர்களுக்காக உருவாக்கியது. 
விலங்குகளைப் பாதுகாத்துப் பராமரிக்க 
வேண்டும் என்ற பல்வேறு குழுக்களின் 
கூட்டுமுயற்சியால்தான் அரசு இச்சட்டங்களை 
இயற்றியது. நம்மையும், நம் சுற்றுச் சூழலையும் 
பாதுகாத்துக் க�ொள்ள, விலங்குகளை 
நாம் பாதுகாக்க வேண்டும். ஆகையால், 
நாம் விலங்குகளின் மீது அக்கறை, அன்பு 
க�ொண்டு அவற்றைப் பாதுகாக்க வேண்டும், 
நம் குடும்பத்திலுள்ள ஓர் உறுப்பினர் ப�ோல் 
விலங்குகளையும் நாம் பேணிக்காக்க 
வேண்டும்.

மதிப்பீடு

I. சரியான விடையைத் தேர்ந்தெடு
1.	  தினசரி, 

கால்நடைகளிலிருந்து நமக்குக் கிடைக்கும் 
முக்கியமான ப�ொருளாகும்.
அ. முட்டை
ஆ. பால்
இ. இவை இரண்டும் 
ஈ. இவை எதுவும் அல்ல

2.	 முட்டையில்  அதிகம் 
உள்ளது.
அ. புரதம்		  ஆ. கார்போ ஹைட்ரேட்
இ. க�ொழுப்பு	 ஈ. அமிலம்

3.	வெள்ளா டு மற்றும் செம்மறி ஆடுகளின் எந்த 
பாகம்  ஆடைகள் தயாரிக்க 
உதவுகிறது.? 
அ. கால்			   ஆ. கை
இ. உர�ோமம்		  ஈ. தலை

4.	ப ட்டுப் பூச்சிகளை வளர்ப்பதும், பட்டு 
இழைகளை உருவாக்குவதும் இவ்வாறு 
அழைக்கப்படுகிறது. 
அ. ஹார்ட்டிகல்சர்	  ஆ. ஃபுள�ோரிகல்சர்
இ. அக்ரிகல்சர்	  ஈ. செரிகல்சர்

5.	 பிரித்தெடுப்பவரின் ந�ோய் 
என்றழைக்கப்படுவது 
அ. ஆஸ்துமா		  ஆ. ஆந்தராக்ஸ்
இ. டைஃபாய்டு		  ஈ. காலரா

II. க�ோடிட்ட இடங்களை நிரப்புக
1.	 புரதம் மற்றும்  பாலில் அதிகம் 

உள்ளது.
2.	தே ன் கூட்டிலிருந்து 

எடுக்கப்படுகிறது. 
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3.	 ஆந்தராக்ஸ் ந�ோயை உண்டாக்குவது 

4.	 இயற்கை இழைகளிலேயே வலிமையான 
இழை 

5.	 அமைதிபட்டு  ஆம் ஆண்டு 
உருவாக்கப்பட்டது.

III. �சரியா, தவறா? தவறெனில் 
சரியானதை எழுதவும் 

1.	 இயற்கையின் மிகப் பெரிய க�ொடை 
விலங்குகள்.

2.	 குதிரையின் உர�ோமம் ஓவியம் தீட்டும் 
தூரிகைகளில் பயன்படுத்தப்படுகிறது. 

3.	ப ட்டுப்பூச்சி கம்பளி இழைகளைத் தருகிறது. 
4.	 அஹிம்சைப் பட்டின் மறுபெயர் மல்பெரி 

பட்டு.
5.	 ஆந்த்ராக்ஸைக் குணப்படுத்தும் சிறந்த 

மருந்து பெனிசிலின்.

IV. �ப�ொருத்துக.

1. கூட்டுப் புழு - இறைச்சி
2. �அமைதிப் பட்டு - க�ோழிப்பண்ணை
3. பிராய்லர் - பட்டுப் பூச்சி
4. �இனிப்பான திரவம் - ஆந்திரப் பிரதேசம்
5. ஆடு - தேன்

V. ஒப்புமை 
1. �நீர்: குழாய்: மின்சாரம் :: 

2. �தாமிரம்: கடத்தி: கட்டை :: 

3. �நீளம்; மீட்டர் அளவு: மின்சாரம் : 
.

4. �மில்லி அம்பியர்; மைக்ரோ அம்பியர்: 10-3 A: 
.

VI. மிகக் குறுகிய விடை தருக
1.	ப ாலிலிருந்து கிடைக்கும் ப�ொருள்களில் 

எவையேனும் இரண்டினை எழுதுக. 

2.	 விலங்குகளிடமிருந்து கிடைக்கும் இரு 
வகையான இழைகள் யாவை?

3.	கத்த ரித்தல் என்றால் என்ன?
4.	 ஆந்தராக்ஸ் ந�ோயின் அறிகுறிகளை எழுதுக
5.	செ ரிகல்சர் – வரையறுக்க
6.	 நாம் விலங்குகளை எப்படி நடத்த 

வேண்டும்?
7.	 அஹிம்சைப் பட்டைக் கண்டறிந்தவர் யார்?

VII. குறுகிய விடை தருக
1.	கம ்பளியின் சிறப்பம்சங்கள் மூன்றினை 

எழுதுக.
2.	ப ட்டின் ஏதேனும் மூன்று பயன்பாட்டை 

எழுதுக.
3.	க�ோ ழிப்பண்ணையில் காணப்படும் 

ப�ொதுவான ந�ோய்கள் யாவை?

VIII. விரிவான விடை தருக
1.	 அஹிம்சை பட்டு பற்றி விவரிக்க?
2.	பட்டாலைக ளில் ஏற்படும் அபாயங்கள் 

யாவை?
IX. �பின்வரும் வினாக்களுக்குப் பதில் 

தருக.
கம்பளி ஆலை படம்

1.	கம ்பளி ஆலையில், கம்பளி தயாரிக்கப்படும் 
நிலைகளை எழுதுக.

2.	கம ்பளியின் பயன்களை எழுதுக.

X. உயர் சிந்தனை வினா
1.	ப ாராசூட் தயாரிக்க பட்டு இழைகள் 

உதவுகின்றன. ஏன்?
2.	தே ன் எல்லாருக்கும் சிறந்த உணவாகப் 

பரிந்துரைக்கப்படுகிறது. ஏன்? காரணம் 
தருக.

XI. கூற்றும், காரணமும்
1. கூற்று: �விலங்குகளின் உர�ோமங்களிலிருந்து 

இழைகள் எடுக்கப்படுகின்றன. 
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 கறாரணம்:  ஆடு, யாக, அல்்பா்கா (உ்ராம 
ஆடு) மற்றும் முயல் ்கம்்பளி 
இடழ்கடைத் தருகின்றன. 

அ. கூற்றும், ்காரணமும் சைரி

ஆ. கூற்று சைரி, ்காரணம் த்று

இ. கூற்று த்று, ்காரணம் சைரி

ஈ. கூற்றும், ்காரணமும் த்று.

2. கூறறு: த்பனிசிலின் மற்றும் 
சி்ப்ராஃ்ப்ைாகசைாசின்.

 கறாரணம்: இந்த மருந்து்கள் ்பசு அம்டமடயக 
குணமாககும். 
 அ. கூற்று சைரி, ்காரணம் த்று.
 ஆ. கூற்று த்று, ்காரணம் சைரி.
 இ. கூற்றும் த்று, ்காரணமும் த்று.
 ஈ. கூற்றும் சைரி, ்காரணமும் சைரி.

இந்த தசையல்முடறயானது ்பண்டண அடமத்தல் 
மற்றும் ்பால் உற்்பத்தி குறித்து மாண்ர்கள் 
அறிந்து த்காள்ை உதவுகிறது

அன்றாை ்ாழ்வில் விலங்கு்கள்

அன்றாட வறாழ்வில் விலங்குகள்  URL:
https://play.google.com/store/apps/details?id=com.playnfun.cowfarmday

்படிநிடல்கள்
்படி 1 :   URL அல்லது Q.R.Code ஐ ்பயன்்படுத்தி தசையல்்பாடு ்பக்கத்டத திறக்கவும்
்படி 2 :   ஒரு ்பண்டனக ்காட்சி்தான்றும், அதனுைன் ஒரு ட்க Symbol ்தான்றும்
்படி 3:   ட்க Symbol ்காட்டும் ்ழிமுடற்களின்்படி ்பசுவிற்்கான உணவு்ப ்பயிர்கடை அறு்டை 

தசைய்தல் மற்றும் ்பசுவிற்கு தீ்னம் த்காடுத்தல் ்்பான்ற்ற்டறக ்காணலாம்.
்படி 4:  ் மலும் ்ழிமுடற்கடை்ப பின்்பற்று்தால் ்பால் உற்்பத்தி தசைய்தல் ்டர ்காணலாம்.

** ்பைங்்கள் அடையாைத்திற்கு மட்டு்ம.
* ்தட்தயனில் ‘Adobe Flash’ ஐ அனுமதிக்கவும்.

ெடி 1 ெடி 2

ெடி 4

ெடி 3

இடணயச் தசையல்்பாடு
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கற்றல் ந�ோக்கங்கள்

காட்சித் த�ொடர்பியல்6
அலகு

இப்பாடத்தைக் கற்றபின் மாணவர்கள்
�� லிப்ரெஆபிஸ் மென்பொருள் மூலம் ஒரு ஆவணத்தை உருவாக்குவது 

எப்படி என்று தெரிந்து க�ொள்வார்கள்
�� மாணவர்களின் படைப்பு சிந்தனை அதிகரிக்கும்
�� ஆவணத்தை ஒழுங்கமைக்கவும் மற்றும் வடிவமைக்கவும் அறிந்து 

க�ொள்வார்கள்

அறிமுகம்
இந்த பாடத்தில் மாணவர்கள் 

மென்பொருள் லிப்ரெஆபீசைப் பயன்படுத்த 
கற்றுக்கொள்வார்கள்.

லிப்ரெஆபிஸ் உலகம் முழுவதும் க�ோடிக் 
கணக்கான மக்களால் பயன்படுத்தப்படும் 
ஒரு சக்திவாய்ந்த மற்றும் இலவச அலுவலக 
பயன்பாட்டு த�ொகுப்பு மென்பொருள் ஆகும். 
இதன் இடைமுகம் மற்றும் பயனுள்ள கருவிகள் 
உங்கள் படைப்பாற்றல் மேம்படுத்திட மற்றும் 
உங்கள் செயல்திறனை மேம்படுத்த உதவும். 
லிப்ரெஆபீஸில் பின்வரும் பயன்பாடுகள் 
உள்ளன.

உரை ஆவணம் (Text Document)
எழுத்தாற்றல், புத்தகங்கள், அறிக்கைகள், 

செய்திமடல்கள், கையேடுகள், மற்றும் பிற 
ஆவணங்களைத் த�ோற்றுவிப்பதற்கு உரை 
ஆவணம் (Word செயலி) ஒரு கருவியாகும்.

அட்டவணைச்செயலி (Spreadsheet)
ஒரு உயர் முடிவு அட்டவணையிலிருந்து 

எதிர்பார்க்கப்படும் அனைத்து மேம்பட்ட 
பகுப்பாய்வுகளை வரைபடங்கள் (Chart) 
மற்றும் முடிவு செய்யும் அம்சங்களை 
அட்டவணைச்செயலி க�ொண்டுள்ளது. 
இதில், நிதி, புள்ளியியல் மற்றும் கணித 
செயல்பாடுகளுக்காக, 300க்கும் மேற்பட்ட 
செயல்பாடுகள் (Functions) உள்ளன.

நிகழ்த்துதல் (Impress)
சிறப்பு விளைவுகள், அசைவூட்டம் மற்றும் 

வரைதல் கருவிகள் ப�ோன்ற ப�ொதுவான 
மல்டிமீடியா விளக்கக்காட்சி உருவாக்க 
பயன்படுகிறது.

படங்கள் வரைதல் (Draw) 
வரைதல் என்பது எளிய வரைபடங்கள் 

அல்லது பாய்வு படங்கள் (Flowcharts) முதல் 
3டி ஆர்ட்வேலை வரை அனைத்தையும் 
உருவாக்கும் ஒரு வெக்டர் வரைதல் கருவி 
ஆகும்.
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�ைவுத்�்ளம் (Data base)

இது படிவங�ள், அறிக்்��ள், விைவல்�ள், அட்ைவ்ண�ள் உருவொக்�வும், திருததைவும் 
ெற்றும் அதை்ைப பொர்வயிைவும் பயனபடுகி்றது. உ்றவுைொர தைரெவுததைளத்தை நிரவகிபபது எனபது 
ெற்்ற பிரெபலெொை தைரெவுததைள பயனபொடு�்ளப கபொன்றதைொகும்.

லிபதைஆபிஸ ஃ்ார்முலா (சூத்திைஙக்்ள உருவாக்கு�ல்)
லிப்ரெஆபிஸ் ஃபொரமுலொ அல்லது ைெனபொடு எடிட்ை்ரெ பயனபடுததி சிக்�லொை ைெனபொடு�்ள 

உருவொக்� முடியும், இதில் நி்லயொை எழுததுரு ்தைொகுபபில் இல்லொதை குறியீடு�்ளக் கூை 
பயனபடுததி சூததிரெங�்ள உருவொக்�லொம்.

தமன்த்ாரு்்ளப த்றுவது எப்டி 
விண்கைொஸ், லிைக்ஸ் ெற்றும் கெக் ஓஎஸ் எக்ஸ் ஆகியவற்றின லிப்ரெஆபிஸ் பதிபபு�்ள 

https://www.libreoffice.org/download இலிருந்து இலவைெொ� பதிவி்றக்�ம் ்ையது ்�ொள்ளலொம்.

உ்ை ஆவணம் (Text Document)

இந்தை பகுதியில், உ்ரெ ஆவணம் பற்றி படிபகபொம். 

�டிதைங�ள், அறிக்்��ள் ெற்றும் பி்ற ஆவணங�்ள தைட்ைசசு ்ையய உ்ரெ ஆவணம் 
(Text Document) ்ென்பொரு்ள பயனபடுததைலொம்.

ஆவணஙக்்ள நிர்வகித்�ல் 
பொைததின இந்தைப பகுதி, ஒரு புதிய / தைற்கபொதுள்ள ஆவணத்தை எவவொறு தி்றபபது, ஒரு 

ஆவணத்தை கைமிததைல், ஆவணத்தைத ெறு்பயரிடுதைல் ெற்றும் தி்றக்�பபட்ை ஆவணத்தை மூடுதைல் 
ஆகியவற்்்ற விளக்குகி்றது. 
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புதிய ஆவணத்தை உருவாக்குதல்
 ஒரு புதிய ஆவணத்தை உருவாக்க, பின்வரும் முறைகளில் ஏதேனும் ஒன்றை பயன்படுத்தலாம்.
1. மெனு பட்டியில் உள்ள புதிய ஆவண (New Text Document) ப�ொத்தானை அழுத்தவும்.

2. �File → New → Text Document கட்டளையை பயன்படுத்தி ஒரு புதிய ஆவணத்தை 
திறக்கவும்.

3. விசைப்பலகையில் CTRL + N விசைகளை அழுத்தவும்.

ஆவணத்தை திறக்க
சேமிக்கப்பட்டு மூடப்பட்ட ஒரு ஆவணத்தை திறக்க, பின்வரும் முறைகளில் ஏதேனும் ஒன்றை 

செய்யலாம்.

1.	ம ெனு பட்டியில் உள்ள திறந்த க�ோப்பு (Open)  ப�ொத்தானை அழுத்தவும். 
 2. File → Open என்ற கட்டளையை பயன்படுத்தவும்
 3. விசைப்பலகையில் CTRL + O விசைகளை அழுத்தவும். 
திறந்த உரையாடல் பெட்டி. த�ோன்றும். க�ோப்பை தேர்ந்தெடுத்து திறக்க (Open) ப�ொத்தானை 

அழுத்தவும்.

புதிய / தற்போதுள்ள ஆவணத்தை சேமிக்க
புதிய அல்லது தற்போதுள்ள ஆவணத்தை சேமிக்க, பின்வரும் முறைகளில் ஏதேனும் ஒன்றை 

பின்பற்றவும்: 

1. மெனு பட்டியில் உள்ள சேமி (Save) ப�ொத்தானை அழுத்தவும். 

2. File → Save என்ற கட்டளையை பயன்படுத்தவும்.
3. விசைப்பலகையில் CTRL + S விசைகளை அழுத்தவும்.
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ஆவணம் ஏற்கனவே பெயரிடப்பட்டு முன்பே சேமிக்கப்பட்டிருந்தால் அந்த ஆவணங்களையும் 
மேற்கண்ட கட்டளைகள் மூலம் சேமிக்கலாம். அவ்வாறு இல்லாமல் புதிய ஆவணமாக சேமிக்க 
வேண்டுமென்றால் “Save as” உரையாடல் பெட்டியை (Dialogue box) திறப்பதன் மூலம் சேமிக்கலாம். 
ஆவணத்தை சேமிக்க விரும்பும் க�ோப்புறையை தேர்ந்தெடுக்கவும். க�ோப்பு பெயரினை தட்டச்சு செய்து 
“ok” என்பதை கிளிக் செய்யவும். மெனு பட்டியலில் File → Save as கட்டளையை தேர்ந்தெடுப்பதன் 
மூலம் புதிய ஆவணத்தை சேமிக்கலாம்.

ஆவணத்தை மூடுதல்
ஒரு ஆவணத்தில் வேலை முடிந்தவுடன் அந்த க�ோப்பினை மூடி விட File → Close என்ற 

கட்டளையை பயன்படுத்தலாம்.

ஆவணத்தை அச்சிடுதல் 
ஒரு ஆவணம் அல்லது தேர்ந்தெடுத்த பக்கங்களை அச்சிட கீழே க�ொடுக்கப்பட்டுள்ள 

படிநிலைகளை பின்பற்றவும்:

1. அச்சிடப்பட வேண்டிய ஆவணத்தை திறக்கவும்.

2. மெனு பட்டியில் File → Print கட்டளையை தேர்ந்தெடு. 

அச்சு உரையாடல் பெட்டி திறக்கும். அச்சு வரம்பு, நகல்களின் எண்ணிக்கை, அச்சுப்பொறி பெயர் 
ப�ோன்ற விருப்பத் தேர்வுகளை தேர்ந்தெடுக்கவும். அச்சுப்பொறியை “on” செய்யவும். மற்றும் தாள் 
அச்சியந்திர தட்டில் சரியாக வைக்கப்பட்டுள்ளதா என்பதை சரி பார்க்கவும். 

2. “OK” ப�ொத்தனை கிளிக் செய்திடவும்.
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அச்சு முன்னோட்டம் (Print Preview) 
அச்சு முன்னோட்டம், உங்கள் ஆவணம் அச்சிடப்படும்போது எவ்வாறு இருக்கும் எனப் 

பார்ப்பதற்கு ஒரு வழியை வழங்குகிறது. ஒரே நேரத்தில் பல பக்கங்களைப் பார்க்கவும் மற்றும் 
திரையினைப் பெரிதுபடுத்தவும் முடியும். உங்கள் ஆவணம் அச்சு முன்னோட்டமாக மாற, இந்த 
முறைகளில் ஒன்றை பயன்படுத்தவும்:

க�ோப்பு (File) மெனுவில் அச்சு முன்னோட்டம் (Print Preview) கிளிக் செய்யவும் அல்லது  
CTRL + Shift + O விசைகளை அழுத்தவும்.

Text Document மென்பொருளிலிருந்து வெளியேறுதல்
 க�ோப்பு மெனு பட்டியில் File → Exit Libreoffice கட்டளையை தேர்ந்தெடுப்பதன் மூலம் Text 

Document மென்பொருளிலிருந்து வெளியேற முடியும்.

உரையை தேர்ந்தெடுத்தல்
ஆவணத்தை உருவாக்கும் ப�ோது ஒவ்வொரு எழுத்தாக தட்டச்சு செய்தாலும் திருத்தும் ப�ோதும் 

வடிவூட்டும் ப�ோதும் ச�ொற்களைய�ோ வரிகளைய�ோ பத்திகளைய�ோ அல்லது சில நேரம் முழு 
ஆவணத்தைய�ோ தேர்ந்தெடுக்க வேண்டி வரும். உரைகளை தேர்ந்தெடுத்த பின்னால் தேவையான 
மாற்றங்களை செய்து க�ொள்ளலாம். உரையை நகர்த்தவும், நகல் எடுக்கவும் தடிப்பாக்கவும் முடியும். 
உரையை தேர்ந்தெடுக்க சுட்டி அல்லது விசைப்பலகையை பயன்படுத்தலாம்.

சுட்டியை க�ொண்டு உரையை தேர்ந்தெடுத்தல்
பின்வரும் படிகள் பின்பற்றப்பட வேண்டும்:

1. செருகும் இடத்தை தேர்ந்தெடுக்கப்பட வேண்டிய உரையின் த�ொடக்கத்தில் வைக்க வேண்டும்.

2. சுட்டெலியின் இடது ப�ொத்தானை அழுத்திப் பிடித்தவாறு உரையின் மீது நகர்த்த வேண்டும்.

3. உரை தேர்ந்தெடுக்கப்பட்ட பின் ப�ொத்தானை விட்டு விட வேண்டும்.
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விசைப்பலகையின் மூலம் உரையை தேர்ந்தெடுத்தல்
பின்பற்ற வேண்டிய வழிமுறைகள்:

1. செருகும் இடத்தை தேர்ந்தெடுக்கப்பட வேண்டிய உரையின் த�ொடக்கத்தில் வைக்க வேண்டும்.
2. �Shift ப�ொத்தனை அழுத்தியவாறு நகர்வு ப�ொத்தான்களை பயன்படுத்தி தேவையான 

உரையை உயர்த்திக் காட்ட வேண்டும்.
3. தேவையான உரை தேர்வு செய்யப்பட்டபின் Shift ப�ொத்தனை அழுத்துவதை விட்டு விடவும்.

நகர்த்துதல் மற்றும் நகலெடுத்தல்
நகர்த்துதல் மற்றும் நகலெடுத்தலுக்கும் இடையே உள்ள முக்கிய வேறுபாடு என்னவென்றால், 

நகர்த்துதல் தேர்ந்தெடுக்கப்பட்ட தரவை அதன் அசல் இடத்திலிருந்து நீக்கும் அதே நேரத்தில் 
நகலெடுத்தல் அசல் உள்ளடக்கத்தின் பிரதிய�ொன்றை உருவாக்குகிறது.

உரையை நகர்த்துதல்
தேர்ந்தெடுக்கப்பட்ட உரையை மிகவும் எளிதாக வேண்டிய இடத்தில் வெட்டவும் ஒட்டவும் 

செய்யலாம். இதற்கு கீழே குறிப்பிட்டுள்ள படி நிலைகளை பயண்படுத்தவும்:

1. முதலில் நகர்த்தப்பட வேண்டிய உரையை தேர்ந்தெடுக்க வேண்டும்.
2. �பிறகு Edit → Cut கட்டளையை தேர்ந்தெடுக்க வேண்டும். அல்லது கருவிப்பட்டையில்  

பணிக்குறியை தேர்ந்தெடுக்க வேண்டும்.
3. அதன் பிறகு செருகும் இடத்தை உரையை எங்கு ஒட்ட வேண்டும�ோ அங்கு வைக்க வேண்டும்.
4. �இறுதியாக Edit→ Paste கட்டளையை அல்லது கருவிப்பட்டையில் பணிக்குறியை 

தேர்ந்தெடுத்து புதிய இடத்தில் தேர்ந்தெடுக்கப்பட்ட உரையை ஒட்ட வேண்டும்.

இந்த முறையின் மூலம் ஒரு ஆவணத்தில் இருந்து இன்னொரு ஆவணத்தக்கு கூட வெட்டி 
ஒட்டும் பணியைச் செய்ய முடியும்.

கீழ்க்காணும் குறுக்கு வழியைப்பயன்படுத்தியும் உரையை நகர்த்தலாம்.

Ctrl +X → வெட்ட

Ctrl +V → ஒட்ட

உரையை நகலெடுத்தல்
1. முதலில் நகலெடுக்க வேண்டிய உரையை தேர்ந்தெடுக்க வேண்டும்.

2. �பிறகு Edit → Copy கட்டளையை தேர்ந்தெடுக்க வேண்டும். அல்லது கருவிப்பட்டையில்  
பணிக்குறியை தேர்ந்தெடுக்க வேண்டும்.

3. அதன் பிறகு செருகும் இடத்தை உரையை எங்கு ஒட்ட வேண்டும�ோ அங்கு வைக்க வேண்டும்.

4. �இறுதியாக Edit → Paste கட்டளையை அல்லது கருவிப்பட்டையில் பணிக்குறியை 
தேர்ந்தெடுத்து புதிய இடத்தில் தேர்ந்தெடுக்கப்பட்ட உரையை ஒட்ட வேண்டும்.
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கீழக்�ொணும் குறுக்கு வழி்யபபயனபடுததியும் உ்ரெ்யந�ரததைலொம்.

Ctrl + C → ந�்லடுக்�

Ctrl + V → ஒட்ை

வடிவ்மத்�ல் விருப்ஙகள்
வடிவூட்ைம் (Format) என்ற பட்டிப பட்்ைத கதைரவு மூலம் ஏ்றக்கு்்றய எல்லொ வடிவூட்ைத 

கதைரவு�்ளயும் ்ப்ற முடியும். ்பொதுவொ� பயனபடும் கதைரவு�ளுக்்�னறு தைனியொ�ப ்பொததைொன�ள் 
உள்ளை. ஆைொல் இந்தை ்பொததைொன�்ளப பயனபடுததுவதைற்கு முனைொல் அவற்்்ற எந்தை 
உ்ரெபபகுதியின மீது பயனபடுததுகிக்றொகெொ அ்தைத கதைரவு ்ையய கவண்டும். கதை்வயொை 
உ்ரெ்யத கதைரவு ்ையதைபின கதை்வக்க�ற்ப கீழ�ண்ை ்பொததைொன�ளில் ஒன்்ற கிளிக் ்ையயவும்.

உ்ரெ்ய தைடிபபொக்குவதைற்கு B ்பொததை்ை கிளிக் ்ையயவும்.

உ்ரெ்ய ைொயந்தை எழுததுக்�ளில் ெொற்றுவதைற்கு I ்பொததை்ைக் கிளிக் ்ையய கவண்டும்.

உ்ரெ்ய அடிக்க�ொடிடுவதைற்கு U என்ற ்பொததைொ்ைக் கிளிக் ்ையயவும்.

Format → Character என்ற �ட்ை்ள்ய கதைரவு ்ையது கி்ைக்கும் Style பட்டிப்பட்டியில் Menu 
Bar) ஒரு கதைர்வ ்ையதும் கெற்கூறிய பணி�்ள ்ையய முடியும்.

ெொ்றொ� வி்ைபபல்�யின மூலம் Ctrl + B, Ctrl + I ெற்றும் Ctrl + U வி்ை�்ள அழுததி 
மு்்றகய தைடிததை, ைொயந்தை அல்லது அடிக்க�ொடிட்ை எழுதது பண்புக்கு ெொற்்றலொம்.

எழுத்துருக்க்்ள மாறறு�ல் (Font Changing)

எழுததுரு எனபது ஒரு குறிபபிட்ை பொணியில் எழுததுக்�ள் ெற்றும் எண்�ளின ்தைொகுபபு ஆகும். 
ஒவ்வொரு எழுததுரு கதைொற்்றமும் ெற்்ற எழுததுருக்�ளிலிருந்து ெொறுபட்ைது.
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Format கருவிப்பட்டையில் (Tool bar) உள்ள Font என்பதை கிளிக் செய்து கீழ்தோன்றும் 
எழுத்துருக்களின் பட்டியலிலிருந்து, தேவையான ஒன்றை கிளிக் செய்யவும். தேர்ந்தெடுத்த 
எழுத்துருவில் உரை மாறுகிறது.

எழுத்துரு அளவு (Font Size)
எழுத்தினுடைய அளவு மிகவும் முக்கியமானதாகும். சட்ட ஆவணத்திற்கும், விளம்பர 

அறிவிப்பிற்கும் ஒரே அளவு உரையைப் பயன்படுத்த முடியாது.

Format கருவிப்பட்டையில் உள்ள Font Size கிளிக் செய்து கீழ்தோன்றும் பட்டியலிலிருந்து, 
தேவையான அளவு ஒன்றை கிளிக் செய்யவும். தேர்ந்தெடுத்த எழுத்துருவின் அளவில் உரை 
மாறுகிறது.

எழுத்துரு நிறத்தை மாற்றுதல் (Font Colour Changing)

தேர்ந்தெடுக்கப்பட்ட உரைக்கு வேறுவேறு வண்ணங்களை சேர்க்க முடியும். வண்ண அச்சுப் 
ப�ொறிகள் பெரும் வரவேற்பை பெற்று வருகின்றன. வண்ண அச்சுப் ப�ொறிகளின் துணைக�ொண்டு 
ஆவணங்களைப் பல வண்ணங்களில் அச்சிட முடியும். 

உரைக்கு வேறு வண்ணத்தை சேர்ப்பதற்கு Font Colour என்ற பணிக்குறியை கிளிக்செய்து 
பின்னர் வேண்டிய வண்ணத்தைச் சேர்க்கலாம். இந்தப் பணிக்குறியின் மீது கிளிக் செய்து 
ப�ொத்தானை அழுத்திப் பிடித்தவாறு இருந்தால் ஒரு வண்ணத்தட்டு திரையிடப்படும். அதில் வேண்டிய 
வண்ணத்தை கிளிக் செய்தால் தேர்வு செய்யப்பட்ட உரை அந்த வண்ணத்திற்க்கு மாற்றப்படும்.

பத்தி ஒழுங்குபடுத்தல் (Paragraph Alignment)

பத்தி ஒழுங்கமைப்பு என்பது பத்தியின் இடது மற்றும் வலது பக்கங்களின் த�ோற்றத்தை 
குறிக்கிறது. இயல்பாக, Word இடப்பக்கம் பத்திகளை ஒழுங்கமைக்கும் (Left Alignment). நீங்கள் 
Word-இல் பத்திகளை வலதுபக்கம் ஒழுங்குபடுத்தலாம், அதனால் வலது பக்கம் சமச்சீராக இருக்கும். 
இது வலது இசைவு (Right Alignment) எனப்படுகிறது. இரு பக்கங்களிலிருந்தும் சமமான இடைவெளி 
க�ொண்டு நடுவில் ஒழுங்குபடுத்தலாம். இது நடு ஒழுங்கமைப்பு (Centre Alignment) எனப்படுகிறது. 
இறுதியாக, இடது மற்றும் வலது பக்கங்கள் இரண்டையும் ஒரு சேர ஒழுங்குபடுத்தலாம். இது 
நேர்த்திசைவு (Justify) எனப்படும்.
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இவவொறு நொனகு வ்�யொை ஒழுஙகுபடுததைல்�்ளத கதைரவு ்ையயலொம், வடிவ்ெததைல் 
�ருவிபபட்டி்ய பயனபடுததை.பினவரும் படி�ள் பயனபடுததைபபடுகின்றை.

1. ஒரு பததியின ஒழுங�்ெ்வ ெொற்்ற, முதைலில் அந்தை பததிக்குள் கிளிக் ்ையயவும்.

2. பல பததி�ளின ஒழுங�்ெ்வ ெொற்்ற, அபபததி�்ளத கதைரந்்தைடுக்�வும்.

்க்கத்தின் அ்மவுகள் (Page Orientation)

பக்�ததின நீளம் அ�லத்தைவிை அதி�ெொ� இருந்தைொல் அது கபொரட்்ரெட் (Portrait) எைபபடும். 
அகதை ைெயம் அ�லம் நீளத்தை விை அதி�ெொ� இருந்தைொல் அது கலண்ட்ஸ்க�ப (Landscape) அ்ெவு 
எைபபடும்.

1. Format → Page �ட்ை்ள்யத கதைரவு ்ையதைொல் பக்� அ்ெபபு உ்ரெயொைல் ்பட்டி கதைொனறும்.

2. Page ்தைொகுதி்யக் கிளிக் ்ையது விருபபங�்ள கதைரவு ்ையயலொம்.

3.  பக்�ததின அள்வ ெொற்றுவதைற்கு Paper Format  கீழி்றஙகு பட்டியில் கவண்டிய அள்வத 
கதைரவு ்ையய கவண்டும். அல்லது சுேல் அம்புக்குறி்ய பயனபடுததி உயரெம் ெற்றும் 
அ�லத்தை ெொற்்றலொம்.

4. Orientation பகுதியில் Portrait அல்லது Landscape எனப்தைத கதைரவு ்ையய கவண்டும்.

5. Ok ்பொததைொ்ை கிளிக் ்ையயவும்.

ரூலரின் து்ண தகாண்டு ஓைஙக்்ள மாறறு�ல்
ஆவண வடிவின ஓரெ அளவு�ள் ைரியொ�த ்தைரியவில்்ல்யனில் View பட்டியில் உள்ள Ruler 

வைதி்யப பயனபடுததி ஓரெததின அளவு�்ள ெொற்றிக் ் �ொள்ளலொம். அதைற்கு கீழ�ொணும் மு்்ற்யப 
பயனபடுதது�.

• Ruler தி்ரெயில் கதைொன்றொவிட்ைொல் View → Ruler ்பொததைொ்ை அழுததை கவண்டும்.
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• �Ruler இன் சாம்பல்நிறப் பகுதி ஓர அளவின் மேல் பகுதியைக் குறிக்கிறது. சுட்டியை சாம்பல் 
நிறப்பகுதிக்கும் வெள்ளை நிறப்பகுதிக்கும் இடையில் எடுத்துச் செல்ல வேண்டும்.

• �சுட்டி சரியான இடத்தில் இருந்தால் அந்தச் சுட்டி இருதலை க�ொண்ட அம்புக் குறிப�ோல் 
காட்சியளிக்கும்.

• இப்பொழுது ஓர வழிகாட்டியை (Margin guide) புதிய இடத்துக்கு நகர்த்த வேண்டும்.

மதிப்பீடு

I.	ச ரியான விடையைத் தேர்ந்தெடுத்து எழுதுக.
1.	தே ர்ந்தெடுத்த உரையை நகலெடுக்க  விசைப்பலகைக் குறுக்குவழி பயன்படுகிறது.

	 அ) Ctrl + c	 ஆ) Ctrl + v	 இ) ctrl + x	 ஈ) Ctrl + A

2.	தே ர்ந்தெடுத்த உரையை வெட்ட  விசைப்பலகைக் குறுக்குவழி பயன்படுகிறது.

	 அ) Ctrl + c	 ஆ) Ctrl + v	 இ) ctrl + x	 ஈ) Ctrl + A

3.	லிபெர் ஆபிஸ் ரைட்டரில் எத்தனை வகையான பக்க அமைவுகள் உள்ளன?

	 (அ 1	 ஆ) 2	 இ) 3		  ஈ) 4

4. திரையில் ரூலர் தெரியாவிட்டால்  கிளிக் செய்ய வேண்டும்.

	 அ) View → ruler	 ஆ) view → task		  இ) file → save		  ஈ) edit → paste

5. ஆவணத்தைச் சேமிக்க மெனு பயன்படுகிறது.

	 அ) File → open	 ஆ) File → print 	 இ) File → save	 	 ஈ) File → close

II. கீழ்க்காணும் வினாக்களுக்கு விடையளிக்கவும்.
1. உரை ஆவண மென்பொருளின் பயன்கள் யாவை?
2. உரையை தேர்ந்தெடுத்தல் என்றால் என்ன?
3. ஒரு ஆவணத்தை மூடலாம்?
4. வலது இசைவு என்பது என்ன?
5. ஏற்கனவே உள்ள ஒரு ஆவணத்தை திறப்பது எப்படி?
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ஏழாம் வகுப்பு அறிவியல் மூன்றாம் பருவம் பாடநூல் உருவாக்கம்

ஆல�ோசனைக்குழு
குழுத்தலைவர் 
முனைவர்.த.வி.வெங்கடேஷ்வரன்
விஞ்ஞானி,
விஞ்ஞான் பிரசார் அறிவியல் மற்றும் த�ொழில்நுட்பத்துறை, புதுடெல்லி.
முனைவர். மஸ்ஹர் சுல்தானா
துறைத் தலைவர் (விலங்கியல்) ஓய்வு,
மாநிலக் கல்லூரி, சென்னை.

மீளாய்வு 
முனைவர் வி. சிவமாதவி
இணைபேராசிரியர், 
பாரதி மகளிர் கல்லூரி, சென்னை.
முனைவர். க�ோ. ரமேஷ்
உதவி பேராசிரியர் (வேதியியல்),
டாக்டர் அம்பேத்கர் அரசு கலைக்கல்லூரி, 
வியாசர்பாடி சென்னை.
முனைவர்.க�ோ. ராஜலட்சுமி
உதவிப்பேராசிரியர் 
பாரதி மகளிர் கல்லூரி, சென்னை.

வல்லுநர் மற்றும் ஒருங்கிணைப்பாளர்கள்
து. பிரபாகரன்
உதவிப்பேராசிரியர், 
SCERT, சென்னை.
ச. ராஜேஷ்
பட்டதாரி ஆசிரியர். அரசு மேல்நிலைப் பள்ளி, வங்கனூர்,   
திருவள்ளூர் மாவட்டம். 

பாட மீளாய்வு
த. பெருமாள் ராஜ்
பட்டதாரி ஆசிரியர், ஊராட்சி ஒன்றிய நடுநிலைப்பள்ளி, 
மாணிக்கமங்கலம், வலங்கைமான் ஒன்றிம், திருவாரூர். 
ம�ோ. ம�ோகனப்பிரியா
முதுகலை ஆசிரியை, அரசு மகளிர் மேல்நிலைப்பள்ளி,
க�ோவிந்தகுடி , திருவாரூர்.

கல்வி ஆல�ோசகர்
முனைவர். ப�ொன். குமார்
இணை இயக்குநர் (பாடத் திட்டம்)
SCERT, சென்னை.
பாடநூல் ஆசிரியர்கள்
என்.இராமேஷ்பாபு
பட்டதாரி ஆசிரியர்
ஊராட்சி ஒன்றிய நடுநிலைப்பள்ளி,
ஆட்டன் தாங்கல், ச�ோழவரம், சென்னை
முனைவர்.மே.நா. தனுஜா
பட்டதாரி ஆசிரியர், அரசு மேல்நிலைப் பள்ளி, 
தேவச�ோலை, நீலகிரி.
முனைவர். ந. வித்யகீதா
விரிவுரையாளர் DIET, ஆடுதுறை, தஞ்சாவூர்.
திரு. ரிபு வ�ோரா
கழிவு மேலாண்மை, ஆர�ோவில், புதுச்சேரி.
லி. சுந்தரம்
பட்டதாரி ஆசிரியர், ஊராட்சி ஒன்றிய நடுநிலைப்பள்ளி,
பாக்கிய நகர், உதகை, நீலகிரி.
ம. ஆனந்தன்
பட்டதாரி ஆசிரியர், அரசு உயர்நிலைப்பள்ளி,  
சேர்வைக்காரன்பட்டி, திண்டுக்கல்.
ந. மணிகண்டன்
பட்டதாரி ஆசிரியர்,
 அரசு உயர்நிலைப்பள்ளி, ராசிங்காபுரம், தேனி.
நா. பாலுச்சாமி
தலைமை ஆசிரியர் (ஓய்வு),
மாநகராட்சி மேல்நிலைப் பள்ளி, பீலமேடு, க�ோயம்பத்தூர்.
மா. தமிழரசி 
முதுகலைப் பட்டதாரி ஆசிரியர் (ஓய்வு),
புனித ஜ�ோசப் பெண்கள் மேல்நிலைப்பள்ளி, வடுகர்பேட்டை, திருச்சி.
எஸ். சுரேந்திரன்
அரசு மேல்நிலைப்பள்ளி
மாதவலாயம், கன்னியாகுமரி மாவட்டம்.

இணையச் செயல்பாடு
எஸ். சுரேந்திரன்
அரசு மேல்நிலைப்பள்ளி
மாதவலாயம், கன்னியாகுமரி மாவட்டம்.

கலை மற்றும் வடிவமைப்பு
வரைகலை 
வின�ோத், க�ோபு, பிரம�ோத், வேல்முருகன்
புத்தக கட்டமைப்பு
வே.சா. ஜாண்ஸ்மித், 
பேச்சி முத்து கைலாசம்,
சகாய அரசு.
நிழல் வரைப்படம் 
தாமரை சீனிவாசன், ஓவியர்
ச�ௌத்திரி நகர், வளசரவாக்கம், சென்னை.
அட்ைட  வடிவ ைமப்பு
கதிர் ஆறுமுகம்
QC
ம ேனாகர் இராதாகிருஷ்ணன்
ஒருங்கிணைப்பாளர்
ரமேஷ் முனிசாமி
தட்டச்சர்
மு. சத்யா
புது பெருங்களத்தூர், சென்னை.

விரைவுக் குறியீடு மேலாண்மைக் குழு
இரா. ஜெகநாதன்
இடைநிலை ஆசிரியர், ஊராட்சி ஒன்றிய நடுநிலைப்பள்ளி, 
கணேசபுரம், ப�ோளூர் , திருவண்ணாமலை. 
சூ. ஆல்பர்ட் வளவன் பாபு
பட்டதாரி ஆசிரியர்,
அரசு உயர்நிலைப்பள்ளி, பெருமாள் க�ோவில்,
பரமக்குடி, இராமநாதபுரம்.

ம. முருகேசன்
பட்டதாரி ஆசிரியர், ஊராட்சி ஒன்றிய நடுநிலைப்பள்ளி, 
பெத்தவேளாண்கோட்டகம், முத்துப்பேட்டை, திருவாரூர்.
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ஏழாம் வகுப்பு 
சமூக அறிவியல்

மூன்றாம் பருவம்
த�ொகுதி - 3
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வரலாறு
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பாடப் தபாரு்ளடககம்

பாடநூலில் உள்்ள விசரவுக குறியீடசடப்  (QR Code) பயனபடுத்துநவாம்! எப்படி?
•  உங்கள திறைன ழ்பசியில் கூகுள playstore ப்கவாணடு DIKSHA பசயலிவய ்பதிவிறைக்்கம் பசயது நிறுவிக்ப்கவாள்க. 
•  பசயலிவய திறைந்்தவுடன, ஸழ்கன பசயயும் ப்பவாத்தவாவை அழுததி ்பவாடநூலில் உள்ள விவரவு குறியீடு்கவ்ள ஸழ்கன பசயயவும். 
•  திவரயில் ழ்தவானறும் ழ்க்ரவாவை ்பவாடநூலின QR Code அருகில் ப்கவாணடு பசல்்வும். 
•  ஸழ்கன பசயை்தன மூ்ம். அந்்த QR Code  உடன இவணக்்கப்்பட்டுள்ள மின ்பவாட ்பகுதி்கவ்ள ்பயன்படுத்த்வாம். 

அலகு �சலப்பு பகக எண் மா�ம்

வரலாறு
1. புதிய ச்யக் ்கருததுக்்களும் இயக்்கங்களும் 129 ஜைைரி

2. ்தமிழநவாட்டில் ்கவ்யும் ்கட்டடக் ்கவ்யும் 140 பிப்ரைரி
3. ்தமிே்கததில் ச்ணம், ப்பௌத்தம், 

ஆசீை்கத ்தததுைங்கள
152 ்வாரச்

புவியியல்
1. ்கணடங்கவ்ள ஆரவாய்தல் - ைடஅப்ரிக்்கவா 

்றறும் ப்தனஅப்ரிக்்கவா
168 ஜைைரி

2. நி்ைவர்படதவ்த ்கறறைறி்தல் 201 பிப்ரைரி
3. இயறவ்க இடர்கள - ழ்பரிடர ழ்்வாணவ் 

நடைடிக்வ்க்கவ்ள புரிந்து ப்கவாள்ளல்
210 ்வாரச்

குடிசமயியல்
1. ப்பண்கள ழ்ம்்பவாடு 223 ஜைைரி

2. சந்வ்த ்றறும் நு்கரழைவார ்பவாது்கவாப்பு 231 ்வாரச்

3. சவாவ்ப் ்பவாது்கவாப்பு 241 ஏப்ரல்

தபாருளியல்
1. ைரியும் அ்தன முக்கியததுைம் 253 ஏப்ரல்

மினநூல் ்திப்பீடு இவணய ை்ளங்கள
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கற்றல் ந�ோக்கங்கள்

கீழே குறிப்பிடப்பட்டுள்ளவை குறித்த அறிவினைப் பெறுதல்
�	ஆழ்வார்கள், நாயன்மார்கள் ஆகிய�ோரின் பக்தி இயக்கம் 
�	ஆதிசங்கரரின் அத்வைத தத்துவம், இராமானுஜரின் விசிஷ்டாத்வைத 

தத்துவம் 
�	வட இந்திய பக்திக் க�ோட்பாடுகளும் அவற்றை முன்மொழிந்த 

ஆளுமைகளும்
�	இந்து இஸ்லாம் சமயங்களுக்கு இடையிலான உறவு ஊடாட்டங்களும் அது குறிப்பாக 

சூபியிசம் (இஸ்லாமிய மறைமெய்ஞானம்) ப�ோன்ற புதிய க�ோட்பாடுகள் உருவாவதற்கு 
இட்டுச் சென்றமையும் 

�	கபீர், குருநானக் ஆகிய�ோரின் ப�ோதனைகள் 
�	பக்தி இயக்கத்தின் தாக்கம்

அலகு - 1

புதிய சமயக் கருத்துக்களும் 
இயக்கங்களும்

அறிமுகம்

இடைக்கால இந்தியாவில் வியப்பை 
ஏற்படுத்தும் அளவில் பக்திக் கவிதைகள்/ 
செய்யுள்கள் இயற்றப்பட்டன. அவை ஒரு 
குறிப்பிட்ட சமயம் சார்ந்ததாக இல்லாமல்  
பல்வேறு சமய இயக்கங்களினால் 
தூண்டப்பெற்றன. கடவுளின் மீதான 
முழுமையான பக்தியே மனிதனை 
வாழ்வின் இடர்ப்பாடுகளிலிருந்து காத்து 
முக்தியை அருளுமென இவ்வியக்கங்களை 
நிறுவியவர்கள் கருதினர். மேலும் இறைவன் 
எங்கும் நிறைந்து இருப்பதினாலும் ஒவ்வொரு 

மனிதனுக்குள்ளும் உறைந்திருக்கின்றார் 
என்பதாலும் ஒருவர் க�ோவிலுக்குச் 
செல்ல வேண்டியத�ோ, சடங்குகள் 
செய்ய வேண்டியத�ோ அவசியமில்லை. 
எனவும் நம்பப்பட்டது. அறிவின் வழிப்பட  
ஞானமார்க்கம், சடங்குகள், நற்செயல்கள் 
ஆகியவற்றின் வழிப்பட கர்மா மார்க்கம் 
ஆகிய இவை இரண்டைக் காட்டிலும் 
பக்திமார்க்கமே சிறந்தது என பகவத்கீதையில் 
கூறப்பட்டுள்ளது. இது பக்திக் க�ோட்பாடுகளை 
முன்மொழிந்தவர்களை ஊக்குவிப்பதாய் 
அமைந்தது.
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பக்தி இயக்கம் : த�ொடக்கங்கள் 

பக்தி இயக்கம் அல்லது வழிபாட்டு 
முறைகளிலான புத்தெழுச்சி தமிழகத்தில் 
கி.பி. (ப�ொ.ஆ.) ஏழாம் நூற்றாண்டை ஒட்டித் 
த�ொடங்கிற்று. அப்புத்தெழுச்சி  ஆண், பெண் 
கடவுளர்களின் பெயர்களைத் த�ொடர்ந்து 
ஓதுதல். கடவுளர்களைப் புகழ்ந்து பாடுதல், 
மதச் சின்னங்களை அணிந்து க�ொள்வது 
அல்லது அடையாளச் சின்னங்களைச் 
சுமந்து செல்வது, கடவுளுடன் த�ொடர்புடைய 
புனிதத்தலங்களுக்கு ஆன்மீகப் பயணங்கள் 
மேற்கொள்வது என்பனவற்றை 
உள்ளடக்கியதாக இருந்தது. தனக்குச் 
ச�ொந்தமான கடவுளை வழிபடும் பக்தனுக்கும் 
அக்கடவுளுக்கும் இடையிலான பரஸ்பர 
உணர்வு ரீதியிலான பற்றுதலுக்கும் அன்பிற்கும் 
பக்தி இயக்கம் சிறப்பு முக்கியத்துவம் க�ொடுத்தது. 
சூபி தத்துவமும் இதே ப�ோன்ற கருத்தையே 
ப�ோதித்தது. த�ொடக்ககால இஸ்லாம் சமயத்தின் 
உலகப்பற்றுதலுக்கு எதிராகத் த�ோன்றியதே சூபி 
தத்துவமாகும். தீவிர உணர்ச்சிவயப்பட்ட பக்தி, 
ஆழமான தியானம் ஆகியவற்றின் மூலமே 
கடவுளை உணரமுடியுமென சூபி க�ோட்பாடு 
நம்பியது. இவ்வகையிலான தியானங்களே 
ஒரு பக்தனுக்குக் கடவுளின் உண்மையான 
இயல்பைப் புரிந்துக�ொள்ள உதவுமென 
சூபிக்கள் நம்பினர். இவ்வாறு செய்தால் 
மட்டுமே உலகப் பிணைப்புகளிலிருந்து ஒரு 
பக்தன் விடுபட முடியுமென்றும் அதுவே அவர் 
கடவுளுடன் இரண்டறக்கலக்க உதவுமென்றும் 
சூபிக்கள் வாதிட்டனர். இந்து, இஸ்லாம் ஆகிய 
இரு சமயங்களிலும் அறிவுநிலை கடந்த சமய 
இயக்கங்கள் செயல்பட்டன. தங்களுடைய 
ப�ோதனைகளில் வெவ்வேறு சமயங்கள் சார்ந்த 
கூறுகளையும் சேர்த்துக் க�ொள்வதில் அவர்கள் 
தயக்கம் காட்டவில்லை. “இந்துக்களும்  
இஸ்லாமியரும் கடவுளை வெவ்வேறு 
பெயர்களில் அழைத்தாலும் இருப்பது 
ஒரேய�ொரு கடவுள் மட்டுமே” என ஹரிதாசர் 
கூறியுள்ளார். 

1. �தமிழகத்தில் பக்தி இயக்கம் 
(ஆழ்வார்களும் நாயன்மார்களும்)

பக்தி இயக்கத்தைத் த�ொடங்கிவைத்த 
வைணவ பக்தி அடியார்களான 
ஆழ்வார்களும் சிவனை வழிபடும் 
சைவர்களான நாயன்மார்களும் 
தமிழ்மொழியில் பக்திப்பாடல்களை இயற்றி 
தங்கள் கடவுளர்களுக்குச் சமர்ப்பித்தனர். 
சிவபக்தியானது இவ்வுலகில் நடைபெற்ற 
சிவபெருமானின் திருவிளையாடல்கள�ோடு 
த�ொடர்புடையதாகும். சிவன், விஷ்ணு 
குறிப்பாக கிருஷ்ணர் குறித்த பாடல்கள் 
தமிழிலும் ஏனைய தென்னிந்திய ம�ொழிகளான 
கன்னடம், தெலுங்கு ஆகிய ம�ொழிகளிலும் 
இயற்றப்பட்டன. பெளத்தம், சமணம் ஆகிய 
சமயங்களின் கடுமையான தாக்குதல்களைத் 
திறம்பட எதிர்கொள்வதற்காக, புலவர்களாகவும் 
ஞானிகளாகவும் இருந்த இவர்கள் சாதியை 
அடிப்படையாகக் க�ொண்ட சமூகநிலைகளைச் 
சாடியத�ோடு அல்லாமல் ஆண், பெண் 
சமத்துவத்தையும் முன்னிறுத்தினர். 

விஷ்ணு பக்தி அல்லது வைணவம் 
விஷ்ணுவின் அவதாரங்களைக் குறிப்பாக 
இராம, கிருஷ்ண அவதாரங்களை 
அடிப்படையாகக் க�ொண்டதாகும். பன்னிரு 
தமிழ் ஆழ்வார்கள் அவர்கள் இயற்றிய 
அழிவில்லாப் பாடல்களுக்காகவே 
நன்கறியப்பட்டவர்கள் ஆவர். பக்தி 
இயக்கத்தின்  வளர்ச்சிக்குத் தாங்கள் 
செய்த பங்களிப்பின் காரணமாய் இரண்டு 
ஆழ்வார்கள் தனித்துவம் மிகுந்து 
காணப்படுகின்றனர். நம்மாழ்வார் அவர் 
இயற்றிய 1,102 பத்திகளைக் க�ொண்ட 
திருவாய்மொழியால் புகழ்பெற்றார். 
நம்மாழ்வாரின் 4000 பாடல்களை 
நாலாயிரம் திவ்வியப் பிரபந்தம் எனும் 
பெயரில் நாதமுனி த�ொகுத்துள்ளார். 
ஆழ்வார்களில் ஆண்டாள்  மட்டுமே 
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பெண்பால் ஆழ்வாராவார். பெரியாழ்வார் த�ொடக்கத்தில் விஷ்ணு சித்தர் என அறியப்பட்டார். தாய் 
யச�ோதையின் இடத்தில் தன்னை இருத்தி குழந்தை கிருஷ்ணனைப் பற்றி பல பாடல்களைப் 
புனைந்துள்ளார். திருவில்லிபுத்தூர் க�ோவில் துளசித் த�ோட்டத்தில் பெரியாழ்வார் ஆண்டாளைக் 
குழந்தையாகக் கண்டெடுத்து, தனது குழந்தையாக ஏற்றுக்கொண்டதாகக் கூறப்படுகிறது. க�ோவில் 
நகரமான திருவில்லிபுத்தூரில் வளர்ந்த அவர் ஆண்டாள் (ஆட்சி புரிபவள்) என அழைக்கப்பட்டார்.  
திருப்பாவை (கிருஷ்ணனை அடையும் வழி) நாச்சியார் திரும�ொழி (பெண்ணின் புனிதப் பாடல்கள்) 
ஆகிய இரண்டும் ஆண்டாளின் புகழ்பெற்ற கவிதை நூல்களாகும். திருவரங்கம் க�ோவிலிலுள்ள 
விஷ்ணுவின் அவதாரமான அரங்கநாதனின் மீதான காதலை ஆண்டாள் தனது பாடல்களில் 
வெளிப்படுத்தியுள்ளார். தமிழ்நாட்டில் வைணவத் திருமண விழாக்களின்போது இப்பாடல்கள் 
பயன்படுத்தப்படுகின்றன.

வைணவ அடியார்கள்  (12 ஆழ்வார்கள்)

முதல் மூன்று ஆழ்வார்கள்: ப�ொய்கை ஆழ்வார், பூதத்தாழ்வார், பேயாழ்வார்.
ஏனைய ஆழ்வார்கள்: திருமழிசையாழ்வார், பெரியாழ்வார், த�ொண்டரடிப்பொடி ஆழ்வார்,  

திருமங்கை ஆழ்வார், திருப்பண் ஆழ்வார், குலசேகர ஆழ்வார், நம்மாழ்வார், மதுரகவி 
ஆழ்வார், ஆண்டாள்.

சைவ அடியார்கள் (63 நாயன்மார்கள்)

மரபுவழிக் கதையின்படி நாயன்மார்கள் 63 பேராவர். அவர்களில் ஞானசம்பந்தர், அப்பர், 
சுந்தரர் (மும்மூர்த்திகள் என அழைக்கப்படுபவர்கள்) ஆகிய�ோர் தென்னிந்தியக் க�ோவில்களில் 
சிலைவழிபாடு செய்யப்படுகின்றனர். நாயன்மார்களின் பாடல்கள் அனைத்தையும் நம்பி 
ஆண்டார் நம்பி (கி.பி.1000) என்பார் த�ொகுத்ததாகக் கூறப்படுகிறது. அதுவே சைவப்புனித 
நூல்களான திருமுறையின் அடிப்படையாக உள்ளது. திருமுறை 12 நூல்களைக் 
க�ொண்டுள்ளது. அவற்றில் 11 நூல்கள் நம்பி ஆண்டார் நம்பியால் த�ொகுக்கப்பட்டவையாகும். 
சேக்கிழாரின் பெரியபுராணம் 12வது நூலாகும்.
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அ. ஆதிசங்கரர்  
ஆதிசங்கரர் அல்லது சங்கராச்சாரியார் 

(ஏறத்தாழ கி.பி. 700 – 750) அத்வைதம் எனும் 
தத்  து வ த ்தை  ப் 
ப�ோதித்தவராவார். 
ஞான   த ்தை  ப் 
ப ெ று வதன்   
வழியாக ஜீவாத்மா 
ப ர மா  த ் மா வு ட ன் 
( பி ர ம ் மா ) 
இணையும் என்பதே 
இ த ்த த் து வத்  தி ன் 
சாரமாகும் அவர் 
பத்ரிநாத், பூரி, 
துவாரகா, சிருங்கேரி 
ஆகிய இடங்களில் மடங்களை நிறுவினார். 
அவை கற்றுக்கொள்வதற்கான, வழிபாடு 
செய்வதற்கான மையங்களாகத் திகழ்ந்தன. 
இவ்விடங்கள் இன்றும் முக்கியமான 
புனிதத்தலங்களாக விளங்குகின்றன. 
தன்காலத்து பக்தி இயக்கத்தின் மீது 
கவனம் க�ொள்ளாத சங்கரர் வேதமரபுகளை 
மீட்டெடுக்கும் முயற்சிகளில் ஆர்வம் க�ொண்டார். 
பிரம்ம சூத்திரம் எனும் நூலுக்கு அவர் எழுதிய 
உரையே அவர் ஆற்றிய பணிகளில் சாலச் 
சிறந்ததாகும். பிரம்ம சூத்திரம் வேதாந்தப் 
பள்ளியின் அடிப்படை நூலாகும். முதன்மையான 
உபநிடதங்களுக்கு அவர் எழுதிய உரைகளும் 
முக்கியமானவையாகவேக் கருதப்படுகின்றன. 

ஆ. இராமானுஜர்
ப தி ன�ொ   ன ்றா  ம் 

நூ ற ்றா  ண ்டை  ச் 
சேர்ந்த வைணவத் 
திருத்தொண்டர ான 
ராமானுஜர் மிகவும் 
செல்    வா க் கு ப ெ ற ்ற 
வ ை ண வ ச் 
சி ந ்த ன ை ய ாளர்   
ஆவார்.

அவர் முன்வைத்தத் தத்துவம் 
விசிஷ்டாத்வைதம் ஆகும். ஆத்மாவானது 
பிரம்மத்துடன் கலந்த பின்னரும் தனக்கான 
அடையாளத்தைத் தக்கவைத்துக் க�ொள்கிறது 
என இத்தத்துவம் அறிவித்தது. நீண்ட நெடிய 
ஆன்மீகப் பயணங்களுக்குப் பின்னர் அவர் 
ஸ்ரீரங்கத்தில் குடியேறினார். சமூக, சமத்துவக் 
கருத்துக்களை பரப்பிய அவர் க�ோவில்களில் 
நுழைவதற்கான சாதியக் கட்டுப்பாடுகளைக்    
கண்டனம் செய்தார். விஷ்ணுவின் மீதும் 
அவரின் இணையான லட்சுமியின் மீதும் அவர் 
க�ொண்டிருந்த பக்திநெறி ஸ்ரீவைஷ்ணவம் 
என்றழைக்கப்படுகிறது. அந்நெறியைப் 
பரப்புவதற்காக அவர் பல மையங்களை 
நிறுவினார்.

16, 17 ஆம் நூற்றாண்டுகளில் 
வைணவ சமயம் இந்தியா நெடுகிலும் 
பரவியது. புகழ்பெற்ற சமஸ்கிருதக் கல்வி 
மையமாக விளங்கிய 
கா  ஞ் சி பு ர த் தி ல் 
வடகலை வைணவம் 
செ  ழி த ்தோங்    கி ய து . 
தென்கலை வைணவம் 
தி ரு வ ர ங ்க த ்தை  
மையமாகக் க�ொண்டிருந்தது. சமஸ்கிருதத்தில் 
எழுதப்பட்ட வேத நூல்களே முக்கியமானவை 
என வடகலையினர் கருதினர். தமிழ் ம�ொழியில் 
பன்னிரு ஆழ்வார்களால் எழுதப்பட்ட திவ்விய 
பிரபந்தத்திற்கு தென்கலையினர் அதிக 
முக்கியத்துவம் க�ொடுத்தனர். 

2. வட இந்தியாவில் பக்தி இயக்கம் 
பதினான்காம் பதினைந்தாம் 

நூற்றாண்டுகளில் வட இந்தியாவில் 
நடைபெற்ற சமய இயக்கங்களைப் பற்றி 
அறிய விரும்புவ�ோர், இக்கால இந்துசமயத் 
தலைவர்கள் இஸ்லாம் குறித்து மிகவும் 
வேறுபட்ட இரு அணுகுமுறைகளைக் 
க�ொண்டிருந்தனர் என்பதை நினைவில் 
க�ொள்ளவேண்டும். ஒரு குழுவினர் இஸ்லாமில் 
எது சிறந்தத�ோ அதை ஏற்றுக்கொண்டனர். 

ஆதிசங்கரர் 

இராமானுஜர்
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